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Introduction
Integrated business planning involves making decisions that are financially desirable as well as 
operationally feasible for the business. Oracle’s Hyperion Planning and Strategic Operational 
Planning solutions come together to address this critical need. 

Oracle Strategic Operational Planning is a new addition to the Oracle EPM family, enabling the 
alignment of top-down financial plans with bottom-up operational plans. This alignment is 
achieved by seamless sharing of plans, metrics, and assumptions between Hyperion Planning 
and Oracle Strategic Operational Planning. 

In addition, Oracle Strategic Operational Planning supports an interactive what-if planning 
environment that enables planners to review gaps between financial and operational plans, 
revise plans to address the gaps and understand the cross-functional impact of these revisions.

Oracle Strategic Operational Planning Analysis Process
The Oracle Strategic Operational Planning application leverages both your actual (measured) 
data and plan (forecast) data. This data may come from a variety of sources, such as ERP 
(Enterprise Resource Planning), PDM (Product Data Management), and CRM (Customer 
Relationship Management) systems. The original source of data is called the execution 
database. Data from the execution database is loaded into the Oracle Strategic Operational 
Planning database, where it is used by the Oracle Strategic Operational Planning application in 
"what-if " scenarios. Data in the Oracle Strategic Operational Planning database is updated 
periodically, for example, nightly or weekly, depending on your needs.
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In a what-if analysis, you change actual and plan values in a set of planning worksheets that 
together make a planning workbook. You can then evaluate changes in key metrics to compare 
the impact of plan changes. The key metrics can vary based on the analysis type selected by the 
person who created the scenario (the analysis "owner").

The overall analysis process is shown in the following diagram:

The Oracle Strategic Operational Planning analysis process may be initiated based on the 
occurrence of exceptions. An exception is an event triggered within the Oracle Strategic 
Operational Planning application when a configured business rule or threshold is violated. The 
business rules and thresholds are called constraints. 

A constraint may exist to ensure that an actual value does not exceed or lag a plan value. For 
example, in Manufacturing Operations, a constraint can be defined for excess inventory to set a 
limit for the amount of material on hand. If this limit is exceeded, the Oracle Strategic 
Operational Planning application generates an excess inventory exception. 

A constraint can also alert planners when data inconsistencies occur. For example, if a monthly 
build plan is changed, an exception may be generated to indicate that the weekly production 
schedule no longer matches the monthly build plan requirement.
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Planners receive a notification on their Home page in the Oracle Strategic Operational 
Planning application when exceptions occur. These exceptions can then be resolved through a 
what-if analysis. In the above example, a planner can adjust values in the weekly production 
schedule to eliminate the exception.

In the Oracle Strategic Operational Planning application, exceptions occur in two ways:

● Exceptions occur in the Oracle Strategic Operational Planning database when base data 
violates a constraint. These exceptions may be generated when updated data is loaded from 
your execution database, or when approved data changes in a scenario are committed to the 
database. When resolved during the course of an analysis, they are called fixed exceptions.

● Exceptions are introduced during the course of an analysis when data changes in a scenario 
violate a constraint. These exceptions are called introduced exceptions.

Within the Oracle Strategic Operational Planning application, the state of an exception 
changes from Assigned to Closed as an analysis proceeds. The state of a scenario changes from 
In Progress to Submitted to Approved and then, when final plan changes are committed back 
to the Oracle Strategic Operational Planning database, to Complete. The analysis is an iterative 
process. An approval flow allows participants and approvers to review an In Progress scenario 
and proved feedback that can be used to create scenario alternatives. Each scenario can 
generate additional introduced exceptions that you can investigate further.

The specific tasks you perform depend on your role during the analysis. 

Oracle Strategic Operational Planning Data Collection Process
The data collection process is similar to a what-if analysis process, with the addition of data 
providers who provide updated forecast data. The updates are consolidated in a data collection 
scenario's "sandbox" in the database, where an analysis owner can examine the impact of 
forecast changes. For example, in a demand consolidation scenario, sales representatives 
provide updated demand data. Usually, data providers are not Oracle Strategic Operational 
Planning users and do not need to log into the user interface.
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The overall data collection process in a data collection scenario is shown in the following 
diagram:

For example, consider a data collection scenario used for demand consolidation. The existing 
demand forecast is used as a starting point to create data collection workbooks. Each data 
provider receives a different data collection workbook as an email attachment containing that 
person's current forecast data. Data providers update the workbooks in Excel and return them 
by email. When received, the updated workbook data is automatically loaded into the Oracle 
Strategic Operational Planning application, where the forecast changes become data changes in 
the data collection scenario. Analysis owners can generate and send workbooks to all data 
providers at once, or they can send them individually with customized email messages.

An audit log allows the analysis owner to monitor the status of data providers and of the data 
loading process. If a data provider has not yet returned a workbook, or if a returned workbook 
contains incorrect data, the analysis owner can resend the workbook. A data collection 
scenario can be submitted for approval regardless of whether all data providers have 
successfully responded. The analysis owner can also complete a data collection workbook on a 
data provider's behalf. 

The analysis owner can invite participants and approvers to be involved in a data collection 
scenario, just as for a what-if analysis. In this case, the approver's role includes reviewing the 
forecast numbers input by data providers. The approver may want to adjust related measure 
values up or down. Participants may also help adjust forecast numbers. For example, 
participants can adjust different sets of forecast numbers depending on a data provider's 
geographic region. 

When a data collection scenario is finally approved, the forecast numbers are committed to the 
base data in the Oracle Strategic Operational Planning database, where others can view the 
adjusted forecast. In the adjusted forecast, there may be two measures for each updated forecast 
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number: one that represents the updated value supplied by data providers, and one that is an 
adjusted value. For example, if the measure Pipeline Sales represents values supplied by data 
providers, the measure Projected Sales might be defined as the adjusted value after other 
considerations are taken into account. 

Exceptions can occur in data collection scenarios. For example, a constraint in a demand 
consolidation scenario may be defined to flag data that is incomplete or incorrect. Exceptions 
can then be used to indicate when further action is needed by the analysis owner. 

Analysis Roles and Workflows
Tasks in the Oracle Strategic Operational Planning application can vary based on analysis roles. 
The tasks you perform depend on your role during an analysis. You can have one or more roles 
at the same time, as you participate in multiple analyses.

The analysis roles below refer to typical workflows in the Oracle Strategic Operational 
Planning user interface. They are not formal roles that require you to have specific permissions.

● Assigner

● Analysis Owner

● Participant

● Approver

● Data Provider

● Administrator

These analysis roles are described below, with diagrams that show typical workflows. 
Variations on these workflows are possible, depending on how you decide to collaborate on an 
analysis.
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Assigner
Assigners monitor the occurrence of exceptions in the base data (data in the Oracle Strategic 
Operational Planning database) and assign new exceptions to users to investigate. You monitor 
new exceptions on your Home page.

Note: By default, only administrators can assign new exceptions to users. Other users can be designated as assigners if 
desired.

A typical workflow for an assigner is shown in the following diagram:
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Analysis Owner
Analysis owners create scenarios to perform an analysis. As an owner, you select an analysis type 
that is appropriate for the functional area you are investigating. Then you create one or more 
scenarios, invite participants, select approvers, and perform the analysis. When all approvers 
approve final plan changes, you can commit the changes to the Oracle Strategic Operational 
Planning database.

A typical workflow for an analysis owner is shown in the following diagram:
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In a data collection scenario designed to gather updated demand forecast data, the typical 
workflow for an analysis owner includes additional steps:
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Participant
Participants collaborate on an analysis to review scenarios and provide comments to the 
analysis owner. As a participant, you can also create scenario alternatives for the owner's 
scenario to extend an investigation. 

A typical workflow for an analysis participant is shown in the following diagram:

You may also be a participant intending primarily to track progress of an analysis. For example, 
you may want to view only reports and charts, or just provide comments to the analysis owner. 

A typical workflow for a participant watching an analysis is shown in the following diagram:
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Approver
Approvers are give authority by analysis owners to approve proposed plan changes developed as 
a result of an analysis. If all approvers approve an analysis, the analysis owner can commit plan 
changes to the Oracle Strategic Operational Planning database. If an analysis is not approved, it 
remains in the Submitted state for further collaboration, or until it is deleted.

A typical workflow for an analysis approver is shown in the following diagram:
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Data Provider
Data providers are sent a report workbook by email and asked to provide updated report data. 
For example, you may be asked to update demand forecast data which is then consolidated 
with other demand data in a data collection scenario. As a data provider, you do not directly 
participate in a scenario's analysis. 

A typical workflow for a data provider is shown in the following diagram:

Administrator
Administrators log into the system to access the Administration Workbench, where they 
perform administrative tasks such as managing analysis types, worksheets, workbooks, queries, 
dimensions and cubes. By default, only administrators can assign new exceptions to users.

Note: To access the Administration Workbench, you must log in as the administrator.

To log in as the administrator, you use the administrator username and password:

username: admin

password: password

By default, the administrator username is admin and the password is password. You can edit 
the administrator username and password to change the defaults.
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Using the Oracle Strategic Operational Planning Application
Using the Oracle Strategic Operational Planning application involves:

● Logging into the Oracle Strategic Operational Planning Application

● Viewing the Current Status on Your Home page

● Understanding the Oracle Strategic Operational Planning User Interface

● Using Oracle Strategic Operational Planning Tools in Excel

● Updating Your User Profile

● Using and Customizing Search Filters

Logging into the Oracle Strategic Operational Planning 
Application
To log into the Oracle Strategic Operational Planning Dynamic Operational Planning 
application, you must be registered as a user and assigned a username and password by the 
administrator. 

You can access Oracle Strategic Operational Planning tools in Excel in the following ways:

● Log into the Oracle Strategic Operational Planning application. Then open a planning, data 
collection, or report workbook in Excel from the Oracle Strategic Operational Planning 
user interface.

● Enable the Remember my username/password checkbox on the login screen as described 
below. Then you can use Excel shortcuts to open planning workbooks. 

To access the Administration Workbench to perform administrative tasks, you must log in as 
the administrator. For the default administrator username and password, see “Analysis Roles 
and Workflows” on page 21.

➤ To log into the Oracle Strategic Operational Planning application:

1 Open an Internet Explorer browser window.

2 Enter the following URL address:

http://server_name:port_number/Oracle Strategic Operational Planning

where server_name is the name of the computer where the Oracle Strategic Operational 
Planning server is running, and port_number is the HTTP port number set up by the 
administrator. By default, the port number is 3333, for example:

http://localhost:3333/Oracle Strategic Operational Planning

3 In the Oracle Strategic Operational Planning login page, enter your username and password and click 
Login. 

Passwords are case-sensitive.
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4 Optional. Click Remember my username/password to save your username and password to log in 
automatically next time. 

Selecting this option stores a cookie on your computer that remains until you click Logout on 
the Oracle Strategic Operational Planning Welcome bar.

➤ To log out of the Oracle Strategic Operational Planning application, do one of the following:

● Close your browser window. 

If you selected Remember my username/password and you close your browser window 
without logging out, you can log in automatically next time.

● Click Logout on the Oracle Strategic Operational Planning Welcome bar. 

If you click Logout, Remember my username/password is cleared and you must re-enter 
your username and password the next time you log in.

Viewing the Current Status on Your Home page
Your Home page is displayed after you log into Oracle Strategic Operational Planning. The 
Home page provides quick access to exceptions assigned to you, and scenarios and tasks you 
are involved in. A weekly calendar lists scenarios and tasks that are due each week. 

The following panels are displayed:

● Weekly Calendar—Scenarios and tasks you are involved in that are due each week.

● Exceptions—Number of exceptions of different types assigned to you.

● Scenarios—Number of scenarios you are involved in as an owner, participant (reviewer), or 
approver. Also shows the number of scenarios you are involved in with past due dates.

● Tasks—Number of tasks, also called action items, that you requested or are assigned. Tasks 
in the Deferred state, and tasks with past due dates, are also displayed. 

Table 1  Working on the Home Page

Objective Steps

To change the week: Click the calendar icon in the upper-right corner of the Weekly Calendar panel.

To open a scenario or task 
that is due:

Click the name of a scenario or task displayed in red.

To open a scenario's 
planning workbook:

Click the Excel icon (a single worksheet) next to a scenario name. 

If the scenario has one or more alternatives (the Excel icon is a stack of worksheets), 
click the Excel icon and then click the name of an alternative in the popup menu that 
opens.

To view exceptions assigned 
to you:

Click the name of an exception in the Exceptions panel.

To view scenarios you are 
involved in that are overdue:

Click Overdue in the Scenarios panel.

To view scenarios you own: Click Owner in the Scenarios panel.

To view scenarios you are 
involved in as a participant:

Click Review in the Scenarios panel.
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Understanding the Oracle Strategic Operational Planning 
User Interface
The Oracle Strategic Operational Planning user interface gives you several ways to work with 
exceptions, create and monitor a scenario, perform an analysis, view reports and charts, and 
perform administrative tasks. Review the following sections for information on:

● Using the Planning Workbench

● Using the Administration Workbench

● Using the Welcome Bar

Using the Planning Workbench
In the Planning Workbench, the Navigation Panel on the left of the screen displays buttons that 
link to different sections of the user interface. Some sections expand to display subsections.

The Planning Workbench includes the following sections:

● Home

● Dashboards

● Analysis Workbench

● Exceptions

● Reports

● Tasks

To view scenarios that need 
your approval:

Click Approver in the Scenarios panel.

To create a new scenario: Click the Create Scenario link. Then select an analysis type from the popup menu 
that opens. You must have at least one analysis type assigned to you to create a 
scenario.

To view tasks you are 
involved in that are overdue:

Click Overdue in the Tasks panel.

To view tasks assigned to 
you as owner:

Click Assigned in the Tasks panel.

To view tasks you 
requested:

Click Requested in the Tasks panel.

To view tasks you are 
involved in that have been 
deferred:

Click Deferred in the Tasks panel.

To create a new task: Click the Create Task link. Then select an analysis type from the popup menu that 
opens. You must have at least one analysis type assigned to you to create a task 
using the Tasks panel.

Table 1  Working on the Home Page

Objective Steps
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The screen title shows where you are in the Planning Workbench. The title includes the section, 
subsection, and task you are currently viewing and the path to navigate to that screen. 

For example, to navigate to:

Analysis Workbench > Analysis Type > Perform Analysis > Create Scenario

where Analysis Type is an available analysis type such as Revenue Attainment, do the following:

1. In the Navigation Panel, click the Analysis Workbench section .

2. Click a subsection for an analysis type, such as Revenue Attainment.

3. Click the Perform Analysis subsection under the analysis type.

4. Click the Create Scenario button.

Sections and subsection names in the title are links to those screens in the user interface. Click 
on a section or subsection name in the title to return to that screen.

Home

The Home page displays a summary of the exceptions, scenarios, and tasks you are involved in. 
A weekly calendar displays items that are currently due. 

Table 2 Home Page Panels

Panel What is Displayed

Weekly Calendar Names of scenarios and tasks that are due each week.

Links allow you to quickly open a scenario or task to view details. Clicking the Excel icon next 
to a scenario name opens the scenario's workbook. A calendar icon allows you to change 
the week displayed.

Exceptions Number of exceptions assigned to you, listed by name. Exceptions have the following states:

● Assigned—An exception assigned to you by another user. By default, newly triggered 
exceptions are assigned to the administrator as they occur.

● Closed—An exception that has been fixed in an approved scenario.
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Note: For more information, see “Viewing the Current Status on Your Home page” on page 29.

Dashboards

The Dashboards section of the Navigation Panel displays charts and graphs that allow you to 
monitor key metrics on a regular basis.

Analysis Workbench

The Analysis Workbench section of the Navigation Panel is where you create and modify a 
scenario. The Analysis Workbench lists subsections for each analysis type assigned to you by 
the administrator. You must be granted access to at least one analysis type before you can create 
scenarios. 

Each analysis type is represented by either a planning workbook or a data collection workbook. 
These workbooks are assembled from predefined planning worksheets where you make plan 
changes and investigate the impact of changes on a default set of key metrics.

In the Analysis Workbench, you perform these tasks:

● Select an analysis type and create a scenario.

● Specify summary information for the scenario, such as name, description, and priority.

● Invite users to be participants and/or approvers.

Scenarios Number of active scenarios you are involved as owner, participant, or approver; and 
scenarios that are past their due date. 

Scenarios have the following states:

● In Progress—A newly created scenario or one currently in use in an analysis.

● Submitted—A scenario submitted for approval.

● Approved—A submitted scenario that is approved. You can no longer analyze an 
approved scenario.

● Complete—A scenario whose final plan changes are committed to the Oracle Strategic 
Operational Planning database.

Links allow you to quickly create a scenario or view scenario details.

Tasks Number of tasks you requested or are assigned, or that are past their due date or deferred. 
Tasks are action items associated with analysis types or scenarios.

Tasks have the following states:

● Not Started—A task that is newly created by a requester and assigned to a task owner. 

● In Progress—A task currently being acted on by the task owner.

● Deferred—A task that is on hold.

● Waiting on Someone Else—A task whose completion depends on another person.

● Completed—A task that is completed as requested.

Links allow you to quickly create a task or view task details.

Table 2 Home Page Panels

Panel What is Displayed
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● Define tasks, which are action items associated with analysis types or scenarios, and assign 
them to users.

● Perform your analysis. In the scenario's planning workbook, you change plan and actual 
data values and recalculate key metrics and other measures. Exceptions that occur are 
highlighted in red in the workbook.

● Compare recalculated key metrics and the number and type of introduced exceptions to 
determine the impact of changes.

For example, the analysis type Revenue Attainment in the Sales and Marketing module allows 
you to change plan and actual data values and recalculate the key metrics Projected Sales Delta 
and Projected Units Delta, as well as other measures you can add to your own watchlist.

When you click an analysis type in the Analysis Workbench, the subsections below are 
displayed.

You can customize and select different search filters for scenarios, exceptions, and tasks. For 
more information, see “Viewing Exceptions” on page 38, “Creating Scenarios” on page 40, and 
“Editing Scenarios” on page 42. 

Exceptions

The Exceptions section of the Navigation Panel allows you to view a list of exceptions assigned 
to you. Click on an exception to view details.

You can customize and select different search filters for exceptions. For more information, see 
“Viewing Exceptions” on page 38.

Reports

The Reports section of the Navigation Panel allows you to view predefined tabular reports and 
charts. The Reports section is similar to View Reports under the Analysis Workbench except 
that it lists all reports available, not just those associated with a particular analysis type.

Table 3 Analysis Workbench Subsections

Subsection Description

Perform Analysis Create a new scenario or modify an existing scenario for the selected analysis type. Click the 
Excel attachment icon to open the planning workbook and begin your analysis.

View Exceptions View details for exceptions that are assigned to you. 

View Reports View predefined tabular reports and charts associated with the selected analysis type. 

View Tasks View tasks associated with an analysis type or scenario. Create and assign a task. Update task 
details including due date and status. A task is any action item requested by a user and 
assigned to an owner to complete
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When viewing reports and charts, you can select filters to display selected ranges of data, such 
as data for a particular time period, product, or location. For more information, see “Viewing 
Reports and Charts” on page 77.

Tasks

The Tasks section of the Navigation Panel allows you to view and define any task you wish that 
is related to analysis types or scenarios. As a task requester, you enter a text description of the 
task, set a due date, and assign the task to a task owner. 

Task status is displayed on the Home pages of the requester and owner. For tasks associated 
with a scenario, task status can be changed by the requester, owner, or scenario participants as 
desired while the scenario is in the In Progress state. For tasks not associated with a particular 
scenario, task status can be changed at any time.

For example, you can define tasks that are action items frequently associated with a particular 
type of analysis. You can also use tasks as reminders to follow up on action items. For more 
information, see “Viewing Tasks” on page 81 and “Deleting Tasks” on page 82.

Using the Administration Workbench
The Administration Workbench section of the user interface is visible only if you log in as the 
administrator. To switch to this section, you click the Administration Workbench link at the 
top right of the screen.

The Administration Workbench displays tabs to access the following sections:

● Data Designer

● Model Designer

● Administration

Data Designer

The Data Designer section is where you create and edit data models. In the Data Designer, you 
manage datasources, rowsources, dimensions, and cubes. After editing these objects, you 
publish your changes. Publishing restructures cubes and recalculates measure values as needed.

Table 4 Data Designer Subsections

Subsection Description

Datasources View, add, edit, or delete datasources. Datasources are data loaded from external sources of 
data, including flat files (such as CSV text files), Excel worksheets, and external databases. 
Map datasources to rowsources and dimensions. 

Rowsources View, add, edit, or delete rowsources. Rowsources are data stored in relational tables in the 
Oracle Strategic Operational Planning database. Map rowsources to datasources and cubes. 
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Model Designer

The Model Designer section is where you create and edit business models. In the Model 
Designer, you manage analysis types, queries, worksheets, and workbooks.

Administration

The Administration section is where you configure database connections, user dashboards, 
script templates, and security filters. You also manage users and the job queue.

Dimensions View, add, edit, or delete dimensions, including dimension hierarchies. Map dimensions to 
datasources. Add dimensions to cubes.

Cubes View, add, edit, or delete cubes. Add dimensions and measures to a cube. Define how 
measures are summarized or allocated in each dimension. Map cubes to rowsources and other 
cubes. 

Table 5 Model Designer Subsections

Subsection Description

Analysis Types View, create, edit, or delete analysis types. 

Queries View, create, edit, preview, or delete queries. Queries are used to retrieve and filter data from 
the Oracle Strategic Operational Planning database for display in reports. They are also used in 
security filters to restrict access to report data. 

Worksheets View, create, edit, or delete planning, report, or data collection worksheets.

Workbooks View, create, edit, or delete planning, report, or data collection workbooks.

Table 6 Administration Subsections

Subsection Description

Connections Define a connection to an external database (such as Oracle or SQL Server), including 
username and password. Test database connections.

Dashboards Add or delete dashboard files and set dashboard access.

Meetings Add or delete meetings and define meeting details.

Job Queue View the status of certain administrative jobs, including data staging and loading operations for 
data collection scenarios, and publish operations for data model changes. Execute jobs 
manually.

Script Templates View, add, edit, or delete templates containing commands used in batch scripts.

Table 4 Data Designer Subsections

Subsection Description
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Using the Welcome Bar
The Welcome bar at the top right of the screen lists your username and contains a Help link 
that opens the Oracle Strategic Operational Planning online help and a Logout link to log out   
of the system and return you to the login screen. 

You can click on your username to update your user profile, including changing your email 
address and login password.

If you log in as the administrator, the Welcome bar displays a link to toggle between the 
Planning Workbench and the Administration Workbench sections of the user interface.

Using Oracle Strategic Operational Planning Tools in Excel
The Oracle Strategic Operational Planning™ Dynamic Operational Planner adds the following 
tools to Microsoft Excel that you use to perform your what-if analysis.

● Oracle Strategic Operational Planning Workbooks

❍ Worksheet Dimensions

❍ Worksheet Measures

❍ Worksheet Cells

● Oracle Strategic Operational Planning Context Menus

● Oracle Strategic Operational Planning Toolbar

● Oracle Strategic Operational Planning Menu

After creating a scenario in the Oracle Strategic Operational Planning user interface, you use 
these analysis tools in Excel to modify data values in the planning workbook, recalculate key 
metrics, and view scenario impact details. For a general discussion of the steps involved in 
performing a what-if analysis, see “What-if Analysis Steps” on page 58.

Excel is used primarily to display different views of the modeling data in the Oracle Strategic 
Operational Planning database. Analysis calculations are performed by the Oracle Strategic 
Operational Planning server. 

While performing an analysis in Excel, you use Excel features as you normally would. For 
example, you can use Excel keyboard equivalents such as CTRL+C (to copy), CTRL+P (to 
print), and CTRL+F (to search for text or numbers in a large worksheet).

Security Filters View, add, edit, or delete security filters to restrict user access to data in reports. Select an 
existing query to define restricted data. Assign users no access, read only access, or read/write 
access. 

Users View, add, edit, or deactivate users. Edit display names, email addresses, and user passwords. 
Assign analysis types to users to allow them to create scenarios.

Table 6 Administration Subsections

Subsection Description
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➤ To view Oracle Strategic Operational Planning tools in Excel:

1 Log into the Oracle Strategic Operational Planning application from your browser.

2 In the Navigation Panel, click Analysis Workbench.

3 In the main panel, click the Create Scenario and select an analysis type. 

Before you can create a scenario, you must be granted access to at least one analysis type by the 
administrator.

4 In the Scenario Summary panel, enter a name for the scenario and click Save.

5 Open Excel in the list of your scenarios by clicking the Excel icon next to the scenario you just created.

Oracle Strategic Operational Planning Workbooks
When you open Excel from the Oracle Strategic Operational Planning application, a planning 
workbook is displayed. 

A planning workbook is a predefined Excel workbook used in a what-if analysis. Each planning 
workbook is associated with an analysis type and is designed to examine the impact of plan 
changes on a specific set of key metrics. 

A planning workbook is assembled from planning worksheets. A planning worksheet provides a 
view of modeling data in the Oracle Strategic Operational Planning database. Each planning 
worksheet displays a different subset of the modeling data and can be included in more than 
one planning workbook, so that its data can be used by different analysis types. 

A planning workbook may also include one or more report worksheets. A report worksheet is a 
predefined Excel worksheet that uses tabular reports and charts to display data in the Oracle 
Strategic Operational Planning database. The data to be displayed is specified using queries.

You navigate through and modify values in a planning workbook as you would in any Excel 
workbook. The name of the active worksheet is displayed at the top left of the worksheet and 
on the sheet tab at the bottom. You switch between worksheets by clicking the sheet tabs. 

In a planning workbook, you use Oracle Strategic Operational Planning tools to view and 
modify the following elements of a planning worksheet:

● Worksheet Dimensions

● Worksheet Measures

● Worksheet Cells

Worksheet Dimensions

Columns and rows in a planning worksheet represent categories of business data called 
dimensions. Common dimensions in planning worksheets include Geography, Product, 
Customer, and Time. Dimensions provide indexes to specify the location of each data cell in a 
worksheet.

A dimension contains individual elements called members. For example, the Time dimension 
includes members that correspond to each calendar month, January through December.  
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The members of a dimension can be organized into one or more a hierarchies to represent 
parent-child relationships. For example, the Time dimension can have a hierarchy named 
Fiscal that represents the fiscal calendar and another hierarchy named Manufacturing that 
represents the manufacturing calendar.

A dimension hierarchy has different hierarchy levels that represent levels in the hierarchy from 
top to bottom. For example, the Time dimension includes the hierarchy levels Year, Quarter, 
and Month. The dimension members at the Quarter level are specific, individual quarters, such 
as Q1 '04, Q2 '04, Q3 '04, and Q4 '04. To see diagrams with examples of dimension hierarchies, 
see “Understanding Cubes, Dimensions, and Measures” on page 86.

Note: The dimension and hierarchy names in your planning workbooks depend on how your planning worksheets are 
defined. Names can be customized.

You can expand a dimension hierarchy to view more detailed data, and you can collapse it to 
view more summarized data. For example, depending on how your worksheets are defined, the 
Geography hierarchy can be expanded to show geographic regions such as North America, 
EMEA (Europe, Middle East, Africa) and APAC (Asia Pacific). Regions can be further 
expanded to show territories, such as the Central, East, South, and West territories in North 
America.

Generally in a planning worksheet, the Time dimension is represented by a row in the 
worksheet. Other dimensions, such as Geography, Product, and Customer, are represented by 
columns. 

In the worksheet, you can right-click on the name of hierarchy level name to open a context 
menu with menu items that allow you to expand and collapse the hierarchy to view more 
detailed or more summarized data.

Worksheet Measures

Measures are the names of numerical data values in a planning worksheet. Measures are 
members of a special dimension, called the measure dimension. Examples of measures are 
Projected Sales, Booked Units, and Actual Average Selling Price. 

Generally, measures are displayed in the rightmost dimension column, to the left of the vertical 
line which separates dimension columns from the data values in the worksheet. You can use 
Oracle Strategic Operational Planning context menus to expand and collapse the column of 
measures, just as you can for the other dimensions. 

Measures in a planning worksheet depend on how the worksheet is defined for a particular 
analysis type. Each analysis type has a set of predefined key metrics, which are measures of 
special interest for that analysis type. For example, the Supply Impact analysis type has the key 
metrics Excess Material Costs, Expedite Costs, and Scrap Metal Costs. 

In an analysis, you make plan changes by modifying one or more data values in a worksheet. 
Then you recalculate all data values, which include key metrics, to view the impact of the 
changes. 
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Measure values can be detailed or summarized, depending on whether dimension hierarchies 
in the worksheet are expanded or collapsed. When dimension hierarchies are collapsed, 
summarized measure values are displayed. When dimensions are expanded, more detailed 
breakdowns of measure values are displayed.

For example, if the Time dimension for the measure Shipped Units is fully collapsed, the 
number of Shipped Units for all time is displayed. If the Time dimension is expanded by one 
level, the number of Shipped Units for each year is also displayed. If the Time dimension is 
fully expanded, the number of Shipped Units is broken down for each year, quarter, month, 
and week, depending on the worksheet. 

Note: Worksheets can be customized, including the layout of dimensions and measures, text formatting, and cell 
highlighting. For example, the current time period in the Time dimension may be highlighted in a different color, so 
that you can easily locate the current year, month, day, or week.

Worksheet Cells

Each measure value in a worksheet cell is located at an intersection of dimensions. If a 
dimension hierarchy is collapsed, then corresponding cells contain summarized measure 
values. If a dimension hierarchy is expanded, cells contain more detailed measure values. When 
you review scenario impact, the locations of cells containing values for key metrics are 
displayed.

A cell location can be expressed as a combination of one member from each dimension, 
including the measure dimension, as in the following example:

NA x All Customers x Fiscal/2005 Q2 x BDF x Booked Sales

The above expression gives the cell location for the number of booked sales of product family 
BDF to all customers in North America during the second quarter of fiscal year 2005, broken 
down as follows:

● Geography dimension: NA (North America)

● Customer dimension: All Customers

● Time dimension: Fiscal/2005 Q2 (the second quarter of fiscal year 2005)

● Product dimension: BDF (a product family)

● Measure: Booked Sales

The number of booked sales above is a more summarized value. If the Geography, Customer, 
Time, and Product dimensions are expanded further, more detailed values for booked sales can 
be displayed. For example:

West x OEM x FY 2005/July x A234 x Booked Sales

where

● Geography dimension: West (a territory in North America)

● Customer dimension: OEM (OEM customers)

● Time dimension: FY 2005/July (the month of July in fiscal year 2005)
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● Product dimension: A234 (a model number in product family BDF)

● Measure: Booked Sales

When an exception occurs due to a constraint violation, the corresponding worksheet cells are 
highlighted in red. For example, if measure values for inventories of certain finished goods 
exceed allowable thresholds for the week, worksheet cells corresponding to these values are 
highlighted. A text comment is also added to highlighted cells to describe the exception. 

You can also add your own comments to individual cells using Oracle Strategic Operational 
Planning context menus, accessed by right-clicking a worksheet cell. In this way you can 
communicate specific information to other participants and review their comments. Cells with 
comments are indicated by a red triangle in the upper right corner. When you move the cursor 
over a highlighted cell or one with a red triangle, a popup opens displaying the cell comment.

Some measures have predefined inline reports that provide transaction-level or component-
level details for measure values. You display an inline report for a cell using Oracle Strategic 
Operational Planning context menus. For example, the measure Booked Sales might provide 
an inline report called Orders that displays sales order data for a particular measure value. The 
inline reports available depend on how your worksheets are defined.

Oracle Strategic Operational Planning Context Menus
Oracle Strategic Operational Planning context menus are displayed in planning workbooks 
that contain one or more planning worksheets used in a what-if analysis. The context menus 
are not displayed in data collection workbooks sent to data providers in a data collection 
scenario.

➤ To view an Oracle Strategic Operational Planning context menu, right-click on a worksheet cell 
containing a hierarchy level name, measure name, or measure value. 

The context menu that opens depends on the kind of cell you select.

Table 7 Oracle Strategic Operations Planning Context Menu Items

Menu Item Description

Zoom In Expands the current branch of a dimension hierarchy by one level.

Zoom Out Collapses the current branch of a dimension hierarchy by one level.

Show Summary Collapses the dimension hierarchy to show the top level. Collapses the list of measures to show 
a subset of the measures in the worksheet. You can customize this set of measures, to display 
only the measures you wish to view.

Show Hierarchy 
Level

Expands or collapses the dimension hierarchy to show the specified hierarchy level.

Show Detail Expands the list of measures to show a larger set of the measures in the worksheet. You can 
customize this set of measures, to display only the measures you wish to view.

Show Measure 
Set Name

Expands or collapses the list of measures to show the specified set of measures. You can 
define one or more measure sets and add or remove measures from a set, to display only the 
measures you wish to view.
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Oracle Strategic Operational Planning Toolbar
The Oracle Strategic Operational Planning toolbar is displayed in Excel when you open a 
planning workbook that contains one or more planning worksheets. The toolbar is not 
displayed if you open a report workbook, which contains only report worksheets. It is also not 
displayed in data collection workbooks sent to data providers in a data collection scenario.

The Oracle Strategic Operational Planning toolbar provides commands to search for specific 
measure values, recalculate all measure values after changes are made, and view scenario 
impact details. Toolbar buttons perform the same functions as their corresponding menu items 
in the Oracle Strategic Operational Planning menu.

Show 
Description

Displays a text description for the dimension member or measure name, if available.

Insert/Edit 
Comment

Opens a text popup where you can enter a cell comment for a measure value. After entering a 
comment, click another cell to close the popup. Commented cells are indicated by a red 
triangle in the upper right corner of the cell.

Add to Key 
Metrics

Adds a measure value to the list of key metrics for the scenario. Added values make up a 
temporary watchlist  hat applies only to the current planning workbook while the scenario is In 
Progress. You can also add a measure value permanently to the list of key metrics for the given 
analysis type. Values for key metrics are calculated and displayed when you view scenario 
impact details.

Inline Report 
Name

Displays an inline report below a measure value giving transaction-level details for that value. 
Inline reports may not be available for all measure values. Some inline reports can be manually 
updated.

Clear Report Cleares the displayed inline report for a measure value. To view this context menu item, right-
click the cell containing the measure value.

Table 7 Oracle Strategic Operations Planning Context Menu Items

Menu Item Description
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Table 8 Oracle Strategic Operational Planning Toolbar Items

Toolbar Description

Oracle Strategic 
Operational 
Planning 
Systems

Opens the Impact window. The current analysis type and scenario name are displayed at the top 
of the window.

Key Metrics:

Displays calculated values of key metrics for the current analysis type. Also displays values of 
measure added to your watchlist. 

Click on a value to go to that cell in the worksheet. Click the X button to delete a measure from 
the watchlist.

Impact Details:

● Fixed Exceptions—Displays the number of exceptions that are resolved due to data changes 
in the planning workbook. Click Show to view cell locations. Click a location to go to that 
cell.

● Introduced Exceptions—Displays the number of exceptions introduced by a data change in 
the planning workbook. Click Show to view cell locations. Click a location to go to that cell.

● Cell Comments—Displays the number of cells in the workbook with comments. Click Show 
to view comments, cell locations, usernames, and time stamps for the comments. Click a 
location to go to that cell.

● Data Changes—Displays the number of data changes made in the planning workbook. Click 
Show to view data changes, cell locations, usernames, and time stamps for the changes. 
Click a location to go to that cell.

Calculate Recalculates key metrics and measure values in a planning workbook. Exceptions introduced as 
a result of a data change are highlighted in red. After recalculating, you can review scenario 
impact. (See “Reviewing Scenario Impact” on page 66.)

This button is displayed for the analysis owner and participants when a scenario is in the In 
Progress or Submitted state

Update Refreshes scenario data with the latest base data in the Oracle Strategic Operational Planning 
database. This button is displayed for approvers when a scenario is in the Submitted stat

Focus Focuses on desired dimension members and measures so that only corresponding data is 
displayed in the worksheet.

Search Searches for a particular dimension member or measure, even if it is not currently displayed in 
the worksheet (for example, when a hierarchy is collapsed). For example, you can search for a 
particular time period in the manufacturing calendar, such as 2004 Q1 Week 1. 

Save Layout Saves the current layout of the planning worksheet. The layout defines which dimension 
members and measures are displayed. You choose whether the layout is used for the current 
scenario or all scenarios with the given analysis type, and whether the layout is used as the 
default view.

Select Layout Selects from a list of user-defined planning worksheet layouts.

Reset Layout Resets the planning worksheet layout to the default view.

View Display 
Options

Selects search options to use when searching for dimension members or measures. Shows 
measure formulas and hides empty rows. 
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Oracle Strategic Operational Planning Menu
The Oracle Strategic Operational Planning menu is displayed in Excel when you open a 
planning workbook that contains one or more planning worksheets. The toolbar is not 
displayed if you open a report workbook, which contains only report worksheets. It is also not 
displayed in data collection workbooks sent to data providers in a data collection scenario.

Several Oracle Strategic Operational Planning menu items listed below perform the same 
functions as corresponding Oracle Strategic Operational Planning toolbar buttons.

Table 9 Oracle Strategic Operational Planning Menu Items

Menu Item Description

Show Impact 
Window

Opens the Impact window. The current analysis type and scenario name are displayed at the top 
of the window.

Key Metrics:

Displays calculated values of key metrics for the current analysis type. Also displays values of 
measure added to your watchlist. 

Click on a value to go to that cell in the worksheet. Click the X button to delete a measure from 
the watchlist.

Impact Details:

● Fixed Exceptions—Displays the number of exceptions that are resolved due to data changes 
in the planning workbook. Click Show to view cell locations. Click a location to go to that cell.

● Introduced Exceptions—Displays the number of exceptions introduced by a data change in 
the planning workbook. Click Show to view cell locations. Click a location to go to that cell.

● Cell Comments—Displays the number of cells in the workbook with comments. Click Show 
to view comments, cell locations, usernames, and time stamps for the comments. Click a 
location to go to that cell.

● Data Changes—Displays the number of data changes made in the planning workbook. Click 
Show to view data changes, cell locations, usernames, and time stamps for the changes. 
Click a location to go to that cell.

Calculate Data 
Changes

Reclaculates key metrics and measure values in a planning workbook. Exceptions introduced as 
a result of a data change are highlighted in red. After recalculating, you can review scenario 
impact. (See “Reviewing Scenario Impact” on page 66.)

This menu item is displayed for the analysis owner and participants when a scenario is in the In 
Progress or Submitted state.

Update Refreshesscenario data with the latest base data in the Oracle Strategic Operational Planning 
database. This menu item is displayed for approvers when a scenario is in the Submitted state.

Focus on 
Selection

Focuses on desired dimension members and measures so that only corresponding data is 
displayed in the worksheet.

Save Layout Saves the current layout of the planning worksheet. The layout defines which dimension 
members and measures are displayed. You choose whether the layout is used for the current 
scenario or all scenarios with the given analysis type, and whether the layout is used as the 
default view.

Select Layout Selects from a list of user-defined planning worksheet layouts.

Delete Layout Deletes a saved planning worksheet layout.

Reset to Default 
Layout

Resets the planning worksheet layout to the default view.
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Updating Your User Profile
Your user profile includes your full name, email address, and login password. You cannot 
change your username (login name). 

Administrators must use the Administration Workbench to change their user profile.

➤ To change your user profile:

1 Log into the Oracle Strategic Operational Planning application using your existing username and password.

2 Click your name in the Welcome bar at the top right of the screen.

3 In the Update Profile window, change:

● Full Name—Your full name, also used as your display name

● Email Address—Your email address, where review and approval notifications will be sent

Your email address must be in the form name@domain.com.

Modify Sheet 
Info

Modifies worksheet information, including its visibility.

Apply Styles and 
Formatting

Defines new styles and text formatting for cells in a planning worksheet. You can change the 
style and text formatting that applies to dimensions, measure values, exceptions, inline reports, 
or planning worksheet headers. 

Manage 
Measure Sets

Defines a set of measures that includes only the measures you wish to view in the worksheet. 
The name of the measure set is added to the context menu. You can also change which 
measures are displayed when you select the Show Summary or Show Detail context menu items.

Control Level 
Zoom

Displays or hides the context menu items Show Summary and Show Hierarchy Level for a 
dimension

Manage Inline 
Reports

Adds, edits, or deletes inline reports. You select the source of data for the report, and set 
whether users can manually update the report. You also select which measure values in the 
planning worksheet allow you to display the report.

Insert Sheet 
from Server

Inserts an existing planning or report worksheet into the planning workbook for the scenario

Save Sheet to 
Server

Saves a new worksheet in the planning workbook for the scenario. You first add the worksheet to 
the planning workbook by selecting Worksheet from the Excel Insert menu. You choose whether 
the worksheet is available to all users involved in the scenario or just yourself.

Delete Sheet Deletes the current planning or report worksheet from the planning workbook. The worksheet is 
deleted only from the current scenario's planning workbook.

View Display 
Options

Selects search options to use when searching for dimension members or measures. Shows  
measure formulas and hides empty rows. 

Oracle Strategic 
Operational 
Planning Help

Opens the Oracle Strategic Operational Planning Systems Online Help window. To return to Excel 
after reviewing or searching the online help, close the help window. To view the online help while 
simultaneously working in Excel, open the help window from the Oracle Strategic Operational 
Planning user interface.

Table 9 Oracle Strategic Operational Planning Menu Items

Menu Item Description
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To change your password, enter your existing password, and then enter a new password. Retype 
the new password to confirm it.

4 Click OK to save changes to your user profile; then click OK to return to the main screen.

Refresh your browser to see changes to your name. The next time you log in, use your new 
password.

Using and Customizing Search Filters
You can filter a list of scenarios, exceptions, or tasks to view those you own, those in a 
particular state, or those you requested, depending on the list. 

● Filtering a List

● Adding a Custom Filter

● Editing a Custom Filter

● Deleting a Custom Filter

Filtering a List

➤ To filter a list of scenarios, exceptions, or taskss, select a filter from the View menu, located near 
the top left of screens displaying a list in the Planning Workbench. 

Search filters depend on the list you are viewing.

Adding a Custom Filter

➤ To add a custom search filter:

1 From the View menu, select Custom Filters.

2 In Custom Filters, click Add.

3 In Add Custom Filter, define your custom filter as follows:

● Enter a display name for the filter that will appear in the View menu for the current screen.

● Enable one or more checkboxes to add selections to the filter. Selections include Owner, 
State, Priority, Description (for exceptions), and Requester and Subject (for tasks). 

● For each filter selection, click one or more items in the list to add them to the filter. 

● For the Description (for exceptions) and Subject (for tasks) filter selections, enter a single 
word or phrase to search for.

4 Click OK to keep your selections and close the window. 

5 Click OK to save the custom filter.



46  Getting Started 

Editing a Custom Filter

➤ To edit a custom search filter:

1 From the View menu, select Custom Filters.

2 In Custom Filters, select an existing custom filter and click Edit.

3 In Edit Custom Filter, modify your custom filter as desired.

4 Click OK to keep your changes and close the window. 

5 Click OK to save the modified custom filter.

Deleting a Custom Filter

➤ To delete a custom search filter:

1 From the View menu, select Custom Filters.

2 In Custom Filters, select an existing custom filter and click Remove.

3 Click OK to delete the selected filter.
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P a r t I I

Using the Planning Workbench

In Using the Planning Workbench:

● Working with Exceptions

● Working with Scenarios

● Working with Data Providers

● Performing an Analysis
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Viewing Exceptions
You can view a list of exceptions and their details. Exception details include:

● ID—Unique ID number for each occurrence of an exception.

● Exception—Name of the exception.

● Due Date—Due date for closing (resolving) the exception. The due date is set when the 
exception is assigned to a user, and is advisory only.

● Priority—Default priority set when the exception is first defined, or the priority set when 
the exception is assigned to a user.

● Status—Current state of the exception.

● Owner—User currently assigned the exception. By default, exceptions are assigned to the 
administrator when they occur. The administrator can then reassign them to other users. 

● Description—Cell location where the exception occurred.

➤ To view a list of exceptions and their details:

1 Go to the Exceptions screen. 

Alternatively, on your Home page, click the name of an exception in the Exceptions panel.

2 Sort the list by clicking a column header.  

3 From the View menu, select a different search filter, or select Custom Filters to add a custom filter  to the 
list.

4 Click the underlined name of an exception to view additional details.
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Assigning Exceptions to Users
By default, newly triggered exceptions in the Oracle Strategic Operational Planning database 
are assigned to the administrator. The administrator then reassigns them to other users for 
analysis. 

When you assign an exception, you can also change its priority and due date. The due date is 
advisory only. Only exceptions in the Assigned state can be reassigned to another user.

➤ To assign an exception to a user:

1 Go to the Exceptions screen. 

Alternatively, on your Home page, click the name of an excpetion in the Exceptions panel.

2 From the View menu, select a different search filter, or select Custom Filters to add a custom filter to the 
list.

3 Click the underlined name of an exception.

4 Optional. Reassign an exception to another user by selecting a different name from the Owner menu. 

5 Optional. Change the priority of the exception by selecting a different priority from the Priority menu.

6 Optional. Change the due date for an analysis to resolve the exception by clicking the calendar icon and 
selectinga new date.

7 Click Save.



Working with Scenarios   51

C h a p t e r

3
Working with Scenarios

In This Chapter Viewing Scenarios . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Creating Scenarios  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Editing Scenarios. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Deleting Scenarioes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Creating Scenario Alternatives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Submitting Scenarios for Approval . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

Approving Scenarios  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Printing Scenarios . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Emailing Scenarios  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Adding Scenarios to Your Favorites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Emailing an Excel Shortcut to a Scenarios Planning Workbook. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Viewing Scenarios
You can access a list of scenarios you are involved in and their details from your Home page or 
the Analysis Workbench. 

Scenario details include:

● Scenario—Name of the scenario.

● Due Date—Due date for completing this analysis. The due date is set when the scenario is 
created, and is advisory only.

● Priority—Priority set when the scenario is created.

● Status—Current state of the scenario.

● Owner—User (analysis owner) who created the scenario. The analysis owner can commit 
plan changes in a scenario to the Oracle Strategic Operational Planning database, after the 
scenario is approved.

➤ To view a list of scenarios you are involved in and their details:

1 Do one of the following:

● On your Home page, go to the Scenarios panel to see the number of scenarios you are 
involved in that need action. Click a link in the panel to view scenarios that are overdue, 
that you own, that await your review as a participant, or that await your approval.
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● Click Analysis Workbench in the Navigation Panel to view scenarios for all analysis types. 

● Click an analysis type listed under the Analysis Workbench to view scenarios for that 
analysis type.

2 In the Analysis Workbench, view details as follows:

a. Sort the list by clicking a column header. Click again to reverse the sort direction. Select a 
different search filter from the View menu, or select Custom Filters to add a custom filter 
to the list. 

b. Click the underlined name of a scenario to view additional details:

c. Click /  to collapse or expand panels.

d. Review scenario impact.

e. Compare a scenario with its scenario alternatives. 

f. For data collection scenarios, send data collection workbooks to data providers or monitor  
their status.

g. Click Cancel or Done to return to the list of scenarios, depending on the scenario's state.

h. Click the Excel icon next to the name of a scenario to open Microsoft Excel and perform 
What-If Analysis steps. The Excel icon is displayed only for scenarios in the In Progress or 
Submitted state. 

If the scenario includes alternatives, a popup menu opens to display the root scenario name 
and the names of scenario alternatives. Select a name from the popup menu.

Creating Scenarios
You create a scenario from the Analysis Workbench or your Home page. When you create a 
scenario, you invite users to become involved as participants or approvers. If you create a data 
collection scenario, you also select data providers who are requested to update forecast data.

When you create a scenario, you must select an analysis type. You must be granted access to an 
analysis type by an administrator before you can create scenarios with that analysis type. 

Both the analysis owner and participants can edit a scenario in the In Progress state. Approvers 
cannot edit a scenario except to add comments when they approve it. 

You can only create scenarios with analysis types that have been assigned to you. To create a 
data collection scenario, you must select a data collection analysis type. Usually, you can 
recognize a data collection analysis type by its name, for example, Demand Consolidation or 
MPS Data Import.

➤ To create a scenario:

1 Select an analysis type in one of these ways:

● On your Home page, click the Create Scenario link in the Scenarios panel. Then select an 
analysis type from the context menu.
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● Click Analysis Workbench in the Navigation Panel, click the Create Scenario button, and 
then select an analysis type from the menu.

● Click Analysis Workbench in the Navigation Panel, click an analysis type in the list, and 
then click the Create Scenario button.

2 In the Analysis Workbench, enter information for the scenario:

● Name—A display name for the scenario that will appear in lists. For example, "2004 Q4 
Production Changes." Scenario names are case-sensitive, where upper and lower case 
versions of a name refer to different scenarios. For example "Production Changes" and 
"production changes" refer to two different scenarios.

● Description—A description for the scenario that appears in lists. For example, "What-if 
analysis to address product shortages caused by forecast revisions" or "Data collection to 
consolidate updated demand data."

● Owner—The analysis owner. By default, the user who creates the analysis is the analysis 
owner. Administrators can specify a different analysis owner using the Owner menu. Only 
the analysis owner can commit an approved scenario to the Oracle Strategic Operational 
Planning database.

● Priority—The priority of the what-if analysis using this scenario. Select a priority from the 
Priority menu.

● Due Date—An advisory due date for the analysis. Click the calendar icon to change the 
due date.

● Participants—A list of one or more participants who can participate in the analysis. 
Participants can review and provide comments, and they can create scenario alternatives. 
Each analysis type includes a default list of participants. 

To add or remove participants from the list:

❍ Click the selection button.

❍ In the Select Participants window, select one or more users in the Available Users 
panel and click Add, or click Add All to add all available users.

❍ In the Invited Participants panel, select one or more users to remove and click 
Remove, or click Remove All to remove all invited participants.

❍ Click OK to save your selections and close the window.

❍ Select Notify Participants by email to automatically send a notification message to 
participants. Click the name of an individual participant in the list to send your own 
email message to that participant.

Invited participants are notified of scenarios to be reviewed in the Scenarios and 
Activities panels on their Home page.

● Approvers—List of one or more approvers who can approve plan changes in this scenario. 
Approvers can review and provide comments. They cannot create scenario alternatives. 

You can invite a user to be both a participant and an approver. All approvers must approve 
a scenario before it can be committed to the Oracle Strategic Operational Planning 
database.
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Each analysis type includes a default list of approvers. By default, the analysis owner, 
participants, and administrators can add and remove approvers. The ability to add or 
remove approvers is set by response.allowEditApprovers. For more information, see 
“Creating Analysis Types” on page 142 and “Editing Analysis Types” on page 146.

To add or remove approvers from the list:

❍ Click the selection button (...).

❍ In the Select Approvers window, select one or more users in the Available Users panel 
and click Add, or click Add All to add all available users.

❍ In the Approvers panel, select one or more users to remove and click Remove, or click 
Remove All to remove all approvers.

❍ Click OK to save your selections and close the window.

❍ Select Notify Approvers by email to automatically send a notification message to 
approvers. Click the name of an individual approver in the list to send your own email 
message to that approver.

Approvers are notified of scenarios to be approved in the Scenarios and Activities panels 
on their Home page.

3 If you selected a data collection analysis type, the Scenario Data Collection panel is displayed. Click the 
selection button (...) to add or remove data providers from the list. 

Each data collection analysis type includes a default list of data providers. Data providers 
receive data collection workbooks to update forecast data. They usually do not need to log into 
the Oracle Strategic Operational Planning user interface. 

4 Save the scenario for later analysis, or begin your analysis immediately:

● Click Save to save the new scenario for later analysis.

● Click the Analyze button to automatically save the scenario, return to the list of scenarios, 
and open the scenario's planning workbook in Excel. It may take a moment for Excel to 
open. Then begin What-if Analysis Steps.

● For data collection scenarios, click Save to save the new scenario and return to the list of 
scenarios. Then click the underlined name of the new scenario. You can then send data 
collection workbooks to data providers. (See “Sending Workbooks to Data Providers” on 
page 68.)

The state of a scenario changes to In Progress when you save it, and it is listed in the Scenarios 
panel on your Home page. 

Editing Scenarios
You edit an existing scenario to change scenario summary information, assign tasks related to 
the scenario, change scenario data collection information, and to create or delete scenario 
alternatives. 

You can only edit scenarios that are in the In Progress state. You can only create scenario 
alternatives if you have been granted access to the scenario's analysis type.
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➤ To edit a scenario:

1 Do one of the following:

● On your Home page, click a link in the Scenarios panel to view a list of scenarios you are 
involved in as owner, reviewer (participant), or approver; or scenarios that are overdue. 
Then click the underlined name of a scenario.

● Click Analysis Workbench in the Navigation Panel. Select a search filter in the View menu. 
Then click the underlined name of a scenario.

2 Click /  to collapse or expand panels. 

3 Edit the following information in the Scenario Summary panel:

● Name—Display name for the scenario that will appear in lists. For example, "2004 Q4 
Production Changes." Scenario names are case-sensitive, where upper and lower  case 
versions of a name refer to different scenarios. For example "Production Changes" and 
"production changes" refer to two different scenarios.

● Description—Description for the scenario that appears in lists. For example, "What-if 
analysis to address product shortages caused by forecast revisions."

● Owner—Aanalysis owner. By default, the user who created the analysis is the analysis 
owner. Note that only administrators can change the analysis owner, by using the Owner 
menu. Only the analysis owner can commit an approved scenario to the Oracle Strategic 
Operational Planning database.

● Priority—Priority of the what-if analysis using this scenario. Select a priority from the 
Priority menu.

● Due Date—Advisory due date for the analysis. Click the calendar icon to change the due 
date.

● Participants—List of one or more participants who can participate in this analysis. 
Participants can review and provide comments, and they can create scenario alternatives.

 To add or remove participants from the list:

❍ Click the selection button (...).

❍ In the Select Participants window, select one or more users in the Available Users 
panel and click Add, or click Add All to add all available users.

❍ In the Invited Participants panel, select one or more users to remove and click 
Remove, or click Remove All to remove all invited participants.

❍ Click OK to save your selections and close the window.

❍ Select Notify Participants by email to automatically send a notification message to 
participants. Click the name of an individual participant in the list to send your own 
email message to that participant.

Invited participants are notified of scenarios to be reviewed in the Scenarios and 
Activities panels on their Home page.

● Approvers—List of one or more approvers who can approve plan changes in this scenario. 
Approvers can review and provide comments. They cannot create scenario alternatives. 
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You can invite a user to be both a participant and an approver. All approvers must approve 
a scenario before it can be committed to the Oracle Strategic Operational Planning 
database.

By default, the analysis owner, participants, and administrators can add and remove 
approvers. The ability to add or remove approvers is set by a parameter, 
response.allowEditApprovers. For more information, see “Creating Analysis Types” on 
page 142 and “Editing Analysis Types” on page 146.

To add or remove approvers from the list:

❍ Click the selection button (...).

❍ In the Select Approvers window, select one or more users in the Available Users panel 
and click Add, or click Add All to add all available users.

❍ In the Approvers panel, select one or more users to remove and click Remove, or click 
Remove All to remove all approvers.

❍ Click OK to save your selections and close the window.

❍ Select Notify Approvers by email to automatically send a notification message to 
approvers. Click the name of an individual approver in the list to send your own email 
message to that approver.

Approvers are notified of scenarios to be approved in the Scenarios and Activities 
panels on their Home page.

4 Click the Add Comment button to add a comment to the scenario that can be viewed by participants and 
approvers. 

The comment, the name of the user who added it, and a time and date stamp will be saved with 
the scenario when it is approved and committed to the Oracle Strategic Operational Planning 
database.

5 Click the Add Tasks button to add an action item that is associated with the scenario. Then enter 
information as follows: 

● Subject—Enter a brief description of the task which is also used as the display name. A 
subject is required.

● Due Date—Click the calendar icon to select a due date for the task. A due date is required. 
Due dates that are in the past are displayed in red on the Home pages of the requester and 
task owner. 

● Start Date—Click the calendar icon to select a date when the task should start. 

● Status—Select the task status from the menu. For example, for a newly created task, select 
Not Started. The requester, task owner, and scenario participants can change the task status 
as desired while the scenario is in the In Progress state.

● Priority—Select the task priority (Low, Normal, or High) from the menu.

● % Complete—Select a value for the percentage of the task that is complete.

● Owner—Select a user to be the task owner. The task name will be displayed on the Home 
pages of the requester and task owner.

● Comment—Enter any additional information about the task and its progress in the text 
field.
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● Enable one or both checkboxes to automatically send an email notification to the task owner 
and/or scenario participants when the task is saved. 

● Click OK to save the task and close the window. Click the name of the task on the main 
screen to view task details.

To edit a task to update task status or other details, click the task name. To delete a task 
from the scenario, you use the Tasks section of the Navigation Panel.

6 For data collection scenarios, in the Scenario Data Collection panel, click the selection button (...) to add 
or remove data providers from the list. 

Data providers receive data collection workbooks to update forecast data. They usually do not 
need to log into the Oracle Strategic Operational Planning user interface. 

7 Click the New Scenario button to create scenaio alternatives. 

This button is displayed only if you have been granted access to the scenario's analysis type. 
(See “Creating Scenario Alternatives” on page 58.)

8 Save your changes to the scenario for later analysis, or begin your analysis immediately:

● Click Save to save your changes.

● Begin a what-if analysis as follows:

● Select either the root scenario or one of its alternatives by clicking its tab in the Scenario 
Impact panel.

● Click the Actions button and select Analyze Scenario Name from the menu, where 
Scenario Name is the name of the selected scenario. 

Your changes are saved automatically, you are returned to the list of scenarios, and the 
scenario's planning workbook opens in Excel. It may take a moment for Excel to open. 
Then begin What-if Analysis Steps.

● For data collection scenarios, click Save to save the new scenario and return to the list of 
scenarios. Then click the underlined name of the new scenario. You can then send data 
collection workbooks to data providers. (See “Sending Workbooks to Data Providers” on 
page 68.)

Deleting Scenarioes

➤ To delete a scenario:

1 View a list of scenarios in one of these ways:

● Click Analysis Workbench in the Navigation Panel for a list that includes all analysis types. 

● Click an analysis type listed under the Analysis Workbench for a list that includes that 
analysis type. 

2 From the View menu, select a search filter, or select Custom Filters to add a custom filter to the list.

3 Select individual scenarios or a block of scenarios in one of the following ways:

● Select one or more scenarios by enabling their checkboxes. Alternatively, hold down the 
CTRL key as you click individual scenarios in the list.
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● Select a block of scenarios by holding down the SHIFT key as you click and drag to select a 
range of scenarios.

● Click the Select All or Deselect All links near the top right of the screen to select or deselect 
the entire list. These links appear if the list contains fewer than 100 items.

4 Click the Delete Scenarios button. 

The entire scenario (including the root scenario and its alternatives) is deleted.

Note: If you are the analysis owner, you can delete scenarios in the In Progress state, the Complete state, or the 
Approved state. You cannot delete scenarios in the Submitted state. 

Creating Scenario Alternatives
When analyzing a scenario, you may wish to consider one or more different alternatives, for 
example, to compare cost impact or feasibility. You can create scenario alternatives for this 
purpose that are based on an existing scenario or on the base data in the Oracle Strategic 
Operational Planning database. 

When you create a scenario alternative based on an existing scenario, a copy of the original 
scenario (also called the root scenario) is made which inherits all its data from the original, 
including any introduced exceptions resulting from data changes. You then modify the 
alternative to take the analysis further. You can also make a copy of a copy by basing a scenario 
alternative on another scenario alternative.

Each root scenario and scenario alternative occupies a different "sandbox" in the Oracle 
Strategic Operational Planning database that is separate from the base data. When you submit 
a scenario for approval, you select either the root or one of its alternatives, thus specifying a 
particular sandbox of data. Changes and calculations made in this sandbox do not affect the 
base data until final changes are committed to the Oracle Strategic Operational Planning 
database after they are approved.

Analysis owners and participants can create scenario alternatives when the root scenario is in 
the In Progress state, if they have been granted access to the scenario's analysis type by the 
administrator. Approvers cannot create scenario alternatives.

➤ To create a scenario alternative for a root scenario:

1 Select a root scenario in one of the following ways:

● On your Home page, click a link in the Scenarios panel to view a list of scenarios you are 
involved in as owner or reviewer (participant), or scenarios that are overdue. Then click 
the underlined name of a scenario.

● Click Analysis Workbench in the Navigation Panel. Select a search filter in the View menu. 
Then click the underlined name of a scenario.

2 In the Analysis Workbench, click the New Scenario button in the Key Metrics panel. 

This button is displayed only for analysis owners and participants who have been granted 

access to the scenario's analysis type. Click /  to collapse or expand panels.
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3 In the New Scenario window, enter a name for the scenario alternative. 

Names of scenario alternatives are case-sensitive, where upper and lower case versions of a 
name refer to different alternatives. For example "Production Changes" and "production 
changes" refer to different scenario alternatives.

Then use the menu to choose whether to base the alternative on the original scenario, another 
existing scenario alternative, or the base data in the Oracle Strategic Operational Planning 
database.

4 Click OK to close the window and keep the new scenario. 

If you chose to keep the new scenario alternative, a new column appears in the Key Metrics 
panel with information for that alternative. Also, tabs appear in the Scenario Impact panel with 
the name of the original scenario and the alternative. 

5 Click a tab in the Scenario Impact panel to select the original scenario or an alternative and bring it to the 
front. 

The selected scenario name is shown with a diamond icon in both the Scenario Impact and the 
Key Metrics panels.

6 Optional. Delete a scenario alternative by clicking the X button corresponding to that scenario in the Key 
Metrics panel. 

You can delete scenario alternatives in this way, but not the root scenario.

7 Click Save to save your changes. 

You can now analyze the scenario alternative in Excel and compare it with the root scenario. 

Submitting Scenarios for Approval
An analysis owner or a participant can submit either a root scenario or one of its alternatives 
for approval. Only scenarios that are in the In Progress state can be submitted. All approvers 
must approve a scenario before it can be committed to the Oracle Strategic Operational 
Planning database.

➤ To submit a scenario for approval:

1 Select a scenario to submit in one of the following ways:

● On your Home page, click a link in the Scenarios panel to view a list of scenarios you are 
involved in as owner or reviewer (participant). Then click the underlined name of a 
scenario.

● Click Analysis Workbench in the Navigation Panel. Then select a search filter from the 
View menu. Then click the underlined name of a scenario.

2 In the Analysis Workbench, click a tab in the Scenario Impact panel to select either the root scenario or one 
of its alternatives for submission. 

The selected tab moves to the front.
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3 Click the Actions button and select Submit "Scenario Name" for Approval from the menu.

"Scenario Name" is the name of the selected scenario (either the root or one of its alternatives).

For data collection scenarios, a message box informs you if tasks in the Scenario Data 
Collection panel are incomplete. The message is displayed in the following cases:

● Data requests have not yet been sent to all data providers listed. 

● Data changes have not yet been received from all data providers listed. 

● Data received from data providers has not all been loaded successfully.

For example, a task above may be incomplete if the analysis owner or a participant has entered 
data changes on behalf of a data provider. 

4 Click OK to submit the scenario for approval without completing all tasks. 

You cannot complete tasks after the scenario is submitted. 

5 In the Submit "Scenario Name" for Approval window, do the following:

a. Enter any desired comments for the approver. The comment will be saved with the 
scenario.

b. Enable the appropriate checkboxes to send an email notification to the analysis owner, 
participants, or approvers.

c. If scenario data is out-of-date relative to the base data in the Oracle Strategic Operational 
Planning database, refresh scenario data with the latest base data before the scenario can be 
submitted for approval. Select one of the following refresh options:

❍ Refresh and Submit—Refresh scenario data with the latest base data, and then submit 
the scenario for approval. 

❍ Refresh, Don’t Submit—Refresh scenario data with the latest base data, but do not 
submit the scenario for approval. You can continue your analysis using the updated 
data.

d. Click OK to close the window and refresh scenario data. 

Depending on the refresh option, the scenario then moves to the Submitted state or 
remains in the In Progress state. Alternatively, click Cancel to close the window without 
refreshing scenario data or submitting the scenario for approval. 

In the Scenario Impact panel, a checkmark is displayed next to the name of a submitted 
scenario (either the root or one of its alternatives). When submitted, the entire scenario 
(including the root and its alternatives) moves to the Submitted state where it remains until all 
approvers approve it. If there are no approvers selected for a scenario, it automatically moves to 
the Approved state.
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Approving Scenarios
All approvers must approve a scenario before it can be committed to the Oracle Strategic 
Operational Planning database. Approvers can review the analysis in Excel, add cell comments, 
and add scenario comments. Approvers cannot create scenario alternatives, and they cannot 
change any data values or recalculate measure values.

Before approving a scenario, you can review the root scenario and all of its alternatives. 
However, when you give your approval, you are approving only the root scenario or the 
scenario alternative that was selected for submission. 

Note: After a scenario is approved, the planning workbook for the scenario is no longer available for viewing in Microsoft 
Excel.

➤ To approve a scenario or one of its alternatives:

1 Select a scenario to approve in one of the following ways:

● On your Home page, click a link in the Scenarios panel to view a list of scenarios you are 
involved in as approver. Then click the underlined name of a scenario.

● Click Analysis Workbench in the Navigation Panel. Set the search filter in the View menu 
to Approver. Then click the underlined name of a scenario.

2 Review the scenario as follows:

a. Click /  to collapse or expand panels for the scenario summary, key metrics, and 
scenario impact, as desired.

b. In the Scenario Impact panel, click the tab of the scenario you wish to analyze (either the 
root or one of its alternatives) to bring it to the front. The scenario that has been selected 
for submission has a checkmark by its name. 

c. Click the Actions button and select Analyze "Scenario Name" from the menu, where 
Scenario Name is the name of the selected scenario. After a moment, Excel opens to display 
the scenario's planning workbook.

d. In Excel, review scenario impact for the selected scenario (either the root or one of its 
alternatives).  See “Reviewing Scenario Impact” on page 80.

e. Add cell comments as needed.

f. Repeat the above steps to review other scenario alternatives, as desired.

g. After your review, close Microsoft Excel and return to the Oracle Strategic Operational 
Planning user interface.

3 In Approve this scenario?, click Yes. 

4 Optional. Enter comments in the Approve Changes panel..

5 Optional. Send an email notification to the analysis owner, participants, or approvers when you submit 
your approval or non-approval by enabling the appropriate checkboxes in the Approve Changes panel.
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6 Click Save to submit your approval.

The entire scenario (including the root scenario and its alternatives) moves to the Approved 
state if all approvers have approved it. Otherwise, it remains in the Submitted state. You cannot 
open a scenario in Excel when it is in the Approved state. When a scenario is approved, the 
scenario data changes are automatically committed to the base data in the Oracle Strategic 
Operational Planning database.

Printing Scenarios
You can print scenario details for a scenario that is in any state, for example, for review at a 
meeting. When you print scenario details, the following information is included:

● Scenario summary

● List of data providers (for data collection scenarios)

● Scenario comments

● Cctual key metric values (based on the base data in the Oracle Strategic Operational 
Planning database) and the key metric values calculated for the scenario and its alternatives

● Scenario impact for the scenario whose tab is at the front, including the number of fixed and 
introduced exceptions, the record of changes to data values, and any cell comments

➤ To print a scenario:

1 Do one of the following:

● Click a link in the Scenarios panel on your Home page,  to view a list of scenarios you are 
involved in as owner, reviewer (participant), or approver. Then click the underlined name 
of a scenario.

● In the Navigation Panel, click Analysis Workbench and select a search filter from the View  
menu. Then click the underlined name of a scenario.

2 In the Scenario Impact panel, click the tab for a scenario or scenario alternative and to bring that tab to 
the front.

3 Click the Actions button and select Print this Page from the menu.

 A preview browser window opens, along with the Print window. 

Scenario panels are expanded in both the preview window and on the printed scenario page, 

regardless of /  settings.

4 Select printer options and click Print.

To print details for another scenario alternative, click its tab to bring it to the front before 
printing.
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Emailing Scenarios
You can email scenario details for a scenario that is in any state, for example, to start a 
discussion thread. When you email scenario details, the following information is included:

● Scenario summary

● List of data providers (for data collection scenarios)

● Scenario comments

● Actual key metric values (based on the base data in the Oracle Strategic Operational 
Planning database) and the key metric values calculated for the scenario and its alternatives

● (mpact for the scenario whose tab is at the front, including the number of fixed and 
introduced exceptions, the record of changes to data values, and any cell comments

➤ To email a scenario:

1 Do one of the following:

● On your Home page, click a link in the Scenarios panel to view a list of scenarios you are 
involved in as owner, reviewer (participant), or approver. Then click the underlined name 
of a scenario.

● In the Navigation Panel, click Analysis Workbench and select a search filter from the View  
menu. Then click the underlined name of a scenario.

2 In the Scenario Impact panel, click the tab for the scenario or scenario alternative to bring that tab to the 
front.

3 Click the Actions button and select Email this Page from the menu. 

4 In the Email this Page window, enter the following information:

● One or more email addresses of desired recipients, separated by commas

● Email subject, which will appear in the subject line of the message

● Any comments, which will appear as text in the body of the message

Scenario panels are expanded in the email message, regardless of  /  settings.

5 Click Send to send the email message to the specified recipients. 

Adding Scenarios to Your Favorites
You can create an Excel shortcut to a scenario's planning workbook which serves as a 
bookmark. The shortcut is automatically added to your Internet Explorer Favorites menu. 

You can only create shortcuts for scenarios in the In Progress or Submitted states. If a scenario 
is no longer available (if it is approved, complete, or deleted), the shortcut takes you to the 
Oracle Strategic Operational Planning login screen.
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When you select the Excel shortcut from your Internet Explorer Favorites menu, one of the 
following occurs:

● If you are currently logged into the Oracle Strategic Operational Planning user interface, the 
bookmarked scenario's planning workbook automatically opens in Excel.

● If you enabled the Remember my username/password checkbox when you first logged in, 
and then exited the Oracle Strategic Operational Planning user interface by closing your 
browser window instead of logging out, the bookmarked scenario's planning workbook 
automatically opens in Excel. You do not need to login.

● If you did not enable the Remember my username/password checkbox when you first 
logged in, or if you clicked Logout on the Welcome bar to log out, the shortcut takes you to 
the Oracle Strategic Operational Planning login screen. 

➤ To add an Excel shortcut to your Internet Explorer Favorites menu:

1 Select a scenario to bookmark that is in the In Progress or Submitted state in one of the following ways:

● Click a link in the Scenarios panel n your Home page to view a list of scenarios you are 
involved in as owner, reviewer (participant), or approver. Then click the underlined name 
of a scenario.

● In the Navigation Panel, click Analysis Workbench and select a search filter from the View 
menu. Then click the underlined name of a scenario.

2 Click the Actions button, and select Add Excel Shortcut to Favorites from the menu. 

3 In the Internet Explorer Add Favorite dialog box, enter a name and select a location in your Favorites menu 
for the shortcut.

After adding the shortcut to your Internet Explorer Favorites menu, you can save the shortcut 
on your Windows Desktop or email it to another user, just as you can with other Internet 
Explorer shortcuts. You can also email an Excel shortcut directly from the Oracle Strategic 
Operational Planning Analysis Workbench.

Emailing an Excel Shortcut to a Scenarios Planning Workbook
You can email an Excel shortcut to a scenario's planning workbook to one or more users. The 
shortcut is sent as a website URL. You can only email shortcuts for scenarios that are in the In 
Progress or Submitted states. 

➤ To email an Excel shortcu:

1 Select a scenario to bookmark for other users that is in the In Progress or Submitted state in one of the 
following ways:

● On your Home page, click a link in the Scenarios panel to view a list of scenarios you are 
involved in as owner, reviewer (participant), or approver. Then click the underlined name 
of a scenario.

● In the Navigation Panel, click Analysis Workbench and select a search filter from the View  
menu. Then click the underlined name of a scenario.
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2 Click the Actions button, and then select Email Excel Shortcut from the menu. 

3 In the Email Excel Shortcut window, enter the following information:

● One or more email addresses of desired recipients, separated by commas

● Email subject, which will appear in the subject line of the message

● Any comments, which will appear as text in the body of the message

Tip: You can also add an Excel shortcut to your Internet Explorer Favorites menu.
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Adding Data Providers to a Data Collection Scenario
A data collection scenario is similar to a scenario for what-if analysis, with the added feature 
that you specify data providers who update and return forecast data. 

An administrator must create an Oracle Strategic Operational Planning user for each data 
provider before they can be added to a data collection scenario. Data providers usually do not 
need to log into the user interface. If they do log in, they cannot view the scenario, and 
therefore cannot view each other's forecast data, unless they are also the analysis owner, a 
participant, or an approver. 

Two workbooks are used in data collection scenarios:

● Planning Workbook—Used by the analysis owner, participants, and approvers for what-if 
analysis to examine the impact of forecast changes sent in by data providers. 

Just as for non-data collection scenarios, you can refresh scenario data, change and 
recalculate measure values, and review scenario impact. 

● Data Collection Workbook—Used by data providers for manual entry of updated forecast 
data. A data collection workbook consists of at least one report worksheet containing 
current forecast data, obtained from base data in the Oracle Strategic Operational Planning 
database. Each data provider receives a different version of the workbook that is 
automatically filtered to display that person's forecast data.

A data collection workbook includes a hidden load specification that is used by the Oracle 
Strategic Operational Planning server to stage and load updated data. Unlike a planning 
workbook, a data collection workbook cannot be used for what-if analysis. It does not 
display the Oracle Strategic Operational Planning menu, toolbar, or context menus. It is 
for manual data entry and updates only. 
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You select data providers in the Scenario Data Collection panel on the Create Scenario or 
Perform Analysis screens in the Analysis Workbench. This panel is only displayed for scenarios 
that use a data collection analysis type. The panel also allows you to do the following:

● Preview the individual data collection workbook for each data provider.

● Send an ordinary email message to an individual data provider, with no attachment. 

● Modify the default email form to send an email message tailored to an individual data 
provider. The email message includes the data collection workbook as an attachment.

● Send data collection workbooks to all data providers at once using the default email form. 

● Monitor the status and view the history of data collection tasks for each data provider.

For more information on the data collection process, see “Oracle Strategic Operational 
Planning Data Collection Process” on page 19.

➤ To add or remove data providers in a data collection scenario:

1 Create a new data collection scenario or select an existing data collection scenario to edit.

2 In the Scenario Data Collection panel:

● Click the selection button (...) for the Data Providers field.

● In the Select Data Providers window, select one or more users in the Available Users panel 
and click Add, or click Add All to add all available users.

● In the Data Providers panel, select one or more data providers to remove and click 
Remove, or click Remove All to remove all data providers.

● Click OK to save your selections and close the window.

After adding data providers and saving the data collection scenario, you are ready to send data 
collection workbooks to data providers. (See “Sending Workbooks to Data Providers” on 
page 68.)

Sending Workbooks to Data Providers
After creating and saving a data collection scenario, you send data collection workbooks to data 
providers. You can send a workbook to an individual data provider or send workbooks to all 
data providers at once. 

You use the Scenario Data Collection panel in the Analysis Workbench to send workbooks. The 
panel allows you to do the following:

● Preview a Workbook—Each data provider receives a different version of the data collection 
workbook containing that person's current forecast data. Data providers do not see each 
other's forecast data unless they are also the analysis owner, a participant, or an approver for 
the scenario. You can preview individual workbooks in Excel.

● Send a Message—You can send an ordinary email message to an individual data provider. 
The email message is independent of the scenario and does not include an attached 
workbook. 
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● Email a Workbook—You can send a data collection workbook to an individual data 
provider as an email attachment. You can then tailor the email message for that person, 
including customizing the Cc: list of addressees who receive copies.

● Send all Workbooks—You can send data collection workbooks to all data providers at once. 
Each data provider receives the same email message, but with a different version of the 
workbook attachment. The email message is based on a template. You can modify the 
message content and the list of addressees in the Cc: list who receive copies.

● View Status—Email messages are added to a job queue and sent serially. You can monitor 
the send and receive status and view the history of data collection tasks for each data 
provider and for addressees in the Cc: list who receive copies. 

● Add or Remove Data Providers -You can enter edit mode to add or remove data providers 
in the list. 

A hidden worksheet in each data collection workbook includes a query that runs automatically 
to retrieve current forecast data from the Oracle Strategic Operational Planning database for 
an individual data provider.

You can preview and send data collection workbooks only for scenarios in the In Progress state. 
The workbook filename is generated automatically with file extension .xls. The filename is 
different for each data provider. 

➤ To send data collection workbooks to data providers:

1 Click the Excel icon for a data provider to preview an individual data collection workbook in Excel.

The workbook displays current (not yet updated) forecast data for that person only. 

2 Click that a data provider’s underlined name Tt send an ordinary email message to that data provider. 

The email message is sent using your default email application and is not associated with the 
scenario. Replies are sent to the email address specified in your user profile.

3 Click the email icon next to a data provider’s name to send a data collection workbook as an email 
attachment to that data provider.

You can modify the message header, message content, and the Cc: list of email addresses. 
Addressees in the Cc: list receive a copy of the email message and workbook. Separate email 
addresses with commas. The email message is sent from the email address specified in your 
user profile. 

4 Click the Send All button to send data collection workbooks to all data providers at once.

You can modify the message header, message content, and the Cc: list of email addresses. Each 
data provider receives a different version of the data collection workbook. Addressees in the Cc: 
list receive a separate email message and workbook for each data provider. Separate email 
addresses with commas. 

Email messages are sent from the email address specified in your user profile. A separate 
browser window may open temporarily while email is sent. Status changes from No Action to 
'Send Email' Pending.
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5 Refresh your browser window to view updated email status, and click on the status for a data provider to 
open the Data Provider Status window. 

The window displays the history of data collection tasks for that data provider, including the 
status of email sent to addressees in the Cc: list. Status changes to 'Send Email' Succeeded when 
email is delivered. 

Providing Instructions for Data Providers
When data providers receive the email message with the attached data collection workbook 
from the analysis owner, they should follow these steps:

1. Open the data collection workbook in Excel. The workbook contains current forecast data 
for that person only.

2. Review and manually update workbook data. Data providers should be careful to use the 
existing format for data entries.

3. Save changes to the workbook file in Excel. Data providers can change the workbook 
filename if they wish.

4. If data providers wish to contact the analysis owner by email, they can reply to the original 
email message. Replies are sent to the analysis owner's email address.

5. After completing and saving changes, data providers return the updated workbook (.xls 
file) as an email attachment. They should email the workbook to the return email address 
specified in the text of the original email message or in text instructions in the data 
collection workbook. 

Another user, for example, the analysis owner, can submit a workbook on a data provider's 
behalf by sending it as an attachment to the same return email address. 

The specified return email address corresponds to the Oracle Strategic Operational Planning 
server's mailbox on your company's email server. The Oracle Strategic Operational Planning 
server periodically checks the mailbox. When an updated workbook is received, it 
automatically adds a set of data staging and loading jobs to the job queue. 

The analysis owner and participants monitor the status for each data provider. The status of 
data staging and loading jobs is displayed in the Scenario Data Collection panel and in the job 
queue in the Administration Workbench. 

Note that status for sending and receiving email is only displayed in the Scenario Data 
Collection panel.
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Monitoring Data Provider Status
After sending data collection workbooks, you monitor the status of data collection tasks to 
confirm that data providers receive, update, and return their workbooks and that data is loaded 
successfully. The analysis owner and participants can view status when the scenario is in any 
state. Approvers can view status when the scenario is in the Submitted state. You check status as 
often as needed. 

A hidden worksheet in each workbook contains a reference to a load specification file located 
on the Oracle Strategic Operational Planning server. The load specification instructs the server 
how to load the incoming data. When received, the updated workbook file (.xls) is saved on the 
server in the interlace_root\data directory, where interlace_root is the Oracle 
Strategic Operational Planning installation directory. 

The server immediately adds a set of data staging and loading jobs to the job queue with status 
Pending. A separate set of jobs is added for each data provider. Jobs are executed by a batch 
script that is scheduled to run periodically. An administrator can also run jobs manually. Data 
is first prepared for loading in a staging table, and then it is loaded into the scenario's 
"sandbox" in the Oracle Strategic Operational Planning database. 

The analysis owner and participants review and adjust the forecast as needed before submitting 
the scenario for approval. The analysis owner then commits the approved scenario with the 
updated forecast to the base data in the Oracle Strategic Operational Planning database. 

You monitor data provider status in the Scenario Data Collection panel in the Analysis 
Workbench. 

➤ To monitor data provider status:

1 Refresh your browser window to update the status. 

Only the most recent status is displayed. 

2 Click the status for an individual data provider to view the history of communications with that person.

The Data Provider Status window opens to display a list of jobs pending or performed and 
their status. The window is not available for status No Action. 

Status changes to 'Received Email' Succeeded when the server receives an updated workbook 
from a data provider. An Excel icon is then displayed in the Data Provider Status window next 
to the Receive Email job. 

3 Click the Excel icon to open the workbook and view updated forecast data from that data provider. 

The workbook opens in Excel in a separate browser window. 

To view updated workbooks, you must enable pop-ups in your browser.

4 Review the status:

● If the status changes to Stage Data Pending for an individual data provider, the server adds 
a set of data staging and loading jobs to the job queue. You can wait for a scheduled batch 
script to execute the jobs, or an administrator can execute jobs manually in the 
Administration Workbench. 
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Data staging and loading jobs are in the demand job category (also called job type). If the 
administrator selects one job in the demand category to run manually, all pending demand 
jobs for data providers in the job queue are executed in serial order. 

The status may change to Issued in the Data Provider Status window during execution of 
long jobs. For short jobs, the Issued status is displayed only in the console log.

● If the status changes to  Stage Data 'Succeeded with Warnings or  Stage Data Failed, the 
staging job was either completed with warnings or interrupted with errors. Simple 
validation checks are performed before staging to ensure data has the expected data type. If 
warnings or errors occur, data content may be the source. The analysis owner should then 
contact the data provider to correct the data and resend the workbook.

● If the status changes to Load Data Succeeded with Warnings or Load Data Failed, data 
loading into the scenario's sandbox was either completed with warnings or interrupted 
with errors. More detailed validation is performed before data is loaded. An error log is 
generated and an information icon is displayed next to the Load Data job in the Data 
Provider Status window. Click the information icon to open a second window with error 
details. 

When a corrected workbook is received from a data provider, the server adds a new set of 
staging and loading jobs to the job queue. The analysis owner can also make corrections on 
behalf of the data provider and resend the corrected workbook to the server as an email 
attachment. 
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What-if Analysis Steps
To begin analyzing a what-if scenario, open the scenario's planning workbook in Microsoft 
Excel.  

The data in a planning workbook is similar to data you are used to working with. Depending 
on your analysis, you may see a mix of plan (forecast) data and actual (measured) data. For 
example, you may see actual data for past time periods and plan data for the future. Or, data 
for the past may be a mix of actual and plan data, if your analysis depends on considering past 
plan values as well.

A planning workbook typically includes several planning worksheets and one or more report 
worksheets. At first, each planning worksheet may display less data than you are used to seeing. 
Actually, worksheets may contain considerably more data, due to the way data is aggregated 
(summarized) in the Oracle Strategic Operational Planning application. 

As described below, you can drill down into the summarized data to see more detail in each 
worksheet. The ability to drill up and down in the data allows you to look for and examine the 
root causes of exceptions that occur when constraints are violated.

For more information on the layout of data in a planning worksheet and an overview of Oracle 
Strategic Operational Planning tools in Excel, see “Using Oracle Strategic Operational 
Planning Tools in Excel” on page 36.

Your analysis approach depends on the questions you wish to investigate. You first select a 
planning worksheet that contains measures you are interested in. The analysis then includes 
some or all of the steps below, in any order, as needed.

What-if analysis steps include:

● Drilling Up and Down to View Dimensional Data

● Changing and Recalculating Measure Values

● Reviewing the Impact of Plan Changes

● Creating and Comparing Scenario Alternatives
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Drilling Up and Down to View Dimensional Data
When you first open a planning worksheet, dimension hierarchies and the list of measures may 
be collapsed to different levels. For example, in the time dimension, you may see data values for 
Years and Quarters, but not Months or Weeks. You may see a single measure listed, or some or 
all of them. You can expand or collapse data in the worksheet to different hierarchy levels 
because data values are summarized in each dimension. 

The initial view depends on how your worksheets have been defined. For example, a specific 
worksheet cell may contain a value for Shipped Units of Assembly 100-12-A during Q2 2004. A 
different view may show Shipped Units of Assembly 100-12-A for April, May, and June 2004 as 
well; or perhaps Shipped Units of a subassembly of Assembly 100-12-A for all of 2004. 
Depending on the view, you see more summarized or more detailed data values in each 
dimension.

The first step you might take, then, is to expand the list of measures to see all measures in a 
worksheet. Next you might expand or collapse dimension hierarchies to view more detailed or 
summarized data. You may want to drill down in the time dimension to see details for Months 
or Weeks, or drill up in the Products dimension to see summaries for a Product Family. You 
can also reset the view to the initial (default) view.

You may find it useful to restrict your view to focus on certain worksheet cells, to reduce the 
amount of data you must scroll through. Or, if you need to view data for a hidden time period, 
such as Week 1 May 2004, you can do a search so that only data for Week 1 May 2004 is 
displayed. Search results display measure values for the search item you specify. You can change 
search options to reduce the amount of data displayed in search results, or to display more 
detail for the search item.

For example diagrams of dimension hierarchies for a Fiscal calendar and for a BOM (Bill of 
Materials) that illustrate terminology used here, see “Understanding Cubes, Dimensions, and 
Measures” on page 86.

Additional tasks that you can perform when viewing dimensional data include:

● Expand (zoom in) and collapse (zoom out) dimension hierarchies to view more detailed or 
summarized data values. (See “Expanding or Collapsing Dimensions and Measures” on 
page 85.)

● Search for a particular measure or dimension member (for example, a time period, product 
component, or geographic region) even if it is not currently in view. (See “Searching 
Dimensions and Measures” on page 86.) 

● Reset the view to the initial layout or restrict your view to focus on worksheet cells that 
interest you. (See “Changing the Worksheet Layout” on page 89.)

Changing and Recalculating Measure Values
A what-if analysis involves changing data values (measure values) in a planning worksheet and 
recalculating key metrics and other measures for the workbook. You can change data values in 
any worksheet cell, as long as a scenario is in the In Progress state. 
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After changing a data value, you recalculate key metrics and other measures in the planning 
workbook. The worksheet display is then updated, and you drill up or down in the data to view 
recalculated values. If a data change violates a predefined constraint and introduces an 
exception, the worksheet cell where the exception occurs is highlighted in red. Data changes in 
one worksheet can affect other worksheets. For example, a data change in one worksheet can 
introduce an exception in another worksheet. 

A measure may appear in more than one planning worksheet in a workbook. When this 
occurs, one worksheet may contain loaded or input values for the measure, while other 
worksheets contain calculated values that are derived from the loaded or input values. (For 
more information on loaded, input, and calculated measure values, see “Understanding Cubes, 
Dimensions, and Measures” on page 86.)

For example, the measure Sales Forecast $ may appear in both the Sales Forecast and Demand 
worksheets in the Demand Impact workbook. In this case, values of Sales Forecast $ in the 
Sales Forecast worksheet are loaded measure values, loaded from an existing system into the 
Oracle Strategic Operational Planning database. Values of Sales Forecast $ in the Demand 
worksheet are calculated measure values, derived from a formula that ultimately depends on 
the loaded values.

When you want to change a measure value that appears in more than one worksheet, you must 
first know which worksheet contains the loaded or input value. Then you make your data 
change in that worksheet. For example, to change values for Sales Forecast $, you must make 
your changes in the Sales Forecast worksheet. Then when you recalculate, your changes 
propagate to values for Sales Forecast $ in the Demand worksheet.

Note: When a measure appears in more than one worksheet, you must make data changes to the loaded or input values 
for the measure, not to calculated values derived from them. If you make changes to calculated values, your 
changes will not be propagated to loaded or input values for the same measure in other worksheets.

In most cases, you will know before you begin an analysis which measures in which worksheets 
to work with. An administrator can determine which measure values are loaded, input, or 
calculated in a worksheet by looking at measure definition XML files. You can add the 
measures you most often evaluate to a watchlist. Measures in your watchlist are recalculated 
and displayed along with key metrics. 

During an analysis, the analysis owner and participants can add text comments to individual 
worksheet cells. Cell comments provide a way to inform other participants about individual 
data changes and obtain feedback. Cell comments are indicated by a red triangle in the upper 
right corner of a worksheet cell.

Some measures include descriptions or details on how the measure value is calculated. You can 
also view inline reports for some measures that show transaction-level or component-level 
details, for example, purchase order details. 

Additional tasks that you can perform when working with measure values include:

● Change data values, add measures to a watchlist, and recalculate key metrics and other 
measures. 



76  Performing an Analysis 

● Enter and view cell comments in a worksheet. (Ssee the “Reviewing Scenario Impact” on 
page 80.) 

● View inline reports with transaction-level or component-level details. (See “Viewing Inline 
Reports” on page 88.) 

Reviewing the Impact of Plan Changes
After recalculating measure values, you view results. You may see cells highlighted in red where 
exceptions have occurred due to a broken constraint. 

Introduced exceptions occur due to a data change made in a planning worksheet during an 
analysis. For example, a calculation problem can occur if a data change is made to a calculated 
value for a measure instead of a loaded or input value.

Highlighted cells with exceptions may be hidden in the current view. Data changes in one 
planning worksheet can also introduce exceptions in other worksheets. The Oracle Strategic 
Operational Planning Impact window in Excel gives you immediate feedback on the results of 
your recalculation, whether or not affected cells are currently in view. You can view the 
following information:

● Calculated values of key metrics for the scenario

● Calculated values of other measures in the watchlist

● Exceptions that are fixed by data changes in the scenario

● Exceptions introduced by data changes in the scenario

● Cell comments added by you or other participants

● Data changes made in the planning workbook

The window can be expanded to display details for each exception, comment, or data change, 
including cell location. By clicking a cell location, you can jump to a cell that may be hidden or 
on a different worksheet. The same information is available in the Oracle Strategic Operational 
Planning user interface, though you cannot jump directly to worksheet cells. A cell location is 
represented by a measure and a set of dimension members. For more information on how cell 
locations are expressed, see “Using Oracle Strategic Operational Planning Tools in Excel” on 
page 36.

After examining the scenario impact, you may wish to display results for recalculated key 
metrics and other measures in predefined reports. Depending on the report, you can display 
tables or charts for selected date ranges, products, locations, or other dimension members. 

During your analysis, you can continue to add comments to individual worksheet cells. You 
can also add comments that apply to an entire scenario in the Analysis Workbench.

Additional tasks that you can perform when reviewing the impact of plan changes:

● View recalculated key metrics and watchlist measures, introduced exceptions, and the 
history of data changes. (See “Reviewing Scenario Impact” on page 80.)

● Jump to a worksheet cell containing a particular exception, cell comment, or data change. 
(See “Reviewing Scenario Impact” on page 80.)
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● View reports, including predefined tables and charts. (See “Viewing Reports and Charts” on 
page 92.)

● Enter cell comments in a worksheet and enter scenario comments in the Analysis 
Workbench. (See “Reviewing Scenario Impact” on page 80.)

Creating and Comparing Scenario Alternatives
After examining results for a scenario, you can return to the Analysis Workbench in the Oracle 
Strategic Operational Planning user interface to create scenario alternatives. Scenario 
alternatives allow you to investigate several potential solutions, compare them, and then 
choose the best plan to implement. 

You analyze a scenario alternative the same way you analyze the original scenario. If you are the 
analysis owner, your invited participants can also create scenario alternatives. As you analyze 
alternatives in Excel, you return to the Analysis Workbench to compare results. You compare 
key metrics and watchlist measures. You also compare introduced exceptions and data changes 
and review cell comments.

Scenario data is kept separate from the base data in the Oracle Strategic Operational Planning 
database. The original scenario (also called the root scenario) and each alternative scenario has 
its own "sandbox" in the database where data changes are made and calculations are 
performed. When you recalculate measure values in one scenario, data in other scenarios is not 
affected. Likewise, scenario data changes do not affect the base data until final plan changes are 
committed to the Oracle Strategic Operational Planning database when they are fully 
approved.

Since the analysis owner and participants can access scenario data simultaneously as they 
collaborate, it is possible for data in a planning workbook to become out-of-date relative to the 
scenario data. If scenario data is modified by another participant, data in your workbook is 
updated automatically with the latest scenario data when you switch to a different worksheet or 
recalculate measure values.

Scenario data can also become out-of-date relative to the base data. This can happen if another 
analysis owner commits their scenario changes to the Oracle Strategic Operational Planning 
database, and also if updates to the base data are loaded from your execution database. When 
you recalculate measure values, review scenario impact, or submit a scenario for approval, a 
check is automatically performed to determine if scenario data is out-of-date relative to the 
base data. You can then choose whether to refresh scenario data with the latest base data or 
continue without refreshing scenario data.

Opening a Scenario in Excel
You open a scenario's planning workbook in Excel from the Analysis Workbench. 

An analysis owner and participants can analyze a scenario in Excel when it is in the In Progress 
state. An approver can review a scenario in Excel when it is in the Submitted state. You cannot 
open scenarios in the Approved or Complete state in Excel.

You can also add an Excel shortcut to your Internet Explorer Favorites menu that takes you 
directly to a scenario's planning workbook.
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Note: Some reports may allow you to submit changes to the database. The submission process may take time to 
complete. Do not close Excel until the submission process has completed. Otherwise, the process will be 
interrupted and your changes will be reverted.

➤ To open a scenario's planning workbook in Excel:

1 Click Analysis Workbench in the Navigation Panel; then select a search filter from the View menu.

2 Open a scenario's planning workbook in one of the following ways:

● Click the Excel icon next to the name of a scenario. 

If the scenario includes alternatives, a popup menu opens to display the root scenario 
name and the names of scenario alternatives. Select a name from the popup menu.

● Click the underlined name of a scenario to display scenario details. 

If the scenario includes alternatives, click the tab of either the root scenario or one of its 
alternatives in the Scenario Impact panel to bring it to the front. 

Then click the Actions button and select Analyze Scenario Name from the menu, where 
Scenario Name is the name of the selected scenario. 

Microsoft Excel opens to display the planning workbook of either the root scenario or a 
scenario alternative, along with Oracle Strategic Operational Planning analysis tools. 

3 Perform What-if Analysis Steps.

4 Close Microsoft Excel. 

You do not need to save your changes in Excel. 

Changing and Recalculating Measure Values
Measure values are loaded or input into the Oracle Strategic Operational Planning database, 
and therefore into planning worksheets, at a particular level in each dimension hierarchy. 
Values at higher levels in a hierarchy are generally obtained by summation. The level at which 
values are loaded is the leaf level, or lowest level. For example, if monthly values are loaded, the 
leaf level in the Time dimension hierarchy is Months. Yearly values are then obtained by 
summation. 

When changing and recalculating measure values in a worksheet, you need to know which 
measure values are loaded or input values. You make your changes to these values.

Review the following topics for information on:

● Changing Measure Values

● Calculating Key Metrics and Watchlist Measures

● Adding or Removing Watchlist Measures

Note: To achieve the highest system responsiveness, you should expand dimension hierarchies just to the level you need 
for the current analysis.
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Changing Measure Values
The analysis owner and participants can change data values in a scenario's planning workbook 
when the scenario is in the In Progress state. Approvers cannot make data changes.

When a measure appears in more than one worksheet, you must change the loaded or input 
values for the measure, not the calculated values derived from them. Otherwise, your changes 
will not be propagated to loaded or input values for the same measure in other worksheets, and 
calculation problems may occur. Similarly, when you change a measure value that is 
summarized at higher levels in a dimension hierarchy, you must make your changes to the leaf 
level (lowest level) in each hierarchy. 

For example, suppose values for the measure Projected Sales are loaded based on months in a 
fiscal calendar. When you change values for Projected Sales, you must change the monthly 
values. If you change yearly values, your changes will not be propagated to lower levels in the 
hierarchy, and calculation problems may occur. For more information on dimension 
hierarchies, see “Understanding Cubes, Dimensions, and Measures” on page 86.

➤ To change a measure value in a planning worksheet, select the cell containing the value, edit the 
value, and then press the Enter key, as you normally would in Excel. 

Calculating Key Metrics and Watchlist Measures
When you make a data change in a planning worksheet, you want to quickly update your view 
of data to see recalculated measure values. A calculation is triggered when you do any of the 
following after making a data change:

● Click the Calculate button on the Oracle Strategic Operational Planning toolbar, or select 
Calculate Data Changes from the Oracle Strategic Operational Planning menu. The button 
and menu item are displayed only for the analysis owner and participants, not for approvers. 
The data in your current worksheet is recalculated and the display is updated. 

● Click the Impact button on the Oracle Strategic Operational Planning toolbar, or select 
Show Impact Window from the Oracle Strategic Operational Planning menu. The Impact 
window opens to display recalculated key metrics and updated scenario impact 
information. The display of data in you current worksheet is also updated.

● Switch to a different worksheet in the planning workbook. Measures are recalculated and 
the display is updated when you switch. 

● Expand or collapse the display of data in the worksheet to view more detailed or 
summarized measure values. The new display shows recalculated measure values. 

● Focus on a group of measure values that interest you. The display is updated to show 
recalculated measure values.

If data in your workbook is out-of-date relative to scenario data because another participant 
has made changes, your workbook is updated automatically with the latest scenario data before 
a calculation is performed. 
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If data in your workbook is out-of-date relative to the base data in the Oracle Strategic 
Operational Planning database, when you recalculate measure values, a message box opens 
asking whether you want to refresh scenario data with the latest base data before a calculation 
is performed. You can choose to refresh scenario data or to continue without refreshing. 
Likewise, the Impact window displays a Refresh button.

Your data changes do not affect the base data in the Oracle Strategic Operational Planning 
database until the scenario is fully approved. If you want to go back to viewing and working 
with the original data values, you can create a scenario alternative that is based on the base 
data.

In addition to the above updates, the administrator may schedule a batch script to run 
periodically to check if scenario data for In Progress scenarios is out-of-date relative to the base 
data. Scenario data is then updated and any necessary calculations are performed 
automatically.

Adding or Removing Watchlist Measures
You can add any measure value in a worksheet to a watchlist of measures. Watchlist measures 
are calculated and displayed along with the default key metrics associated with a scenario. For 
example, you can add the value of a measure during a particular time period or for a particular 
product component to the watchlist.

The default key metrics are permanently associated with an analysis type. They are calculated 
and displayed for all scenarios with that analysis type. Watchlist measures, on the other hand, 
apply only to a particular scenario.

➤ To add a measure to a scenario's watchlis, right-click the worksheet cell containing the desired 
measure value and select Add to Key Metrics. 

The measure will be listed in the Key Metrics panel in the Impact window and its value will be 
calculated along with the default key metrics.

➤ To delete a measure from the watchlist:

1 Click the Oracle Strategic Operational Planning Systems button on the Oracle Strategic Operational 
Planning toolbar or select Show Impact Window from the Oracle Strategic Operational Planning menu. 

2 In the Impact window, click the X button next to the watchlist measure.

3 Click OK to remove the measure from the list.

Reviewing Scenario Impact
You view the results of your data changes in a scenario's planning workbook using the Impact 
window in Excel. This window also gives cell locations for each result. Similar information is 
available when you view details and compare scenarios in the Analysis Workbench in the 
Oracle Strategic Operational Planning user interface.
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The Impact window lets you view the following information:

● Key Metrics—Calculated values of key metrics and measures added to your watchlist. Key 
metrics are permanently associated with a particular analysis type and thus with a scenario. 
Watchlist measures apply only to the current scenario and only while it is in progress. By 
clicking on a calculated value, you can jump directly to the corresponding cell in a 
worksheet.

● Fixed Exceptions—Number of exceptions that have been resolved as a result of data changes 
made in the planning workbook. You can show details, including cell locations in a 
worksheet. By clicking on a cell location, you can jump directly to that cell.

● Introduced Exceptions—Number of exceptions that have been introduced as a result of 
data changes made in the planning workbook. You can show details, including cell locations 
in a worksheet. By clicking on a cell location, you can jump directly to that cell.

● Cell Comments—Number of individual text cell comments in the planning workbook. You 
can show details for each cell comment, including the worksheet that contains it, the cell 
location, the text of the comment, who entered or last edited the comment, and when (date 
and time). By clicking on a cell location, you can jump directly to that cell.

● Data Changes—Number of data changes that have been made in the planning workbook. 
You can show details for each data change, including the worksheet that contains it, the cell 
location, the old and new data values, who made the change, and when (date and time). By 
clicking on a cell location, you can jump directly to that cell.

Viewing Key Metrics and Watchlist Values

➤ To view calculated key metrics and watchlist values:

1 Click the Oracle Strategic Operational Planning Systems button on the Oracle Strategic Operational 
Planning toolbar, or select Show Impact Window from the Oracle Strategic Operational Planning menu. 

The Key Metrics panel in the Impact window displays both key metrics and watchlist measures. 
To resize the window, click and drag its edges or corners. 

2 Click a calculated measure value in the Key Metrics panel to jump to the corresponding worksheet cell. 

If a measure value appears on more than one worksheet, a popup menu opens allowing you to 
select a worksheet destination.

Viewing Exceptions, Cell Comments, and Data Changes

➤ To view exceptions, cell comments, and data changes:

1 Click the Oracle Strategic Operational Planning Systems button on the Oracle Strategic Operational 
Planning toolbar, or select Show Impact Window from the Oracle Strategic Operational Planning menu. 

The Impact Details panel in the Impact window displays the number of fixed exceptions, 
introduced exceptions, cell comments, and data changes for the scenario. To resize the window, 
click and drag its edges or corners. 
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2 Click Show to view additional details for exceptions, comments, or data changes, including cell locations 
for each. 

3 Click a cell location to jump to that cell in a worksheet.

 If a cell location occurs on more than one worksheet, a popup menu opens allowing you to 
select a worksheet destination. Click Hide to hide impact details. 

For information on how cell locations are expressed, see “Using Oracle Strategic Operational 
Planning Tools in Excel” on page 36.

The analysis owner, participants, and approvers can add text comments to individual data cells 
in a planning worksheet. Comments can be viewed while a scenario is in the In Progress, 
Submitted, or Approved state. Cell comments are not saved when a scenario is committed to 
the Oracle Strategic Operational Planning database.

Commented cells are indicated by a red triangle in the upper-right corner. When you move the 
cursor over a commented cell, a popup opens to display the comment. The popup also displays 
the name of the user who inserted or last edited the comment.

Adding Cell Comments

➤ To add cell comments:

1 Right-click the cell containing the data value you wish to comment on, and select Insert/Edit Comment. 

2 Enter text for the comment. 

A red triangle appears in the upper right corner of the cell. To close the popup after entering 
text, click any cell in the worksheet. 

To edit a cell comment, right-click the commented cell (indicated by a red triangle), and select 
Insert/Edit. Edit text in the popup, and then click any cell to close the popup.

3 Save the comment.

If you are an analysis owner or participant, click the Calculate button on the Oracle Strategic 
Operational Planning toolbar, or select Calculate Data Changes from the Oracle Strategic 
Operational Planning menu. 

If you are an approver, click the Update button or select the Update menu item to save the 
comment. 

Analysis owners, participants, and approvers can add comments that apply to an entire 
scenario instead of to an individual data cell. Scenario comments are permanently saved with 
the scenario. You can use scenario comments to provide information or feedback on an entire 
analysis. You add and view scenario comments in the Analysis Workbench in the Oracle 
Strategic Operational Planning user interface.
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Adding Scenario Comments

➤ To add scenario comments:

1 In the Oracle Strategic Operational Planning user interface, click Analysis Workbench in the Navigation 
Panel.

2 Select a search filter from the View menu to list the name of a scenario; then, click the underlined name of 
the scenario. 

3 Click ( / ) to collapse or expand panels.

4 Enter comments in the window that opens and click OK. 

The data and time the comment was entered, the user who entered it, and the comment text 
are displayed in the Scenario Summary panel and can be viewed by other participants and 
reviewers.

Comparing Scenarios
You can compare a scenario and its alternative scenarios with each other and with the base data 
in the Oracle Strategic Operational Planning database. You can also view a scenario using a 
different analysis type.

To compare scenarios, you use the Analysis Workbench in the Oracle Strategic Operational 
Planning user interface. You can compare and review the following information:

● calculated values of key metrics

● calculated values of other measures in your watchlist

● exceptions that are fixed by data changes in the scenario

● exceptions introduced by data changes

● cell comments added by you or other participants

● the history of data changes that have been made

● scenario data viewed using another analysis type

Comparing Scenarios and Scenario Alternatives

➤ To compare a scenario and its scenario alternatives:

1 In the Oracle Strategic Operational Planning user interface, click Analysis Workbench in the Navigation 
Panel.

2 Select a search filter from the View menu to list scenarios. 

Scenario names listed are root scenario names. Then click the underlined name of the scenario.

3 Click /  to collapse or expand panels.
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4 In the Analysis Workbench, view information for the root scenario and its alternatives in the following 
panels:

● Key Metrics—Names of key metrics and watchlist measures for the base data, the original 
scenario, and each alternative.

● Scenario Impact—Tabs for the original scenario and each alternative scenario. The tab 
currently in front is the selected scenario, indicated by a yellow diamond icon in both 
panels. Each tab contains the same information as the Impact window in Excell. However, 
you cannot click on a cell location to go from the Analysis Workbench directly to a cell in a 
worksheet.

5 Click a tab to select a scenario or one of its alternatives to bring it to the front. 

When you analyze, submit, print, or email a scenario, only the selected scenario is affected.

Viewng a Scenario as Another Analysis Type
You can temporarily switch analysis types to view scenario data from another perspective. 
Switching views lets you analyze scenario data in a different planning workbook, with planning 
worksheets, report worksheets, and key metrics that are specific to the temporary analysis type.

For example, if you are analyzing a scenario from a sales perspective using the Demand Impact 
analysis type, you can switch to a financial perspective that uses the Financial Impact analysis 
type. You can then calculate key metrics and view reports and charts for that analysis type.

Switching views is temporary only. Data changes and calculated key metrics in the temporary 
view are not saved and do not affect scenario data in the original view. You can switch views for 
scenarios that are in the In Progress and Submitted states.

➤ To view a scenario as another analysis type:

1 In the Analysis Workbench, view information for the root scenario and its alternatives in the following 
panels:

● Key Metrics—Names of key metrics and watchlist measures for the base data, the original 
scenario, and each alternative.

● Scenario Impact—Tabs for the original scenario and each alternative scenario. The tab 
currently in front is the selected scenario, indicated by a yellow diamond icon in both 
panels. Each tab contains the same information as the Impact window in Excel. However, 
you cannot click on a cell location to go from the Analysis Workbench directly to a cell in a 
worksheet.

2 Click a tab to select the root scenario or one of its alternatives to bring it to the front. 

3 Select a temporary analysis type from the View as menu, located at the top right of the Key Metrics panel. 

The panel displays key metrics for that analysis type.

4 Analyze the scenario using the temporary analysis type by clicking the Actions button and selecting Analyze 
Scenario Name, where Scenario Name is the name of the scenario. 

You are returned to the list of scenarios, and then Microsoft Excel opens to display scenario 
data in the planning workbook for the temporary analysis type. It may take a few moments for 
the scenario to open in Excel.
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You can perform What-if Analysis Steps in this planning workbook. Your data changes and 
calculated key metrics are not saved. 

5 When you have completed your analysis using the temporary analysis type, close Microsoft Excel. 

The next time you open the scenario in the Oracle Strategic Operational Planning user 
interface, you are returned to the original analysis type with the same scenario data you had 
before switching views.

Expanding or Collapsing Dimensions and Measures
To view dimensions and measures in a planning worksheet, you use Oracle Strategic 
Operational Planning context menus in Excel to expand (zoom in) and collapse (zoom out) 
dimension hierarchies and lists of measures. In this way, you can view more detailed or 
summarized data values, and you can expand dimension hierarchies to just the level you need 
for your analysis.

Note: For more information on how dimension hierarchies are displayed in planning worksheets, see “Using Oracle 
Strategic Operational Planning Tools in Excel” on page 36. For example diagrams illustrating dimension 
terminology, see “Understanding Cubes, Dimensions, and Measures” on page 86.

Expanding Dimensions

➤ To expand a dimension to view lower levels of the hierarchy, do one of the following:

● Right-click on the name of a dimension member and select Zoom In from the context 
menu. 

Only the branch of the hierarchy below the selected dimension member is expanded. You 
can continue to zoom in until that branch is fully expanded.

● Right-click on a dimension member and select Show Hierarchy Level, where Hierarchy 
Level is a lower level in the hierarchy. 

The entire dimension hierarchy expands to show that level. For example, when you right-
click on the Geography dimension, you might see context menu items such as Show 
Region and Show Territory, which allow you to display those geographic levels. 

Collapsing Dimensions

➤ To collapse a dimension to view higher levels of the hierarchy, do one of the following:

● Right-click the name of a dimension member and select Zoom Out from the context menu.

The hierarchy collapses so that only the parent of the selected dimension member is 
displayed. You can continue to zoom out until the branch containing the selected 
dimension member is fully collapsed.
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● Right-click a dimension member and select Show Hierarchy Level, where Hierarchy Level 
is a higher level in the hierarchy. 

The entire dimension hierarchy collapses to show that level. For example, if the Time 
dimension has been fully expanded, when you right-click on the Month hierarchy level, 
you might see context menu items such as Show Quarter and Show Year, which allow you 
to display those levels of the hierarchy.

● Right-click a dimension member and select Show Summary from the context menu, if this 
menu item is available. 

The hierarchy for that dimension collapses to the top level view.

● Click the Reset button on the Oracle Strategic Operational Planning toolbar to return to the 
default view of the dimension hierarchy. 

You can also select the Reset to Original Layout menu item from the Oracle Strategic 
Operational Planning menu.

When a dimension, such as Time, is expanded horizontally in a planning worksheet, from left 
to right the hierarchy moves from lower levels (more detailed, Months) to higher levels (more 
summarized, Years). The most summarized level (All Time) is shown at the far right. 

When a dimension, such as Geography, is expanded vertically in a worksheet, from top to 
bottom the hierarchy moves from lower levels (more detailed, such as Cities) to higher levels 
(more summarized, such as Countries). The most summarized level (All Locations) is shown 
at the bottom

These summation directions are consistent with the way Excel usually shows summations at 
the bottom of a column of numbers or at the right end of a row of numbers.

Expanding or Collapsing Lists of Measures

➤ To expand a list of measures, right-click a measure name and select Show Detail from the 
context menu, if this menu item is available. The entire list of measures is expanded.

➤ To collapse a list of measures, right-click a measure name and select Show Summary from the 
context menu, if this menu item is available. The entire list of measures is collapsed.

Searching Dimensions and Measures
You can search for a dimension member or measure to quickly display data values that are 
scrolled out of view in a worksheet or that are hidden in a collapsed hierarchy. 

Searching also allows you to display data only for a particular dimension member or measure. 
For example, you can display data values only for Week 2 May 2004, OEM customers, or 
Booked Sales.

You can only search one worksheet at a time. Search results include measure values for the 
search item you specify. You can change search options to reduce the amount of data displayed 
in search results, or to display more detail.
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➤ To search for a dimension member or measure:

1 On the Oracle Strategic Operational Planning toolbar, enter a search term in the Search field and press 
Enter. 

Search terms are case-insensitive, and you can enter all or part of a term.

If your search returns a single match, the corresponding data is displayed immediately in the 
worksheet. If your search returns multiple matches, the Search Results window opens to 
display all results.

For example, if you want to display data only for FY 2004, or only for Q1 2004, enter 2004 in 
the Search field and press Enter. The Search Results window opens to display all possible results 
that include the term 2004, such as:

Fiscal/Fiscal/2004 Q1

Fiscal/Fiscal/2004 Q2

Fiscal/Fiscal/2004 Q3

Fiscal/Fiscal/2004 Q4

Fiscal/Fiscal/FY 2004

The above expressions give the fully qualified member names, including the dimension name 
(Fiscal), namespace (Fiscal), and member names (2004 Q1, FY 2004, and so on). In this 
example, the names of the dimension and namespace are the same.

Dimension, hierarchy, and member names depend on how your planning worksheets are 
defined. Names can be customized.

2 In the Search Results window, select one or more items to display by enabling their checkboxes.

To display data for all items listed, enable the Location checkbox. For example, to display data 
only for FY 2004, enable that checkbox. To display data for all time periods containing 2004, 
enable the Location checkbox. 

3 Choose whether to display data only for the search item, or whether to include data for the hierarchy level 
directly above or below the search item as well. 

● Show Next Level Down—Show data for the search item and also for the hierarchy level 
below it. For example, if the search item is FY 2004, show data for FY 2004 and also for Q1 
2004 through Q4 2004.

● Show Next Level Up—Show data for the search item and also for the hierarchy level above 
it. For example, if the search item is FY 2004, show data for FY 2004 and a summation for 
All Time.

● Show Both—Show data for the search item and also for the hierarchy levels above and 
below it. For example, if the search item is FY 2004, show data for FY 2004, for Q1 2004 
through Q4 2004, and a summation for All Time.

● Show Results Only—Show data only for the search item. For example, show data only for 
FY 2004.

To select an option as the default search option for the planning workbook, click the View 
Display Options button in the Oracle Strategic Operational Planning toolbar.

4 Click OK in the Search Results window to display desired data in the worksheet.
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5 To search again using a different search term, enter the search term in the Current search criteria text field 
of the Search Results window, then click the Search Again button. 

For example, to change the search to display for FY 2003, enter 2003 in the Search Results 
window and click Search Again.

You can search other dimensions, such as Customers. For example, depending on the 
worksheet, to display data only for OEM customers, enter the search term OEM .To search for 
a particular measure, enter the measure name, for example, Plan Sales. Then only measure 
values for Plan Sales will be displayed in the worksheet.

Viewing Inline Reports
Inline reports are available for some measures that provide transaction-level or component-
level details. You display an inline report for a particular measure value using an Oracle 
Strategic Operational Planning context menu. The inline reports in your planning workbooks 
depend on how your worksheets are defined. 

For example, inline reports for the Forecast worksheet may provide details on orders (such as 
quantity, revenue, and target ship date) and pipeline information (such as product line, 
customer name, and expected close date). 

Inline reports for the Supply worksheet may provide details on purchase order status (such as 
vendor and expected receipt date) and part availability (such as lead time, excess thresholds, 
and shortage thresholds).

Some inline reports can be updated, allowing planners to modify data within the report to 
support a what-if analysis. For example, an inline report with purchase order details may allow 
planners to edit the expected receipt date to model an expedite action. If the expedite action 
resolves a part shortage, a planner may decide to take further action by confirming with the 
procurement organization whether the purchase order can be expedited. 

Opening Inline Reports

➤ To open an available inline report for a measure value:

1 Right-click on a worksheet cell containing a measure value that has an inline report. 

If an inline report is available, its name appears in the context menu below the Add to Key 
Metrics menu item.

2 Select Inline Report Name from the menu, where Inline Report Name is the name of the inline report.

For example, Purchase Order Receipts or Pipeline. An inline report containing one or more 
rows of information is displayed directly beneath the cell containing the measure value.

Editing InLine Reports
If an inline report is editable, it contains one or more fields whose values can be changed. After 
editing a field value, you recalculate data values for the worksheet. If the inline report field you 
changed is not editable, its value reverts to the original value.
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Some inline reports allow you to add a new row. If so, a blank row is displayed at the bottom of 
the report. You can enter values for fields in the blank row. When you recalculate, the new 
values are inserted into the report.

After recalculating worksheet data values, you review the impact of your change, for example, 
to confirm whether it resolves an exception. 

➤ To edit and update an inline report:

1 Select a field in the inline report, change the data value, and press Enter.

2 If the inline report includes a blank row at the bottom, enter desired values for fields in the row.

3 Click the Calculate button on the Oracle Strategic Operational Planning toolbar, or select Calculate Data 
Changes from the Oracle Strategic Operational Planning menu. 

This button and menu item are displayed only for the analysis owner and participants when a 
scenario is in the In Progress or Submitted state.

4 Review scenario impact to see the impact of your change.

See “Reviewing Scenario Impact” on page 80.

Closing Inline Reports

➤ To close an inline report:

1 Right-click on the worksheet cell containing the measure value corresponding to the inline report.

2 Select Clear Report from the context menu.

Changing the Worksheet Layout
You can change display options for a planning worksheet in Excel using Oracle Strategic 
Operational Planning toolbar buttons and menu items described below.

Toolbar Button Menu Item Description

Focus Focus on Selection Select and display data only for dimension members and 
measures that interest you.

Reset Layout Reset to Default 
Layout

Reset dimension hierarchies and the list of measures to the 
initial (default) view.

View Display Options View Display Options Set search options to be used by default.

Previous Layout View Previous Layout Save the layout and select layout sections,
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Focusing on Selected Data
You can restrict your view of data in a worksheet to focus only on the measures and dimension 
members that interest you. Restricting the view reduces the amount of data you must scroll 
through. It also reduces the need to expand or collapse dimension hierarchies as you make data 
changes.

For example, suppose you are working in the Forecast worksheet and the dimensions include 
Customers, Regions, Products, and Fiscal (representing the fiscal calendar). You can select 
specific measures and dimension members to focus on. For example, you can focus on Pipeline 
Sales and Booked Sales of product BDF for the West and Central territories of the North 
America region for Q1 2005 for All Customers. Only data values corresponding to your 
selected measures and dimension members are displayed for you to work with.

➤ To focus on data for selected dimension members and measures:

1 Select the desired dimension members and measures. 

The selected cells are highlighted.

2 Click the Focus button on the Oracle Strategic Operational Planning toolbar, or select Focus on Selection 
from the Oracle Strategic Operational Planning menu. 

The view changes to show data only for the dimension members and measures you selected. 

You can continue to select cells and focus further if desired. You can zoom dimension 
hierarchies and the list of measures in and out at any time.

Now you can change data values and recalculate key metrics while working only with your 
selected range of data. You can reset the display to the initial (default) view at any time.

Resetting the Display
After expanding or collapsing dimension hierarchies and lists of measures, doing searches, and 
restricting your view to focus on specific data, you can return to the initial (default) view of the 
worksheet. The initial view depends on how your worksheets are defined.

➤ To reset the display to the initial (default) view, click the Reset Layout button on the Oracle 
Strategic Operational Planning toolbar, or select Reset to Default Layout from the Oracle 
Strategic Operational Planning menu.

Setting Default Search Options
You can set default search options to be used for all searches in a planning workbook. When a 
default is set, you can still chang seasrch options for individual searches if you wish.

➤ To set default search options:

1 Click the View Display Options button on the Oracle Strategic Operational Planning toolbar, or select View 
Display Options from the Oracle Strategic Operational Planning menu.
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2 In the search options panel, select an option: 

● Show Next Level Down—Show data for the search item and also for the hierarchy level 
below it. For example, if the search item is FY 2004, show data for FY 2004 and also for Q1 
2004 through Q4 2004.

● Show Next Level Up—Show data for the search item and also for the hierarchy level above 
it. For example, if the search item is FY 2004, show data for FY 2004 and a summation for 
All Time.

● Show Both—Show data for the search item and also for the hierarchy levels above and 
below it. For example, if the search item is FY 2004, show data for FY 2004, for Q1 2004 
through Q4 2004, and a summation for All Time.

● Show Results Only—Show data only for the search item. For example, show data only for 
FY 2004.

3 Click OK to apply your selection.

Refreshing Scenario Data
Scenario data in a planning workbook can become out-of-date relative to the base data in the 
Oracle Strategic Operational Planning database. This can happen when data changes from 
another scenario are committed to the base data, and also when updates to the base data are 
loaded into the Oracle Strategic Operational Planning database from your company's 
execution database. 

When you perform a calculation in a worksheet, scenario data is checked automatically to 
determine if it is out-of-date. If it is, a warning is displayed. You can then choose to refresh 
scenario data with the latest base data or continue your analysis without refreshing scenario 
data.

➤ To refresh scenario data with the latest base data, do one of the following:

● When a scenario is in the In Progress state, click the Calculate button on the Oracle 
Strategic Operational Planning toolbar or select Calculate Data Changes from the Oracle 
Strategic Operational Planning menu. 

If scenario data is out-of-date relative to the base data, a window opens to display a 
warning. Select one of the following options:

❍ Refresh to See Latest Base Data—Refresh scenario data with the latest base data. Data 
values in the workbook will be updated. 

❍ Don't Refresh—Do not refresh scenario data. Data values in the workbook will not be 
updated when you recalculate values. You can continue working with the existing 
scenario data.

● Click the Impact button on the Oracle Strategic Operational Planning toolbar, or select 
Show Impact Window from the Oracle Strategic Operational Planning menu. In the 
Impact window, click the Refresh button.
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Viewing Reports and Charts
Reports and charts are opened in Excel for viewing. You can refresh the data in a report or 
chart, to update it with the latest data changes. You can also filter reports and charts to display 
selected ranges of data, such as data for a particular time period, product, or location.

Note: Some reports may allow you to submit changes to the database. The submission process may take time to 
complete. Do not close Excel until the submission process has completed. Otherwise, the process will be 
interrupted and your changes will be reverted.

Viewing Reports from the Dashboard Section in the Naviation Panel
The Dashboards section in the Navigation Panel may display predefined charts containing data 
for certain key metrics. They allow you to monitor changes in important key metrics. For 
example, a Forecast-to-Actual chart may display key metrics such as Projected Average Selling 
Price (ASP) and Actual ASP over time, allowing you to compare values. 

➤ To view reports from the Dashboard section in the Navigation Panel, click Dashboards in the 
Navigation Panel to view available charts displaying key metrics.

Viewing Reports from the Reports Section in the Navigation Panel
The Reports section in the Navigation Panel lists predefined tabular reports and charts. The 
reports and charts available depend on your configuration. They let you track changes in 
important key metrics and monitor the occurrence of certain exceptions.

For example, an Impact report may allow you to view the revenue impact of plan changes over 
time. A Forecast report may allow you to track changes in plan revenue. A Shortage report may 
include parts and product shortages that led to broken constraints.

You can view reports and charts using the base data in the Oracle Strategic Operational 
Planning database, or using data in a scenario in the In Progress or Submitted state. You can 
refresh reports and charts to display the latest base data or scenario data.

If a report or chart depends on base data, it includes approved plan changes committed to the 
database. A report or chart that depends on a root scenario or one of its alternatives includes 
plan changes in an analysis that may still be in progress. Scenario data is kept separate from the 
base data in the Oracle Strategic Operational Planning database until plan changes are 
committed.

To view reports from the Reports section in the Navigation Panel:

1 Click Reports in the Navigation Panel to list available charts and reports.

2 Click the underlined name of a chart or report. 

3 From the menu that opens, select whether to run the report against base data in the Oracle Strategic 
Operational Planning database or against a scenario. 

Some reports can be run only against base data or only against scenario data.



Completing a Scenario   93

● If you choose to run the report against a scenario, select the name of a root scenario or one 
of its alternatives in the window that opens. If the window is empty, no scenarios exist that 
are in the In Progress or Submitted state.

● Click OK to run the report, or click Cancel to close the window without running the 
report.

Excel opens to display the report or chart along with menus that allow you to filter data. By 
default, filters set to blank entries display all data ranges, such as data for all products, all 
locations, or all time periods. If no data values are displayed in a report, then data is not 
available for that report.

4 Select filters from menus in the report to narrow the range of displayed data; then click the Refresh Data 
button. 

If no data values are displayed in a filtered report, data is not available for the ranges selected.

5 Do one of the following:

● Reset filters to display all ranges of data by selecting a blank entry in the menu and clicking 
the Refresh Data button.

● Refresh data without changing filter settings by clicking the Refresh Data button. 

Default Excel options for modifying chart displays are available; however, these options are not 
supported by the Oracle Strategic Operational Planning application.

Viewing Reports in an Excel Planning Workbook
Some planning workbooks include one or more report worksheets in addition to planning 
worksheets. Report worksheets display predefined tabular reports or charts.

➤ To view reports in a planning workbook in Excel, Click a report worksheet tab in a planning 
workbook to view a predefined tabular report or chart based on scenario data.

Completing a Scenario
Completing a scenario involves:

● Committing Plan Changes to the Database

● Viewing Analysis History

Committing Plan Changes to the Database
When all approvers have approved a scenario, the scenario's final plan changes are 
automatically committed to the base data in the Oracle Strategic Operational Planning 
database. The plan values of either the root scenario or one of its alternatives, whichever was 
selected for submission and then approved, are committed. All information in the Key Metrics 
panel and on the tabs in the Scenario Impact panel is saved with the scenario.
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The analysis owner can then move the scenario from the Approved state to the Complete state, 
to indicate that the analysis is completed. The scenario must be moved to the Complete state 
before it can be deleted. 

Note: Individual worksheet cell data changes and cell comments exist only while a scenario is in progress. They are not 
saved when a scenario is committed to the Oracle Strategic Operational Planning database.

➤ To move a scenario from the Approved state to the Complete state:

1 Select a scenario in one of the following ways:

● On your Home page, click a link in the Scenarios panel to view a list of scenarios you are 
involved in as owner; then click the underlined name of a scenario in the Approved state.

● Click Analysis Workbench in the Navigation Panel. Then click the underlined name of a 
scenario in the Approved state.

2 In the Apply Changes panel, enter any desired comments. 

The comments are saved with the scenario.

3 Optional. Send an email notification to the analysis owner, participants, or approvers when you move the 
scenario to the Complete state by enabling the appropriate checkboxes in the Apply Changes panel.

4 Click the Commit button to move the scenario to the Complete state.

The entire scenario (including the root scenario and its alternatives) moves to the Complete 
state. You can view an analysis history for completed scenarios. You cannot open a scenario in 
Excel when it is in the Approved or Complete state.

Viewing Analysis History
Summary information saved with a completed analysis provides a useful audit trail for later 
review. When plan changes in a scenario are committed to the Oracle Strategic Operational 
Planning database, the following information is saved and can be viewed later by the analysis 
owner:

● Scenario summary information, including the list of participants and approvers

● Scenario comments, including who entered them and when (time and date)

● Key metrics and their values for the scenario and its alternatives

➤ To view analysis history:

1 Select a scenario in one of the following ways:

● On your Home page, click a link in the Scenarios panel to view a list of scenarios you are 
involved in as owner; then click the underlined name of a scenario in the Complete state.

● Click Analysis Workbench in the Navigation Panel; then click the underlined name of a 
scenario in the Complete state.
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2 Click the underlined name of the scenario.

The number of days completed scenarios are available for viewing in the Oracle Strategic 
Operational Planning user interface under the Analysis Workbench is set by a parameter, 
ui.analysis.keepAppliedWorkbooksDays. The parameter is located in the ISServer.properties 
file on the server machine in the following directory:

c:\interlace_root\ISServer.properties

where interlace_root is the Oracle Strategic Operational Planning installation directory. 
The default value for this parameter is 30 days. An administrator can change this value by 
opening ISServer.properties in a text editor, changing the value, and then saving the 
changes to the file.

Managing Analysis Tasks
Managing Analysis Tasks invovles:

● Viewing Tasks

● Deleting Tasks

● Creating Tasks

● Editing Tasks

Viewing Tasks
A task is an action item associated with an analysis. A task can be part of a particular scenario, 
or it can be a standalone task. You can use tasks to track or follow up on actions that are 
performed frequently during an analysis. The user who requests the action item also assigns it 
to a task owner to complete. 

You can access a list of tasks and their details from your Home page, the Tasks section of the 
Navigation Panel. or the Analysis Workbench.

Task details include:

● Subject—Brief description of the task which is also used as the display name.

● Due Date—Due date for the task. 

● Status—Task status (Not Started, In Progress, Waiting On Someone Else, Deferred, or 
Completed). 

● Priority—Task priority (Low, Normal, or High).

● Requester—User who created the task as an action item.

● Owner—User who is assigned the task. 

● Scenario—Scenario associated with the task, if any.
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Only the requester, owner, and administrators can view standalone tasks. Tasks associated with 
a particular scenario can be viewed by the requester, owner, scenario participants, and 
administrators. However, scenario participants must view scenario details to see this 
information. 

➤ To view a task:

1 View a list of tasks in the following ways:

● On your Home page, click a link in the Tasks panel to see a list of tasks that you requested 
or are assigned, or tasks that are overdue or deferred. 

● Click Tasks in the Navigation Panel to see a list of tasks. Then select a search filter from the 
Viewmenu. 

● Click an analysis type listed under the Analysis Workbench and then click the View Tasks 
section to see a list of tasks. Then select a search filter from the View menu. 

2 View task details in the following ways:

● Sort the list by clicking a column header. Click again to reverse the sort direction. Select a 
different search filter from the View menu, or select Custom Filters to add a custom filter 
to the list. 

● Click the underlined name of a task to view additional details, including the percentage of 
the task that is complete and any comments. Click Cancel to return to the list of tasks.

Deleting Tasks
You can delete tasks in any state for which you are the requester or task owner. Scenario 
participants cannot delete tasks. 

➤ To delete a task:

1 Depending on the tasks you wish to delete:

● Click Tasks in the Navigation Panel for a list that includes standalone tasks and tasks 
associated with scenarios.

● Click an analysis type listed under the Analysis Workbench and then click the View Tasks 
section for a list that includes standalone tasks and tasks associated with scenarios of that 
analysis type.

2 Select a search filter from the View menu, or select Customize Filter to add a custom filter to the list. 

3 Do one of the following to select individual tasks or a block of tasks:

● Select one or more tasks by enabling their checkboxes. Alternatively, hold down the CTRL 
key as you click individual tasks in the list.

● Select a block of tasks by holding down the SHIFT key as you click and drag to select a 
range of tasks 

● Click Select All or Deselect All near the top right of the screen to select or deselect the 
entire list. These links appear if the list contains fewer than 100 items.

4 Click the Delete Tasks button. 
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Creating Tasks
When you create a task you give it a name, text description, and due date. As the task requester, 
you then assign the task to yourself or another user to complete. Both the requester and task 
owner can edit task details including task status at any time. They view task progress on their 
Home pages. For tasks that are associated with a particular scenario, scenario participants can 
also edit tasks.

Any user can create a standalone task, even if that user has no assigned analysis types. To create 
a task that is associated with an existing scenario, you must be the scenario owner, a 
participant, or an administrator. You can create tasks associated with a scenario only while the 
scenario is in the In Progress state. 

➤ To create a task:

1 Do one of the following:

● In the Tasks panel of your Home page, click Create Task. If you have one or more assigned 
analysis types, select an analysis type from the menu.

● In the Navigation Panel, click Tasks, then click the Create Task button. If you have one or 
more assigned analysis types, select an analysis type from the menu.

● Click the name of an analysis type under the Analysis Workbench, click the View Tasks 
section, and then click the Create Task button. You can use this method only if you have 
one or more assigned analysis types or if you are a scenario participant.

● Within a scenario in the Scenario Summary panel, click the Add Task button.

2 Specify task details: 

● Subject—Enter a brief description of the task which is also used as the display name. A 
subject is required.

● Due Date—Click the calendar icon to select a due date for the task. A due date is required. 
Due dates that are in the past are displayed in red on the Home pages of the requester and 
task owner. 

● Status—Select the task status from the menu. For example, for a newly created task, select 
Not Started. The requester, task owner, and scenario participants can change the task status 
as desired while the scenario is in the In Progress state.

● Start Date—Click the calendar icon to select a date when the task should start. 

● Priority—Select the task priority (Low, Normal, or High) from the menu.

● % Complete—Select a value for the percentage of the task that is complete.

● Owner—Select a user to be the task owner. The task name will be displayed on the Home 
pages of the requester and task owner.

● Scenario—Select one of the following options from the menu if it is displayed:

❍ None—Select None to create a standalone task. The task will be listed the View Tasks 
section for every analysis type in the Analysis Workbench, and in the Tasks section of 
the Navigation Panel.



98  Performing an Analysis 

❍ Scenario Name—Select a scenario name to associate the task with the scenario. The 
task will be listed in the Scenario Summary panel when you view scenario details, and 
in the View Tasks section for the scenario's analysis type.

● Comments—Enter any additional information about the task and its progress in the text 
field.

Enable one or both checkboxes to automatically send an email notification to the task owner 
and/or scenario participants when the task is saved. 

3 Click the Create button to save the task and return to a list of tasks.

4 Click the name of the task in the list to view task details.

If you created the task from within a scenario, click OK to return to scenario details screen and 
then click Save to save your changes to the scenario. Click the name of a task in the Scenario 
Summary panel to view task details.

Editing Tasks
The requester, owner, and administrators can edit a standalone task that is in any state. 

When a task is associated with a scenario that is in the In Progress state, it can be edited by the 
requester, owner, scenario participants, and administrators. However, scenario participants 
must view scenario details to see and edit the task.

When a task is associated with a scenario that is in the Submitted, Approved, or Complete state, 
it can be edited by the requester, owner, and administrators. However, they must use the Tasks 
section in the Navigation Panel to see and edit task information. Approvers cannot edit tasks. 

➤ To edit a task:

1 Do one of the following:

● On your Home page, click a link in the Tasks panel to see a list of tasks that you requested 
or are assigned, or tasks that are overdue or deferred. 

● In the Navigation Panel, click Tasks and select a search filter from the View menu. 

● Click an analysis type listed under the Analysis Workbench and then click the View Tasks 
section to see a list of tasks. Then select a search filter from the View menu. 

● Within a scenario in the Scenario Summary panel, click the name of a task associated with 
the scenario.

2 Edit task details: 

● Due Date—Click the calendar icon to select a due date for the task. A due date is required. 
Due dates that are in the past are displayed in red on the Home pages of the requester and 
task owner. 

● Status—Select the task status from the menu. For example, for a newly created task, select 
Not Started. The requester, task owner, and scenario participants can change the task status 
as desired while the scenario is in the In Progress state.

● Priority—Select the task priority (Low, Normal, or High) from the menu.
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● % Complete—Select a value for the percentage of the task that is complete.

● Owner—Select a user to be the task owner. The task name will be displayed on the Home 
pages of the requester and task owner.

● Comments—Enter any additional information about the task and its progress in the text 
field.

Enable one or both checkboxes to automatically send an email notification to the task owner 
and/or scenario participants when the task is saved. 

3 Click the Save or OK button to save task changes and return to the previous screen. 
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P a r t I I I

Using the Administration Workbench

In Using the Administration Workbench:

● Using the Data Designer Tab

● Using the Model Designer Tab

● Using the Administration Tab

● Isadmin Commands
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Understanding Cubes, Dimensions, and Measures
Data in the Oracle Stragetic Operational Planning database includes:

Cubes

Dimensions

Dimension Hierarchies

Dimension Namespaces

Measures

Measure Types

Key Metrics

Cubes
A cube is a subset of data organized in a multidimensional structure. Cubes are defined by a set 
of dimensions. A cube has at least two dimensions, one of which is a measure dimension. 
Other dimensions provide indexes to identify measure values in the cube.

A planning worksheet provides a view of the data in a cube. Each planning worksheet is 
associated with one cube. However, a cube can be associated with more than one planning 
worksheet, with each worksheet providing a view of a different slice of cube data.

The dimensions in a cube are based on categories of business data. Common dimensions are 
Fiscal, Manufacturing, Geography, Product, and Customer. Each dimension is composed of 
members which can be organized into hierarchies with levels. For example, hierarchy levels in 
the Fiscal dimension include months, quarters, and years. 
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Note: For additional examples of dimensions and members, and an overview of how dimensions are used in planning 
worksheets, see “Using Oracle Strategic Operational Planning Tools in Excel” on page 36.

Dimensions
Dimensions types include:

● Time—A dimension composed of time periods such as Weeks, Months, Quarters, and 
Years. Time dimensions are organized into hierarchies that represent the fiscal or 
manufacturing calendar. You cannot edit time dimensions. Time dimensions are a special 
type of dense dimension.

● Sparse—A dimension in which a cube contains relatively fewer data values, so that a smaller 
percentage of dimension intersections correspond to data values.

● Dense—A dimension in which a cube contains relatively more data values, so that a greater 
percentage of dimension intersections correspond to data values.

● Measure—A dimension whose members are the measures calculated in an analysis. The 
measure dimension is not organized into hierarchies. 

A dimension can belong to more than one cube. For example, most cubes contain a time 
dimension such as Fiscal or Manufacturing. 

A dimension definition contains the following elements:

● One or more members

● One or more namespaces

● One or more hierarchies (optional)

If hierarchies are defined, one hierarchy must be designated as the default hierarchy. 
Hierarchies can be statically defined or determined dynamically during runtime. For example, 
hierarchies in the Components dimension depend dynamically on a Bill of Materials (BOM). 
As a result, there may be multiple hierarchy roots that change during runtime. You cannot edit 
dimensions with dynamically defined hierarchies.

For editable dimensions, you can edit dimension hierarchies, namespaces, and members. After 
editing a dimension, you must restructure cubes that contain it to reorganize dimension 
members and recalculate data values. For example, adding a product to the Product dimension 
can affect other dimensions such as Product Line which must then be reorganized. Data values 
in the cube, which are located at intersections of cube dimensions, must also be recalculated. 
Editing the measure dimension, for example, by modifying a measure formula, likewise 
requires recalculating data values. 

Dimension Hierarchies
A dimension can contain one or more hierarchies, with one hierarchy defined as the default 
hierarchy. A hierarchy does not need to contain all of a dimension's members, and a dimension 
member can appear in more than one hierarchy. In a hierarchy, each dimension member 
belongs to a hierarchy level. 
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Members that occupy the same level are called siblings. The sequence of siblings in a level is 
important, making it possible to specify a particular sibling member in formulas for measures 
and exceptions. In a hierarchy diagram, a sibling sequence moves from left to right in a level, 
with the leftmost member the "first" member and the rightmost member the "last" member. In 
the Administration section of the user interface, the sequence of siblings moves from top to 
bottom in a list, with the member at the top the "first" and the member at the bottom the "last." 
See “Working with Measure and Constraint Formulas” on page 108 for a list of functions used 
to express the location of a member in a hierarchy level relative to its siblings

The diagrams below illustrate the terminology used to describe dimension hierarchies.
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Dimension Namespaces
A namespace is a mapping that matches dimension member names to internal system IDs. 
Each dimension member belongs to a specific dimension namespace. This mapping is 
especially important when individual dimension members share the same name. For example, 
the Time dimension contains several members named "January"; however, each of these 
belongs to a different namespace corresponding to a fiscal year such as FY 2003, FY 2004, or FY 
2005. A dimension can contain more than one namespace.

Likewise in the Geography dimension, there may be more than one dimension member named 
West, corresponding to the West territory in different geographic regions. Each dimension 
member West therefore belongs to a different namespace, such as NA or EMEA.

Note: A namespace is not the same as a dimension hierarchy. A hierarchy defines the structure of a dimension, that is, 
how the members are organized. A namespace provides a naming system to uniquely identify members. A 
member can belong to more than one hierarchy; however a member belongs to one and only one namespace.

A dimension member has a fully qualified name which includes its namespace. The fully 
qualified member name is expressed as follows:

/dimension name/namespace/member name

For example, the fully qualified member name of the dimension member January in the 
dimension Fiscal in the namespace FY 2005 is expressed as:

/Fiscal/FY 2005/January

A dimension has a default namespace whose name is the same as the dimension name. In 
addition, the default namespace contains a member with the same name as the dimension. For 
example, in the Fiscal time dimension, the fully qualified name of the default dimension 
member is given as:

/Fiscal/Fiscal/Fiscal

Measures
A measure is a member of a special type of dimension called a measure dimension. A measure 
dimension and its measures belong to only one cube. An example of a measure dimension is 
the Demand dimension, which belongs to the Demand cube and contains measures such as 
Projected Sales and Booked Units. A measure dimension is not organized into hierarchies and 
contains only one namespace with the same name as the cube it belongs to.

A measure, for example, Projected Sales, has numerical values that are located at intersections 
of cube dimensions, with coordinates given by one member from each dimension. All 
measures have a data type of double.
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Measure Types
Measure types include:

● Loaded—Measure values are numerical data loaded from an existing system into the Oracle 
Strategic Operational Planning database; for example, CSV files. Examples of loaded 
measures are Booked Sales and Shipped Units. When a loaded value does not exist, a 
formula can be used to derive it. The formula never overrides a loaded value, however.

For example, consider a formula in which the Inventory value for the current week is given 
by the value for the previous week. If loaded values for Inventory include a value for the 
current week, the loaded value is used. If a loaded value does not exist for the current week, 
the value for the previous week is used.

● Input—Measure values are numerical data entered directly into an Oracle Strategic 
Operational Planning planning worksheet. For example, one source of input measure 
values can be data in existing Excel spreadsheets used for forecasting.

● Derived—Measure values are calculated from formulas using Oracle Strategic Operational 
Planning built-in functions. Derived values can be based on other measures, including 
loaded and input measures. Examples of derived measures include Actual Average Selling 
Price and Excess Material Cost.

● Cross-cube—Measure values in one cube are calculated from formulas that depend on 
measure values in other cubes. Examples of cross-cube measures are Forecast Projected 
Sales and Forecast Booked Sales, whose values depend on measures in both the Demand and 
Forecast cubes. 

Key Metrics
A key metric corresponds to a particular measure value of interest, for example a particular 
value of Projected Sales, that is located at a specified intersection of cube dimensions. 

For example, the measure Projected Sales belongs to the Demand cube, with dimensions 
Demand, Product, and Fiscal. A key metric can be defined as the value of Projected Sales (in 
the Demand dimension) for product KFB (in the Product dimension) during the time period 
Q2 '05 (in the Fiscal dimension). A different key metric can be defined as the value of Projected 
Sales for All Products during the time period Fiscal 2005.

A scenario includes default key metrics whose values are calculated and displayed in the Key 
Metrics panel on the Perform Analysis screen or the Impact window in Excel during an 
analysis. Key metrics are chosen based on the measure values that are most important in a 
particular analysis type.
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Working with Measure and Constraint Formulas
In Excel, you can change display options to show the formulas that are used to calculate 
measures in a planning worksheet. 

As a planner, you may want to view formulas to see how the measures you work with are 
derived.

As an administrator, you may want to customize planning worksheets to add new measures, 
along with formulas for calculating their values from other data in the Oracle Strategic 
Operational Planning database. 

Review the following topics for information on:

● Overview of Measure Formulas

● Measure Summarization

● Types of Functions in Formulas

Overview of Measure Formulas
Planning worksheets provide a view of measure values stored in cubes in the Oracle Strategic 
Operational Planning database. Measure values can be loaded, input, or calculated, depending 
on their original data source. 

Calculated measure values are derived from formulas that take into account some or all of the 
following:

● Cell Location—The location in the worksheet of the cell containing the measure value.

● Hierarchy Level—The level to which a dimension hierarchy has been expanded or 
collapsed, which determines whether the measure represents a detailed or summarized 
value.

● Time Period—The time period over which a measure value applies.Both calculated and 
non-calculated measure values can also be summarized using aggregate functions.

Measure Summarization
Measure values in a dimension can be summarized using aggregate functions to obtain 
summary values for different levels in a hierarchy. For example, in the Fiscal dimension, 
measure values that apply over a time period of a month can be summarized at the quarter 
level and again at the fiscal year level. In this way, a dimension hierarchy in a planning 
worksheet can be expanded or collapsed to expose more detailed or summarized data. 

Measure values can be summarized differently in each dimension. Measure values cannot be 
summarized in the measure dimension.
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The following aggregate functions can be used to summarize measure values in a particular 
dimension, depending on the type of dimension:

● Count—Returns a count of the values in the next lowest level of a dimension hierarchy. 

For example, in the Fiscal dimension, the dimension member Q2 '05 has three children in 
the hierarchy: the months April, May, and June. The summary value for Q2 '05 is therefore 
three. This function is used in dense and time dimensions only. (This aggregate function is 
not currently used.)

● Max—Returns the highest value in the next level down in a dimension hierarchy, that is, the 
maximum value of the children in the hierarchy. 

For example, in the Fiscal dimension, the dimension member Q2 '05 has three children in 
the hierarchy: the months April, May, and June. If values for April, May, and June are 14, 
11, and 15, respectively, the summary value for Q2 '05 is 15. This aggregate function is used 
only in dense and time dimensions. (This aggregate function is not currently used.)

● Min—Returns the lowest value in the next level down in a dimension hierarchy, that is, the 
minimum value of the children in the hierarchy. 

For example, in the Fiscal dimension, the dimension member Q2 '05 has three children in 
the hierarchy: the months April, May, and June. If values for April, May, and June are 14, 
11, and 15, respectively, the summary value for Q2 '05 is 11. This aggregate function is used 
only in dense and time dimensions. (This aggregate function is not currently used.)

● Sum—Returns the sum of the values in the next level down in a dimension hierarchy, that 
is, the sum of the values of the children in the hierarchy.

For example, in the Fiscal dimension, the dimension member Q2 '05 has three children in 
the hierarchy: the months April, May, and June. If values for April, May, and June are 4, 1, 
and 5, respectively, the summary value for Q2 '05 is 10. This aggregate function is used to 
summarize values in sparse, dense, and time dimensions.

● Avg—Returns the average of the values in the next level down in a dimension hierarchy, that 
is, the average value of the children in the hierarchy.

For example, in the Fiscal dimension, the dimension member Q2 '05 has three children in 
the hierarchy: the months April, May, and June. If values for April, May, and June are 4, 3, 
and 5, respectively, the summary value for Q2 '05 is 4. This function is used in dense and 
time dimensions only. 

● Last_in_Period—Used only for time dimensions (Fiscal and Manufacturing). Returns the 
value for the last member in a sequence of children.

For example, in the Fiscal dimension, the dimension member Q2 '05 has three children in 
the hierarchy arranged in the sequence April, May, June with values 4, 3, and 5, 
respectively. The summary value for Q2 '05 is the value for June (5). This function is used 
in dense and time dimensions only. 

● First_in_Period—Used only for time dimensions (Fiscal and Manufacturing). Returns the 
value for the first member in a sequence of children.

For example, in the Fiscal dimension, the dimension member Q2 '05 has three children in 
the hierarchy arranged in the sequence April, May, June with values 4, 3, and 5, 
respectively. The summary value for Q2 '05 is the value for April (4). This function is used 
in dense and time dimensions only. 
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In dense and time dimensions, measures can be summarized using any of the above aggregate 
functions. In sparse dimensions, measures can only be summarized using the sum aggregate 
function. For more information on types of dimensions and measures, see “Understanding 
Cubes, Dimensions, and Measures” on page 103.

Types of Functions in Formulas
The arguments (inputs) to functions used in formulas may be numbers, alphanumeric 
characters, variables, logical values (true or false), cell locations, or other formulas.

The following types of built-in Oracle Strategic Operational Planning functions are available:

● Mathematical Functions—Standard mathematical functions for calculating sums, 
differences, ratios, percentages, averages, and so on.

● Dimension Hierarchy Functions—Functions for specifying levels and members in a 
dimension hierarchy, such as parents, children, or siblings. 

● Logical Functions—Functions which return a specified result depending on whether a 
condition is true or false, including functions for setting multiple test conditions (true or 
false conditions).

● Comparison Functions—Functions for comparing two numbers or character strings, for 
example, to determine if one number is less than, equal to, not equal to, or greater than the 
other.

● Time Functions—Functions for specifying cell locations that correspond to a past or future 
time period, or for determining whether a measure applies to the current time period or a 
past or future time period.

● Update Functions—Functions for updating cells with newly recalculated measure vales and 
for checking whether any constraints are broken.

Data Flow and Mapping
Figure 1 shows how modeling data from external sources is staged and loaded into the Oracle 
Strategic Operational Planning database. Modeling data is mapped to Oracle Strategic 
Operational Planning rowsources and cubes using XML metadata definition files. 
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Figure 1 How Modeling Data from External Sources is Staged and Loaded into Oracle Strategic Operational 
Planning

● Datasources—Relational tables in the Oracle Strategic Operational Planning database 
where copies of external modeling data are stored. By default, the Oracle Strategic 
Operational Planning application looks in /install/config/data for files containing 
the data; for example, CSV text files. The data is then loaded into datasources in the Oracle 
Strategic Operational Planning database. The default directory for external modeling data 
is specified in ISServer.properties.

● Datasource Definitions—XML files that specify which datasource columns in a datasource  
to use. Using all columns in a datasource is not required. By default, datasource definition 
files are located in /install/custom/datasource .

● Stagemaps—XML files that map datasources to rowsources or dimensions in the Oracle 
Strategic Operational Planning database. One datasource can be mapped to more than one 
rowsource. For example, each rowsource can contain some of the columns of the original 
datasource. By default, stagemap files are located in 
directory/install/custom/loader.

When datasources are mapped to dimensions, Oracle Strategic Operational Planning maps 
the names from the tabular datasource to the elements of the dimension’s hierarchical 
structure. In addition to mapping datsource columns to dimension members  at all levels, 
Oracle Strategic Operational Planning maps  the attributes of dimension members and 
specifies the relationship (for example, parent-child).

● Rowsources—Relational tables in the Oracle Strategic Operational Planning database 
containing data values. Rowsources can be mapped to cubes.

Oracle Strategic Operational Planning supports one-to-one mapping of rowsource values 
to a single value in a cube measure or aggregation of rowsource values to a single value in 
cube measure. Rowsource columns are mapped to dimension member names in the cube, 
and the values are mapped to different measures. 

● Dimension Definitions—XML files that specify the namespace name, hierarchy names, and 
hierarchy level names for a dimension. By default, dimension definition files are located in 
/install/custom/model.

● Rowsource Definitions—XML files that specify the columns in a rowsource and the parent-
child relationships between rowsources. By default, rowsource definition files are located in 
/install/custom/rowsource.



112  Using the Data Designer Tab 

● Cube Definitions—XML files that specify the dimensions in a cube, the names of measures 
in the cube  and measure formulas, the names of rowsources mapped to the cube, and cube-
to-cube mapping information. By default, cube definition files are located in 
/install/custom/model.

The mapping between different cubes allows  data values in one cube to flow to data values 
in another cube. Since the cubes have different structures, the mapping defines how to flow 
the data. The mapping is like a table join in relational world—it defines the common 
dimensions and how to map/join them.

Understanding the Data Designer User Interface
Figure 2 shows the Oracle Strategic Operational Planning Data Designer.

Figure 2 Sample Data Designer

Sections in the Data Designer include:

● Object Browser—Shows the selected elements. You can view datasources, rowsources, 
dimensions, and cubes. Click Actions to add, delete, or edit an element.

● Object Properties—Properties of the selected element. 

● Object Details—Details of the selected element. Select a tab to define how to view the 
details.

❍ Definition—Name, description, type, file type, filename, and data fields for the 
selected element.
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❍ Graph—Graphical representation of the relationship between the selected element 
and other elements. 

Click an element to view available actions for the element. For example, clicking a cube 
brings up a menu where you can re-center, edit, or delete the cube; map the cube to 
another datasource; or map the cube to another cube.

Click the line between elements to edit or delete the mapping between the elements. 
Available mappings include cube-to-cube, cube-to-rowsource, and rowsource-to-
datasource.

❍ Relationships—Name, type, and mapping for the selected element.

Building a Model
Use the Data Designer to build a model. Building a model involves:

● Creating a Datasource

● Creating a Rowsource

● Creating a Dimension

● Creating a Cube

● Creating Maps

Creating a Datasource

➤ To create a datasource:

1 On the Object Browser View menu, select Datasources.

2 Click Actions and select Add.

A Datasource Wizard is displayed, where you can enter information about the datasource.

3 Enter datasource Properties information.

● Name—Datasource name.

● Description—Description of the datasource.

● Type—Datasource file type. Select Flat File, Excel File, or Database.

● Details—Information about the file. 

❍ For Flat Files, enter a filename and a file type (delimited or fixed width).  

❍ For Excel Files, enter filename and an Excel sheet name. 

❍ For Database files, define a database connection. Either select an existing connection 
or click New to define a connection.

When entering a filename for Flat Files or Excel Files, do one of the following:

❍ Type in the file name.

❍ Click Browse to display the files on the server data tray.
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❍ Click Upload to upload a file from your own machine. When you select a file after 
clicking Upload, the file is uploaded to the server.

4 Enter datasource Configuration information.

● Delimiter—Separator between fields in a datasource. Select Tab, Comma, Semicolon, or 
Pipe.

● Start Row—Row on which to start importing data. (The Start Row is usually 2.)

● Header Row—Row that contains the column titles. (The Header Row is usually 1.)

● Missing Trailing Values—How to treat rows or columns that are missing values. Select 
Treat as Error or Treat as Null.

● Text Qualifier—How to display (or not display) the quotes around text values. Select 
None, Double Quote, or Single Quote.

● End Row—Row on which to stop importing the data. (Leave blank to import all rows.)

● Row Increment—Number of rows to advance when importing data. (Default is 1)

● Pivot Data—If the underlying Excel data is in a simple tabular format, select False. If the 
underlying Excel data is in a pivot format, select True. Pivoting implies that the file is 
anchored vertically along a few columns and then horizontally along other columns, with 
data at the intersection of the vertical and horizontal columns. 

Click Preview to see how your data will appear.

5 Review the data Fields.

● Refresh Fields—Refresh the data fields that are defined. Click this button if no fields 
initially appear.

● Create—Create a new data field.

If you create a new data field, enter the following information:

❍ Name—Data field name.

❍ Type—Data field file type. Select String, Double, Integer, Date, or Duration.

❍ Nullable—Whether a value is allowed to be empty. Select True or False.

❍ Orientation—Select Vertical or Horizontal to define how to display the data field in 
relation to other data fields. 

If vertical, enter the column number in which the data field will be displayed.

If horizontal, enter a row number and row type. A row type can be absolute or relative. 
Absolute rows are horizontal header columns, and you must specify the actual row 
numbers. Relative rows indicate the data columns, and the row number must be zero.

❍ Default—Default data field value.

❍ Date Format—For Data data fields, select the format in which the date will appear.

❍ Null Values—How to treat null values. Select Remain as Null or Default to Previous 
Non-Null value.

● Edit—Edit an existing data field.

● Delete—Delete an existing data field.
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6 Click Save to create the datasource and map it to a rowsource.

The datasource is displayed in the Object Browser and is automatically mapped to a rowsource. 
(See “Data Flow and Mapping” on page 110 for details on how data is staged and loaded into 
the Oracle Strategic Operational Planning database.)

Note: It is important to review the rowsource generated through automatic mapping for key values. The automatic 
generation assigns the first column as the key column of the rowsource. This may not be valid, and you may need 
to modify the rowsource. Similarly, when the stagemap is automatically generated for the mapping between a 
datasource and a rowsource, a default group name is assigned to the stagemap. You should review this default 
group name for accuracy.

Creating a Rowsource

➤ To create a rowsource:

1 On the Object Browser View menu, select Rowsources.

2 Click Actions and select Add.

A Rowsource Wizard is displayed, where you can enter information about the rowsource.

3 Enter rowsource Properties information.

● Name—Rowsource name.

● Description—Description of the rowsource.

● Parent Rowsource—Select a parent rowsource, or select None if there is no parent.

● Time Varying—Select True or False. If True, a column is automatically created in the 
rowsource for the effective date.

4 Create rowsource Columns. 

To create columns, click Create and do one of the following:

● Add Columns from the Datasource—Click Add from Datasource to display the Add 
Rowsource Columns dialog box.  When you select a datsource, the columns in the 
datasource are displayed. Select the desired columns and click OK. You can select as many 
datasources/columns as desired.

● Create New Columns—Click Create New to create a new column. Enter the following  
infomation about the column:

❍ Name—Column name.

❍ Type—Column type. Select String, Double, Integer, Date, Timestamp, or Boolean.

❍ Nullable—Whether a value is allowed to be empty. Select True or False.

❍ Data Constraint—Whether the data is restricted. Select None, Range, or Specific 
Values. If you select Range, enter the starting and ending values. If you select Specific 
Values, enter a list of values. To add a value, click Add.

❍ Style—Style of the column. Click  and select a style from the menu.

❍ Size—(String) Column size.
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❍ Precision—(Double) Accuracy in terms of number of decimal places. For example, 
with a precision of 3, the number 45.3768 is rounded to 45.377.

❍ Date Format—(Date) Format in which the date will appear.

❍ Default—Default column value.

5 Enter Key and Indices information.

● Rowsource Key—Each row has a unique key. Click Edit and define the rowsource key by 
moving the desired column(s) from Available Columns to Selected Columns. (For time 
varying rowsources, the effective data is automatically part of the key.)

● Rowsource Mapping Order—Column order in the rowsource. Click Edit and define the 
order by moving the desired column(s) from Available Columns to Selected Columns. 

● Rowsource Indices—Click Create or Edit and define rowsource indices by moving the 
desired column(s) from Available Columns to Selected Columns. Select True or False to 
define whether the rowsource index is unique.  You can define as many rowsource indices 
as desired. Defining rowsource indices improves query performance. 

● Rowsource Index Details—Click on a rowsource index defined above to view its details.

6 Click Save to create the rowsource.

The rowsource is displayed in the Object Browser. 

Note: See “Data Flow and Mapping” on page 110 for details on how data is staged and loaded into the Oracle Strategic 
Operational Planning database.

Creating a Dimension

➤ To create a dimension:

1 On the Object Browser View menu, select Dimensions.

2 Click Actions and select Add.

A Dimension Wizard is displayed, where you can enter information about the dimension.

3 Enter dimension Properties information.

● Name—Dimension name.

● Description—Description of the dimension.

● Type—Select Dense, Sparse, or Time. (See “Dimensions” on page 104 for dimension type 
descriptions.)

4 Enter dimension Hierarchies information.

● Name—Dimension hierarchy name.

● Root Member—Top member of the hierarchy.

● Dynamic—Select True or False to define whether the parent/child relationship of the 
dimension is data driven. If True, enter the dimension class.

● Class—Java class that defines the hierarchy.
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● Levels—Number of levels in the hierarchy.

● Associate Styles to Levels—Whether to define styles for the levels in the hierarchy. If 

associating styles to levels, click  and select a style.

See “Dimension Hierarchies” on page 104 for additional hierarchy information.

5 Enter dimension Attributes information.

Click Create or Edit and enter attribute details. Attributes define information about a member 
in the dimension. Attributes are used for filtering and searching.e.

6 Click Save to create the dimension.

The dimension is saved in the Object Browser.

Note: See “Understanding Cubes, Dimensions, and Measures” on page 103 and “Data Flow and Mapping” on 
page 110 for additional information on dimensions and how data is staged and loaded into the Oracle Strategic 
Operational Planning database.

Creating a Cube

➤ To create a cube:

1 On the Object Browser View menu, select Cubes.

2 Click Actions and select Add.

A Cube Wizard is displayed, where you can enter information about the cube.

3 Enter cube Properties information.

● Name—Cube name.

● Description—Description of the cube.

● Cube Publish Order—Order in which to publish the cube.

The Administration Workbench automatically assigns a cube order. To accept, this order, 
leave the Cube Publish Order at default; otherwise, assign a Cube Publish order.

4 Define Dimensions for the cube.

Click Add and select dimensions from the Add Dimensions dialog box. After you add a 
dimension, you can select it to view its details. (See “Dimensions” on page 104  and “Creating a 
Dimension” on page 116 for detailed information about dimensions.)

5 Define Measures for the cube and define a default measure.

Click Create to access the Measure Wizard and define a measure. After you add a measure, you 
can select it to view its details. (See “Measures” on page 106 for detailed information about 
measures and “Creating Measures” on page 118 for information about creating measures in the 
Measure Wizard. )

6 Review dimension Summarization information.

The dimensions defined earlier in the wizard are displayed. Click a dimension to view its 
details.
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7 Define cube Constraints.

Click Create to access the Contraints Wizard and define a constraint. After you add a 
constraint you can select it to view its details. (See “Creating Constraints” on page 119 for 
information about creating constraints in the Constraint Wizard.)

8 Define cube Allocation Maps.

Click Create to access the Cube Wizard and define an allocation map. (See “Creating an 
Allocation Map” on page 129 for more information.)

9 Click Save to create the cube.

The cube is displayed in the Object Browser.

Note: See “Understanding Cubes, Dimensions, and Measures” on page 103 and “Data Flow and Mapping” on 
page 110 for additional information on dimensions and how data is staged and loaded into the Oracle Strategic 
Operational Planning database.

Creating Measures

➤ To create a measure:

1 Click Create on the Measures page in the Cube wizard.

A Measure Wizard is displayed, where you can enter information about the measure.

2 Define measure Properties information.

● Name—Measure name.

● Display Name—How the measure is displayed in Excel.

● Description—Description of the measure.

● Type—Select Cross-Cube, Derived, Input, or Loaded. (See “Measure Types” on page 107.)

● Precision—Accuracy in terms of number of decimal places. For example, with a precision 
of 3, the number 45.3768 is rounded to 45.377.

● Check Consistency—Select True or False to define whether Oracle Strategic Operational 
Planning should check if the measure value is different from the calculated value. Not valid 
for input values coming from another source.

● Hidden—Whether the measure is hidden from end users. Select True or False.

● Style—Formatting to apply to the measure. Click  and select a style.

3 Define measure Definition information.

● For Cross-Cube measures, enter the following information:

❍ Cube—Source cube containing the cross-cube value.

❍ Measure—Measure in the source cube on which the current target measure depends.

❍ Formula—Formula used for batch calculation.

❍ Onchange Formula—Formula used for interactive calculation.
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● For Derived measures, enter a measure formula and click Validate. (See “Working with 
Measure and Constraint Formulas” on page 108.)

● Input measures do not have associated formulas. You can input the measure values at 
runtime while performing analysis.

● For Loaded measures, enter the following information:

❍ Rowsource—Click  and select a rowsource.

❍ Rowsource Column—Click  and select a rowsource column.

❍ Formula—Enter a measure formula and click Validate. (See “Working with Measure 
and Constraint Formulas” on page 108.)

❍ Filters—How to filter the measures. The filters that are displayed are based on the filter 
details entered below.

❍ Filter Details—Enter filter details by selecting a column, selecting an operator, and 
entering a value. (For example, the column could be customerid, the operator could be 
equals, and the value could be 100.)

4 Enter dimension Summarizations for the measure.

For each meausre, select Rollup/Rolldown values. Rollup values are complex aggregation 
operators. Rolldown values are allocation operators. 

If you select custom, enter the following information:

● Source Level—For rollup, the level from which the aggregation starts. For rolldown, the 
level from which allocation starts.

● Operation Map—An allocation map defined in the cube where you define intermediate 
end levels.

● Formula—Batch calculation formula used during rollup/rolldown.

● On Change Measure—Dependency measure. Changing this measure triggers rollup/ 
rolldown.

● On Change—Interactive equivalent of batch formulas for rollup/rolldown.

● Propagate on Existance—Defines whether to creates new children and roll down values to 
those children..

Note: See “Measures” on page 106, “Overview of Measure Formulas” on page 108, and “Measure Summarization” on 
page 108 for additional information on measures.

Creating Constraints

➤ To create a constraint:

1 Click Create on the Constraints page in the Cube wizard.

A Constraint Wizard is displayed, where you can enter information about the measure.

2 Define constraint Properties information.

● Name—Constraint name.
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● Description—Description of the constraint.

● Type—Constraint type.

❍ Batch—Business-rule violations are only evaluated at batch calculation time and not 
during interactive what-if analysis. Also known as "Reporting" constraints.

❍ Conditional—Business rule violations are not evaluated up front; instead, Oracle 
Strategic Operational Planning checks for these violations at certain intersections and 
flags them in them user interface. Also known as “Display Only” constraints since the 
violations are not stored.

❍ Interactive—Business-rule violations are evaluated for batch calculations and 
interactive calculations. 

For example, new violations may be introduced during what-if analysis or existing 
violations may get fixed by changing some values. 

● Default Assignee—Who to notify to fix the violation.

● Priority—Priority of the constraint. Select Low, Normal, or High.

● Days till Due—Number of days until the default assignee should fix the violation. 

3 Define the constraint Condition.

To define the constraint condition, select a measure and enter a formula. Click Validate to 
ensure that the formula is valid before proceeding. (See “Overview of Measure Formulas” on 
page 108.)

4 Define constraint Reporting Detail.

Click Create and enter the following information:

● Name—Constraint name.

● Display Name—How the constraint is displayed in Excel.

● Type—Type of constraint. Select String, Double, Integer, Date, Timestamp, or Boolean.

● Size—(String) Constraint size.

● Precision—(Double) Precision of the constraint.

● Format—(Date) Format in which the constraint date is displayed.

● Key—Whether the constraint has a key associated with it. Select True or False.

● Formula—Enter a formula for the constraint.

5 Define the Severity of the constraint.

The severity is a formula that gets evaluated and is used in conjunction with the styles. 

For example, the following formula evaluates "severity" to a number. The number is then used 
to flag the violation in different colors (specified in styles). 

   <Severity><![CDATA[
    (75 - "ASP Attainment Pct")/75*100
    ]]></Severity>
    <Styles>
    <Style styleID="greenBackground" layer= "1"><![CDATA[
    Severity <= 50
    ]]></Style>
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    <Style styleID="orangeBackground" layer= "1"><![CDATA[
    Severity > 50 and Severity < 75
    ]]></Style>
    <Style styleID="redBackground" layer= "1"><![CDATA[
    Severity >= 75
    ]]></Style>
    </Styles>

6 Define the Style of the constraint.

● Style—Click  and select a style.

● Layer—Defines violation precedence. 

For example violations associated with styles that have a high layer number will take 
precedence over violations associated with styles that have a lower layer number.

● Formula—Formula to evaluate whether to use a particular style. The severity defined 
above is oftne used in the formula.

7 Click Save to save constraint information.

Creating Maps
When you add a datasource, rowsource, dimension, or cube in the Data Designer, maps are 
automatically created. Available mappings include cube-to-cube, rowsource-to-cube,  
datasource-to-rowsource, datasource-to-dimension, and allocation maps.

➤ To edit the mapping, click the line between objects in the Object Details Graph tab and select 
Edit Mapping.

When you edit a map, a green checkmark appears next to the object in the Object Browser.

Review the following sections for information on creating maps:

● Creating a Cube-to-Cube Map

● Creating a Rowsource-to-Cube Map

● Creating a Datasource-to-Rowsource Map

● Creating a Datasource-to-Dimension Map

● Creating an Allocation Map

Creating a Cube-to-Cube Map

➤ To create a cube-to-cube map:

1 In the Data Designer, go to the Object Details Graph tab, click the line between the cubes, and select Edit 
Mapping.

A Cube Mapping Wizard is displayed, where you can edit information about the mapping.

2 Review Source and Target cube information.
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3 Define the Cube Scope for the source and target cubes by selecting a scope type and entering a value for 
each dimension. 

The cube scope defines which members participate in the data flow from the source cube to the 
target cube.

● All—All cube members participate.

● Function—Define a custom function; which, when evaluated, returns a list of members 
that participate.

● Level—Select a level in the dimension hierarchy. The members in that level are the 
members that participate.

● Member—Explicity specify the members that participate.

4 Review or edit Dimension Map information for the source and target cubes.

To view detailed information for a dimension, click the dimension name. The information is 
displayed under Dimension Map Details. To change dimension map information, click Edit. 

● Dimension—Name of the dimension.

● Namespace—Name to uniquely identify dimension members.  

When creating a dimension map, Oracle Strategic Operational Planning passes the name 
of the dimension and the value of the namespace to the mapping function to evaluate the 
target members. 

In the following example, when Oracle Strategic Operational Planning evaluates the 
mapping function, it uses the "ProductLine" argument  as well as the namespace and 
dimension values to determine  the target dimension members.

dimension=”Product”
namespace=”ESG”
mapping=”oneToOneMap(ProductLine)”

The namespace can be the same as the dimension name, but it does not have to be. See 
“Dimension Namespaces” on page 106 for detailed information on namespaces.

● Transformation—An optional function applied to the result of the mapping function.

Oracle Strategic Operational Planning first maps source members to target members using 
the mapping function (oneToOneMap(ProductLine) in the example above). If the target 
members are not available after the mapping is complete, the transformation informaion is 
used. Transformation information is applied in the context of the target dimension.

The following is a sample dimension map:

dimension=”Manufacturing”
namespace=”Manufacturing”
mapping=”calendarmap(Fiscal)”
transformation=”childMembers”

● Mapping Type—Select Simple or Advanced. 

For Simple mappings, define the type of mapping and the dimension to which to map.

For Advanced mappings, click Add and select one or more mapping types.

5 Click Save to save the mapping information.
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Creating a Rowsource-to-Cube Map
A Rowsource-to-Cube map defines how rowsource columns are mapped to the fully-qualified 
names of members in different cube dimensions. The mapping allows Oracle Strategic 
Operational Planning to load data from each rowsource into cube cells. 

In general, there is a single mapping between a rowsource and a cube; however, Oracle 
Strategic Operational Planning allows the mapping to change by measure. 

For example, assume that one measure, shipped units, maps the "shipped_date" column of the 
rowsource to the cube, but all the other measures use "order_date". In this example, Oracle 
Strategic Operational Planning would use normal mapping overall, but use “custom” mapping 
for specific measures.

➤ To create a rowsource-to-cube map:

1 In the Data Designer, go to the Object Details Graph tab, click the line between a rowsource and a cube, 
and select Edit Mapping.

A Rowsource Mapping Wizard is displayed, where you can edit information about the 
mapping.

2 Review Source and Target information.

● Rowsource—The source rowsource for which you are editing the mapping.

● Cube—The target cube for which you are editing the mapping.

● Custom Mapping—Whether to use custom mapping for each specific measure. Select True 
or False.

● Summarized Value—Select True if you are aggregating multiple values. Select False for 
one-to-one mapping.

3 Define Default Map information.

If you defined custom mapping to be true on the Source and Target wizard page, enter:

● Custom Mapper Class—Class to generate the mapping from rowsource row to cube cell.

● Key Generator Class—Class to generate the rowsource keys given a cube cell.

If you defined custom mapping to be false on the Source and Target wizard page, define the 
default mapping by doing one of the following for each cube dimension:

● Select a rowsource column.

● Select Advanced and click Add to add one or more rowsource columns.

4 Define measure-specific maps for Custom Mapping.

If you defined custom mapping to be true on the Source and Target wizard page, you cannot 
define measure-specific maps.

If you defined custom mapping to be false on the Source and Target wizard page, define 
measure-specific maps by clicking Add Measure Map and selecting a measure. 

For each cube dimension in the measure, create a measure map by doing one of the following:

● Select a rowsource column.

● Select Advanced and click Add to add one or more rowsource columns.
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5 Define Filter information.

Click Create and enter the following filter details:

● Measure—Select a measure, or leave at All Measures to include all measures in the filter.

● Column—Select a column.

● Value—Enter a measure value. 

● Dimension—Select a dimension.

● Operator—Select an operator.

● Format—Optional Formatfor the filter value. You can leave the Format blank.

To edit an existing filter, click Edit and edit the filter information.

6 Click Save to save the mapping information.

Creating a Datasource-to-Rowsource Map

Note: A datasource-to-rowsource map is also known as a stagemap. See stagemaps under “Data Flow and Mapping” on 
page 110 for more information.

➤ To create a datasource-to-rowsource map:

1 In the Data Designer, go to the Object Details Graph tab, click the line between a datasource and a 
rowsource, and select Edit Mapping.

A Datasource Mapping Wizard is displayed, where you can edit information about the 
mapping.

2 Review Source and Target information.

● Name—Name used to identify the map. (Assigned by Oracle Strategic Operational 
Planning.)

● Datasource—The source datasource for which you are editing the mapping.

● Rowsource—The target rowsource for which you are editing the mapping.

● Groups—Groups are used to combine the related set of rowsources. Oracle Strategic 
Operational Planning defines all the stagemaps with a group name of Bootstrap-
Rowsource-Stagemaps. Using this model group, you can create macro commands without 
having to type separate commands for each stagemap.

3 Define Column Maps.

For each target column, do one of the following:

● Select a source column.

● Select Advanced and click Add to add one or more source columns.

4 Define Filters.

Click Create, select a filter type, and enter details about the filter:
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● Simple Filter

❍ Datasource Field—Field on which to filter the information.

❍ Filter Operator—Operator to use in the filter.

❍ Filter Value—Value for the filter. To include columns in the filter value, click Add and 
select a column.

❍ Non-matching are Errors—Whether to log data values that do not match with filter 
values in the error log file. Select True or False. (The default is False, data values that do 
not match with filter values will not be entered in the log file.)

● Rowsource Filter

❍ Datasource Field—Field on which to filter the information.

❍ Rowsource—Rowsource to use in the filter.

❍ Rowsource Column—Rowsource column to use in the filter.

❍ Match—Select True to only allow matching records in the filter. Select False to only 
allow non-matching records in the filter.

❍ Non-matching are Errors—Whether to log data values that do not match with filter 
values in the error log file. Select True or False. (The default is False, data values that do 
not match with filter values will not be entered in the log file.)

● Dimension Filter

❍ Datasource Field—Field on which to filter the information.

❍ Dimension—Dimension to use in the filter.

❍ Filter On—Select Namespace or Hierarchy. If you select Namespace, enter a value. (If 
you leave the Namespace value blank, the default hierarchy is used.) If you select 
Hierarchy, select a hierarchy and a hierarchy level.

See “Dimension Namespaces” on page 106  and “Dimension Hierarchies” on page 104 
for more information on namespaces and hierarchies.

❍ Allow Members—Select True to only include the records that exactly match the 
dimension member names. Select False to only include the records that do not match 
any dimension member names.

❍ Non-matching are Errors—Whether to log data values that do not match with filter 
values in the error log file. Select True or False. (The default is False, data values that do 
not match with filter values will not be entered in the log file.)

● Distinct Filter

❍ Filter Value—Value for the filter. To include columns in the filter value, click Add and 
select a column.

❍ Distinct—Whether data should have distinct values across the dataset. Select True or 
false.

❍ Non-matching are Errors—Whether to log data values that do not match with filter 
values in the error log file. Select True or False. (The default is False, data values that do 
not match with filter values will not be entered in the log file.)
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● Custom Filter

❍ Class Name—Java class name that contains the custom filter logic.

❍ Parameters—Parameters passed to the Java class.

5 Define Custom Processing information.

● Custom Pre-processing

To define custom pre-processing details, click Create and enter:

❍ Class Name—Java class containing pre-processing logic before staging starts for this 
stage map.

❍ Parameters—Parameters passed to the pre-processing Java class.

To define parameters, click Add and enter a value, type, and format for the parameter.

● Custom Post-processing

To define custom pre-processing details, click Create and enter:

❍ Class Name—Java class containing post-processing logic after staging ends for this 
stage map.

❍ Parameters—Parameters passed to post-processing Java class.

To define parameters, click Add and enter a value, type, and format for the parameter. 

6 Click Save to save the mapping information.

Creating a Datasource-to-Dimension Map

Note: A datasource-to-dimension map is also known as a stagemap. See stagemaps under “Data Flow and Mapping” 
on page 110 for more information.

➤ To create a datasource-to-dimension map:

1 In the Data Designer, go to the Object Details Graph tab, click the line between a datasource and a 
dimension, and select Edit Mapping.

A Datasource Mapping Wizard is displayed, where you can edit information about the 
mapping.

2 Review Source and Target information.

● Name—Name used to identify the map. (Assigned by Oracle Strategic Operational 
Planning.)

● Datasource—The source datasource for which you are editing the mapping.

● Dimension—The target dimension for which you are editing the mapping.

● Groups—Groups are used to combine the related set of rowsources. Oracle Strategic 
Operational Planning defines all the stagemaps with a group name of Bootstrap-
Rowsource-Stagemaps. Using this model group, you can create macro commands without 
having to type separate commands for each stagemap.
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3 Define Hierarchy Level Maps.

The hierarchies defined as part of dimensions are displayed here. Hierarchy level maps:

● Define how to map the datasource to members in different levels of the hierarchy. 

● Map the dimension member attributes. 

● Define the mapping for the attributes defined in the dimension.

To view details about a hierarchy level, click a hierarchy  and review its details under Hierarchy 
Level Map Details.

To edit a hierarchy level, select a hierarchy, click Edit, and define mapping information by 
either selecting a column or entering value for each of the following:

● Parent—Parent level in the hierarchy.

As an example of entering a value, assume you have a parent level of family_name. 
Assume further that you want to combine two columns (family_name and capacity) 
and change the parent name. In this case, you would enter 
${family_name}#${capacity} as the value.

● Namespace—Name to uniquely identify dimension members.   (See “Dimension 
Namespaces” on page 106 for more information.)

● Name Column—Datasource column that indicates the member name or an expression 
that combines different datasource columns.

● Display Name Column—Datasource column that indicates the display name or an 
expression that combines different datasource columns.

● Description Column—Datasource column that indicates the description or an expression 
that combines different datasource columns.

● Attribute—Attributes defined in the dimension.

4 Define Filters.

Click Create, select a filter type, and enter details about the filter:

● Simple Filter

❍ Hierarchy Level—Hierarchy level on which to filter the information.

❍ Datasource Field—Field on which to filter the information.

❍ Filter Operator—Operator to use in the filter.

❍ Filter Value—Value for the filter. To include columns in the filter value, click Add and 
select a column.

❍ Non-matching are Errors—Whether to log data values that do not match with filter 
values in the error log file. Select True or False. (The default is False, data values that do 
not match with filter values will not be entered in the log file.)

● Rowsource Filter

❍ Hierarchy Level—Hierarchy level on which to filter the information.

❍ Datasource Field—Field on which to filter the information.

❍ Rowsource—Rowsource to use in the filter.
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❍ Rowsource Column—Rowsource column to use in the filter.

❍ Match—Select True to only allow matching records in the filter. Select False to only 
allow non-matching records in the filter.

❍ Non-matching are Errors—Whether to log data values that do not match with filter 
values in the error log file. Select True or False. (The default is False, data values that do 
not match with filter values will not be entered in the log file.)

● Dimension Filter

❍ Hierarchy Level—Hierarchy level on which to filter the information.

❍ Datasource Field—Field on which to filter the information.

❍ Dimension—Dimension to use in the filter.

❍ Filter On—Select Namespace or Hierarchy. If you select Namespace, enter a value. (If 
you leave the Namespace value blank, the default hierarchy is used.) If you select 
Hierarchy, select a hierarchy and a hierarchy level.

See “Dimension Namespaces” on page 106  and “Dimension Hierarchies” on page 104 
for more information on namespaces and hierarchies.

❍ Allow Members—Select True to only include the records that exactly match the 
dimension member names. Select False to only include the records that do not match 
any dimension member names.

❍ Non-matching are Errors—Whether to log data values that do not match with filter 
values in the error log file. Select True or False. (The default is False, data values that do 
not match with filter values will not be entered in the log file.)

● Distinct Filter

❍ Hierarchy Level—Hierarchy level on which to filter the information.

❍ Filter Value—Value for the filter. To include columns in the filter value, click Add and 
select a column.

❍ Distinct—Whether data should have distinct values across the dataset. Select True or 
false.

❍ Non-matching are Errors—Whether to log data values that do not match with filter 
values in the error log file. Select True or False. (The default is False, data values that do 
not match with filter values will not be entered in the log file.)

● Custom Filter

❍ Hierarchy Level—Hierarchy level on which to filter the information.

❍ Class Name—Java class name that contains the custom filter logic.

❍ Parameters—Parameters passed to the Java class.

5 Define Custom Processing information.

● Custom Pre-processing

To define custom pre-processing details, click Create and enter:

❍ Class Name—Java class containing pre-processing logic before staging starts for this 
stage map.
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❍ Parameters—Parameters passed to the pre-processing Java class.

To define parameters, click Add and enter a value, type, and format for the parameter.

● Custom Post-processing

To define custom pre-processing details, click Create and enter:

❍ Class Name—Java class containing post-processing logic after staging ends for this 
stage map.

❍ Parameters—Parameters passed to post-processing Java class.

To define parameters, click Add and enter a value, type, and format for the parameter.

6 Click Save to save the mapping information.

Creating an Allocation Map

➤ To create an allocation map:

1 On the Object Browser View menu, select Cubes; then, click Actions and select Add or Edit.

2 Go to Step 6 Allocation Maps in the Cube Wizard.

See “Creating a Cube” on page 117 for all the steps to create a cube in the Cube Wizard.

3 Click Create to create a new allocation map or Edit to edit an existing allocation map.

An Allocation Map Wizard is displayed, where you can enter information about the allocation 
map.

4 Define Properties information.

● Name—Name of the allocation map.

●  Source Dimension—Select a source dimension.

5 Define the Allocation Scope.

To define the allocation scope, create an expression that specifies which dimension members 
participate in the data flow from source to target. 

6 Review or edit Dimension Map information for the source and targe dimension.

To view detailed information for a dimension, click the dimension name. The information is 
displayed under Dimension Map Details. To change dimension map infomration, click Edit.

● Dimension—Name of the dimension.

● Namespace—Name to uniquely identify dimension members. (See “Dimension 
Namespaces” on page 106 for more information.)

● Mapping Type—Select Simple or Advanced.

For Simple mappings, define the type of mapping and the dimension to wich to map.

For Advanced mappings, click Add and select one or more mapping types.

7 Click Save to save the mapping information.
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Customizing Worksheet Templates
Oracle Strategic Operational Planning worksheet templates define the layout, navigational 
hierarchy, text styles, and default view of a worksheet. Worksheet templates are in XML format. 

Default Oracle Strategic Operational Planning worksheet template files, if any, are located in 
the interlace_root\interlace\templates directory, where interlace_root is the 
Oracle Strategic Operational Planning installation directory. Do not make changes to any files 
in this directory if it exists on your system.

Worksheet template files that you can customize are located in the 
interlace_root\custom\templates directory, . You can edit a worksheet template file in 
this directory using a text editor such as Windows Notepad or an XML editor.

Caution! It is strongly recommended that you make backup copies of the default worksheet templates 
before making any changes. In addition, you should make backup copies of any customized 
worksheet templates and keep them in a location outside the Oracle Strategic Operational 
Planning installation directory.

Worksheet templates are read when the Oracle Strategic Operational Planning server is started. 
You must restart the server for changes to take effect. It may also be necessary to clear the 
Internet Explorer web browser cache on both the server and client machines to see the changes.

Note: Do not use a word processor to edit a worksheet template file. Word processors may add extra characters to the 
file.
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➤ To customize a worksheet template:

1 Make backup copies of the worksheet template files in the interlace_root\custom\templates 
directory on the server machine.

2 Open a worksheet template file in the interlace_root\custom\templates directory in a 
text editor or XML editor, and make desired changes. Save your changes.

3 Restart the Oracle Strategic Operational Planning server.

4 Open Internet Explorer on the server machine and clear the web browser cache as follows:

● On the Tools menu, select Internet Options.

● On the General tab, in the Temporary Internet files section, click the Delete Files button.

● Click OK to close the Internet Options window.

5 Follow the above steps to clear the web browser cache on all client machines that have previously been 
used to view planning worksheets, or send a message to users to complete these steps.

The content of the worksheet templates files in the /custom/templates directory is given 
below, where WorksheetName is the name of an Oracle Strategic Operational Planning 
planning worksheet.

● WorksheetName.xml

❍ <!DOCTYPE>—Document type declaration, specifies the file containing the style 
definitions used in the templates. By default, the specified file is style_types.include, 
located in the same directory.

❍ <Template>—Name of the template, which is the same as the name displayed on the 
sheet tab in Excel.

❍ <Styles>—Styles used to display dimensions and data in the worksheet.

❑ <DimensionStyle>—Name of a dimension and the style definition used to 
display it.

❑ <HierarchyStyle>—Name of one or more hierarchies for a dimension in the 
worksheet.

❑ <LevelStyle>—Names of hierarchy levels for a hierarchy in the worksheet and 
the style definitions used to display them.

❑ <MeasureStyle>—Names of measures in the worksheet and the style definitions 
used to display them.

❑ <BrokenConstraintStyle>—Style definition used to display broken 
constraints. (exceptions).

❍ <InitialLayout>—Layout of dimensions in the worksheet (row or column) and the 
default view, including:

❑ <Anchor>—Anchor cell (top left cell of a data range) used to display the first data 
value. For example:

       <Anchor row="4" column="6"/>

❑ <Cube>—Subset of data in the Oracle Strategic Operational Planning database 
used in calculations.
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❑ <Row>—Dimensions to the left of the vertical line in a worksheet, and the order in 
which they are displayed relative to the anchor cell. The order is given by an index 
number with a negative value. Dimensions with larger negative index numbers are 
displayed further from the anchor cell. Also gives the fully qualified names of the 
dimension members that are visible in the hierarchy when the worksheet is first 
opened.

❑ <Column>—Dimension displayed to the right of the vertical line in a worksheet, 
generally the Time (Fiscal or Manufacturing) dimension. Also gives the fully 
qualified names of the dimension members that are visible in the hierarchy when 
the worksheet is first opened.

❍ <InlineReports>—You should not change attribute values within this element.

❍ <NavigationalHierarchy>—You should not change attribute values within this 
element.

● style_types.include

❍ <Style>—Name and attributes of a style used in the templates, including:

❑ Interior color and pattern of cells

❑ Border color, line style, weight, and position

❑ Font color and style

❑ Number format

❑ White space (blank column or row) between the current hierarchy level and the 
level above or below it, as a separator.

Creating New Report Worksheets
This section demonstrates how to create custom report worksheets in Microsoft Excel using 
combined Oracle Strategic Operational Planning and Excel tools. The example is based on 
sample data in the Oracle Strategic Operational Planning database. Dimension and dimension 
member names are defined in the sample data.

The following steps are involved in creating a new report worksheet:

Step 1: Create a Query

Step 2: Create an Empty Report Worksheet

Step 3: Select a Range of Worksheet Cells

Step 4: Add Graphical Controls

Step 5: Assign Functions to the Graphical Controls

Step 6: Register the Report Worksheet

Step 7: Add the Worksheet to a Planning or Report Workbook

Step 8: Run the Report
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After reading this section, you will be familiar with the following tasks needed to create a basic 
report:

● Create a query to specify the subset of data you wish to display in the report. This task is 
performed in the Administration > Queries section in the Navigation Panel. 

● Create an empty Microsoft Excel worksheet that includes Oracle Strategic Operational 
Planning tools. This task is performed in the Administration > Worksheets section in the 
Navigation Panel.

● Specify a range of worksheet cells where you wish to place (or "land") the data returned by 
your query. This task uses Excel tools in Microsoft Excel.

● Add graphical controls to your worksheet, including a Refresh Data button and menus for 
filtering data returned by the query. This task uses design tools in Microsoft Excel.

● Assign functions to the graphical controls. This task uses tools in Excel, the Microsoft Visual 
Basic Editor, and Oracle Strategic Operational Planning class modules. For example, 
functions are available to enable menus for filtering report data.

● Save the worksheet in a predefined location, and then register it in the Oracle Strategic 
Operational Planning user interface. Registering the new report worksheet makes it 
available for use in planning and report workbooks. This task is performed in the 
Administration > Worksheets section in the Navigation Panel.

● Add the new report worksheet to an existing planning or report workbook. You can also 
create a new planning or report workbook if you wish. This task is performed in the 
Administration > Workbooks section of the Navigation Panel.

Step 1: Create a Query
A basic report consists of a database query. The query specifies the subset of data you wish to 
retrieve from the database for display in a report worksheet. You can specify a subset of 
rowsource data or cube data, and define filtering criteria. 

You can use the following types of queries:

● RSQL (Rowsource Structured Query Language—A query defined using SQL that is 
designed to return rowsource data. Rowsource data is transactional- or component-level 
data, for example, sales order details. Rowsource data is loaded into relational tables in the 
Oracle Strategic Operational Planning database from your execution database. 

● MDX (Multidimensional Expressions—A query defined using standard MDX and Oracle 
Strategic Operational Planning extensions that is designed to query multidimensional 
cubes. MDX queries return subsets of the base data or scenario data in the Oracle Strategic 
Operational Planning database. 

You view, create, preview, and edit queries using the Administration>Queries section of the 
Navigation Panel. The Oracle Strategic Operational Planning application includes default 
queries used in sample reports. 

In this section, you will create an MDX query called ProductShortageExample, which is 
defined as follows:

ProductShortageExample query definition:
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SELECT 

  { [Measures].[Ending Inventory Units]

  }

    ON COLUMNS,

  {

    Filter(

           CrossJoin([InventoryLocation].Members, [Product].Members, 
           [Manufacturing].Members),
           HasBrokenConstraint("Product Shortage", [Measures].
           [Ending Inventory Units]))

  }

    ON ROWS

FROM [Schedule]

The above query uses standard MDX functions and Oracle Strategic Operational Planning 
extensions. The query defines the following elements: 

● Data source—The subset of data selected for the report is from the Schedule cube: 
SELECT...FROM statement.

● Column values—The report displays measure values for Ending Inventory Units in a 
column: {...} ON COLUMNS statement.

● Row values—Measure values in a cube occur at intersections of members from different 
cube dimensions. The report only displays values for Ending Inventory Units that occur at 
specific intersections. The intersecting dimension members are displayed in rows: {...} 
ON ROWS statement.

● Data filter—The intersecting dimension members displayed in the report are determined 
by a filter. The filter applies a test condition to values for Ending Inventory Units. Only 
values that meet the test condition are displayed, along with the intersecting dimension 
members at which they occur: Filter(dimension members, filtering 
condition) statement.

● Dimension members—Values for Ending Inventory Units are tested at all possible 
intersections of InventoryLocation, Product, and Manufacturing dimension members: 
 CrossJoin(dimension A members, dimension B members, dimension C 
members) statements.

● Filtering condition—The filtering condition searches for values of Ending Inventory Units 
that break the Product Shortage constraint: HasBrokenConstraint("Constraint 
Name", measure values) statement.

The possible dimension member combinations in the report depend on how dimensions are 
defined in the sample data. In this example, the Product dimension includes Product Family 
and Product Model members. The Manufacturing dimension includes Year, Quarter, Month, 
and Week members. 
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➤ To create the above Product Shortage Example query:

1 Log into the Oracle Strategic Operational Planning user interface as the administrator. 

The default administrator username is admin and the password is password. Your 
administrator username and password may be different.

2 Click the Administration>Queries section in the Navigation Panel.

3 Click the Create Query button. Enter query details as follows:

● In the Name field, enter a name for the query; for example, ProductShortageExample. 
The name must be a single word.

● From the Type menu, select the query type MDX.

● In the Description field, enter a brief description, for example, Query shortage report.

● In the Definition field, enter the query definition shown above. You can copy and paste the 
query text from this topic directly into the Definition field. Copy all text from the SELECT 
statement to the final closing square bracket.

4 Click the Preview button and select Preview Against Base Data. 

A new browser window opens to display the query definition, any syntax errors, and a table 
that displays query results. 

The number of columns in the preview table depends on the hierarchy level of the dimension 
member(s) specified in the query filter. For later use, make a note of the number of columns in 
the preview table. The same number of columns is needed in the report worksheet.

5 Correct any syntax errors and click Save to save the new query definition. 

You are returned to the list of queries. Click the underlined name of your query to review query 
details. When you are finished, close the browser preview window.

Step 2: Create an Empty Report Worksheet
As an administrator, you can run a query by previewing it on the Administration>Queries 
screen. However, for non-administrators to run the query, it must be included in a report 
worksheet. These users can then run the report and view results in Excel during a what-if 
analysis. 

You can add a new report worksheet to an existing Excel workbook, or you can create a new 
Excel workbook with the report worksheet. In this tutorial, you will create a new Excel 
workbook. 

Note: An Excel workbook as described here is a physical file stored on your file system that contains planning and report 
worksheets. An analysis workbook, used during a what-if analysis, is a "virtual" workbook assembled from these 
worksheets. An analysis workbook may be the same as a physical Excel workbook file, but does not have to be.

➤ To create an empty report worksheet:

1 Click the Administration>Worksheets section in the Navigation Panel. 

A list of existing report and planning worksheets is displayed. Each worksheet belongs to an 
Excel workbook whose filename is also displayed.
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2 Click the Download New Worksheets button to open Excel. 

A new Excel workbook containing empty worksheets is displayed. The worksheets include 
hidden, embedded Oracle Strategic Operational Planning tools. 

3 In Excel, save the workbook in the following location with a filename such as example-product-
shortage.xls:

interlace_root\custom\workbook\example-product-shortage.xls

where interlace_root is the Oracle Strategic Operational Planning installation directory. 
After saving the new workbook in Excel, it is not yet listed on the Administration>Worksheets 
screen in the Oracle Strategic Operational Planning user interface.

4 Delete extra worksheets.

Since only one worksheet is needed for this example, you can delete the extra worksheets. In 
Excel, select a worksheet to delete by clicking a sheet tab. Then select the Edit>Delete Sheet 
menu item.  Delete all but one worksheet.

Double-click on the sheet tab of the remaining worksheet and change its name. The worksheet 
name must be unique and must not contain any spaces. For example, name the worksheet 
ExampleShortage. Save your changes to the worksheet.

5 Close Excel. 

You can reopen the Excel workbook later to continue setting up the new report worksheet.

Step 3: Select a Range of Worksheet Cells
The next step is to specify a location in the new report worksheet to display (or "land") query 
results. To specify a location, you select and name a range of worksheet cells that includes the 
requisite number of columns and at least two rows. 

You can also begin customizing the layout of the worksheet. For example, you can add borders, 
format text, and change column spacing in the report.

➤ To select a range of worksheet cells to display query results:

1 In Excel, open the workbook containing your new report worksheet.

2 In the worksheet, position the cursor in a cell, then click and drag to draw a rectangle. 

The rectangle should enclose the same number of columns that appeared in the preview table 
when you previewed the query definition and should include at least two rows. For this 
example, select a range of cells that includes eight columns and two rows, not including 
column headers.

3 Click the Name Box field at the top left of the worksheet and enter a name for the highlighted range of 
cells, for example, shortage_range; then press the Enter. 

At any time, you can select the range name from the Name Box menu and the range of cells will 
be highlighted in the worksheet.

You can edit a range after creating it. For example, you can drag the borders of the highlighted 
range to move it to a different location in the worksheet. 
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To edit a range:

a. Select Insert > Name > Define. 

b. In Define Name, click a range name to highlight it. Then click the icon that appears at the 
far right of Refers to. The selected range is outlined in the worksheet. 

c. Redraw the range to include the desired cells, then click the X button at the top right of the 
dialog box. 

d. Click OK to save the redrawn range.

4 Draw a border around the range.

a. Select the range name from the Name Box menu to highlight the range. 

b. Right-click the highlighted range, select Format Cells, and click Border. 

c. Click the None button, select the line style and color you wish from the Line section, and 
then click the Outline button. 

d. Click OK to save the border. The range is now highlighted in the worksheet.

5 Save your changes to the report worksheet.

➤ To customize the report layout:

1 Click a cell above a range column, then type the name of the column header and press Enter. 

For example, enter these column headers to match those in the preview table:

● Inventory Location

● Product Family

● Product Model

● Year

● Quarter

● Month

● Week

● Ending Inventory Units

2 Optional. Select column header cells and add a border around them.

3 Select column header cells and change the text style using the Excel Formatting toolbar 
(View>Toolbars>Formatting). 

For example, left-justify column headers and use bold text.

4 Optional. Adjust column widths to fit cell content. 

To do this, select all columns in the report and select Format > Columns > AutoFit Selection, 
or drag the borders of alphabetic column headings.

5 Optional. Add spacing between columns by inserting empty columns between them. 

To make sure query results are not placed in these columns, add a formula to the empty cells 
that inserts an empty text string.
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a. Select a column and select Insert > Columns. 

An empty column is inserted to the left of the selected column, and the range of cells where 
results are placed is adjusted.

b. In the first data cell of the empty column, enter:

=T("")

This inserts an empty string that prevents query data from being placed in the column. You 
do not need to add the formula to other data cells in the empty column.

The formula is not visible if your Excel options are set to hide formlas.

c. Repeat these steps to add additional empty columns as desired.

6 Save changes to the report worksheet.

Step 4: Add Graphical Controls
The main graphical control in a report worksheet is a command button which runs a query. 
Each time the button is clicked, query results are retrieved from the Oracle Strategic 
Operational Planning database and the report is updated with the latest data. You can also add 
menus to filter report data in the worksheet. For example, you can create menus to filter by 
time period or location. 

➤ To add a Refresh Data button:

1 In Excel, ensure that the following toolbars are displayed:

● Control Toolbox—Select View > Toolbars > Control Toolbox

● Forms—Select View > Toolbars > Forms

● Drawing—Select View > Toolbars > Drawing

● Formatting—Select View > Toolbars > Formatting

2 Draw a Refresh Data button:

a. On the Control Toolbox toolbar, click the Command Button icon.

b. Move the cursor to the desired button location in the report worksheet. Click and drag the 
cursor to draw a rectangular button. 

c. Click and drag the borders of the button to resize it. 

d. Click and drag the button to move it. 

e. To change the button caption:

f. Right-click on the button and select Properties from the context menu. 

g. In the Properties dialog box, change the value for the Caption property to Refresh Data. 

h. Then click the X button at the top right of the dialog box to close it. The button is now 
named Refresh Data.

3 Save your changes to the report worksheet.
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➤ To add a menu to filter data:

1 Draw a filter menu:

a. On the Forms toolbar, click the Combo Box icon (eighth from the left).

b. Move the cursor to the desired menu location in the report worksheet. Click and drag the 
cursor to draw a rectangular menu. 

c. Click and drag the borders of the menu to resize it. 

d. Click and drag inside the menu to move it.

2 Label the filter menu:

a. On the Drawing toolbar, click the Text Box icon (eighth from the left).

b. Move the cursor to the desired text box location in the report worksheet. Click and drag 
the cursor to draw a text box. 

c. Click and drag the handles of the text box to resize it. 

d. Click and drag the borders of the text box to move it.

e. To create a label, click inside the text box and enter label text. For example, enter Month: 
and then format label text as follows:

f. Right-click on the text box and select Format Text Box from the context menu. Then select 
font and style options. 

g. Or, use tools on the Formatting toolbar to select font, style, and text alignment.

h. Position the text box label as desired next to the filter menu.

3 Save your changes to the report worksheet.

Step 5: Assign Functions to the Graphical Controls
In this step you assign a query to the Refresh Data button, create a list of filter values for the 
menu, and enable the menu. You use control tools in Excel and the Visual Basic Editor, which 
gives you access to Oracle Strategic Operational Planning class modules. 

To enable the filter menu, you must modify your query definition.

Assigned functions to the graphical controls involves:

● Enabling a Refresh Data Button

● Enabling One or More Filter Menus

● Enabling Graphical Controls

Enabling a Refresh Data Button

➤ To enable a Refresh Data button:

1 In Excel, go to the design mode. 

On the Control Toolbox toolbar, click Design Mode/Exit Design Mode.
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2 Double-click the Refresh Data button to open the Visual Basic Editor. 

The following code should be displayed in the window at the front of the right pane:

Private Sub CommandButton1_Click()

End Sub

3 Make the following changes to the code:

● Change the Private statement to Public.

● Enter code between the first and last lines as follows:

Public Sub CommandButton1_Click()

Dim QueryVariable As New Oracle Strategic Operational PlanningQuery

    QueryVariable.RangeName = "range_name"

    QueryVariable.FilterRangeName = "filter_value"

    QueryVariable.QueryName = "query_name"

    QueryVariable.LandData

End Sub

where:

❍ Dim declares a variable of data type Oracle Strategic Operational PlanningQuery and 
QueryVariable is the name of the variable. You can specify any name allowed in 
Visual Basic. For example, MyQuery. 

❍ range_name is the name of the cell range where query results will be "landed" in the 
report worksheet. For example, shortage_range.

❍ filter_value is a name representing the selected  filter value. 

Since you have not yet specified filter values for the menu you created earlier, specify 
an empty string by entering double-quotes: ""

❍ query_name is the name of your defined query. For example, 
ProductShortageExample.

Your completed code should be similar to:

Public Sub CommandButton1_Click()

Dim MyQuery As New Oracle Strategic Operational PlanningQuery

    MyQuery.RangeName = "shortage_range"

    MyQuery.FilterRangeName = ""

    MyQuery.QueryName = "ProductShortageExample"

    MyQuery.LandData

End Sub

4 Save changes in the Visual Basic Editor and return to Excel. 

In Excel, exit design mode. You are now ready to run the query. 

5 Click the Refresh Data button in the report worksheet. 

Rows are added automatically as needed, and your results should look the same as those in the 
preview table earlier.
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Enabling One or More Filter Menus
For each filter menu in a report worksheet, the MDX report query must include a Parameter 
statement. To enable the Month menu created earlier, therefore, you need to modify the 
original query. 

In the example that follows, you will modify the ProductShortageExample query by adding two 
Parameter statements. The change allows you to enable two filter menus in the report, for 
Location and Month. The modified query, called ModifiedProductShortageExample, is 
defined as follows:

ModifiedProductShortageExample query definition:
SELECT   
  { [Measures].[Ending Inventory Units]   
  }   
    ON COLUMNS,   
  {  
    Filter(  
  
    CrossJoin({ Parameter("location", MEMBER, [InventoryLocation]) }, 
    [Product].Members, 
    { Parameter("time", MEMBER, [Manufacturing]) } ), 
    [Measures].[Ending Inventory Units] < 1000)  
   
  }   
    ON ROWS   
FROM [Schedule]   

The above query definition includes the following changes:

● The set of dimension members [InventoryLocation].Members representing all 
members of the InventoryLocation dimension and the set 
[Manufacturing].Members representing all members of the Manufacturing dimension 
are replaced with Parameter(...) statements:

{Parameter("parameter_name", MEMBER, [dimension_name])}

where

❍ parameter_name is a name specified for the parameter; for example, location or 
time.

❍ dimension_name is the name of the dimension represented by the parameter; for 
example, InventoryLocation or Manufacturing.

● The filtering condition is also modified to return a different data set for this example:

[Measures].[Ending Inventory Units] < 1000

which searches for values of Ending Inventory Units that are less than 1000.

When you preview the above query in the Administration>Queries section of the Oracle 
Strategic Operational Planning user interface, you are prompted whenever a Parameter 
statement is encountered to enter a specific member name. The member name will be 
substituted for the parameter. The fully qualified member name must be used.

In Excel, you select a filter value representing the fully qualified name of a dimension member 
from each menu. The filter values are then substituted for query parameters when you run the 
query.
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In addition to modifying the query, you must also supply a list of filter values for each menu in 
the report worksheet. Each filter value must be the fully qualified name of a dimension 
member, expressed as:

dimension name/namespace name/member name

For example:

● Manufacturing/MY 2004/August

● InventoryLocation/InventoryLocation/CHN

If all dimension members in a list belong to the same namespace, you can use a formula to 
represent the dimension and namespace prefix.

➤ To enable filter menus for Location and Month:

1 In the Administration>Queries section of the Oracle Strategic Operational Planning user interface, edit the 
ProductShortageExample query definition or create a new query 
ModifiedProductShortageExample using the modified query definition above. 

Do not allow line breaks to occur inside a dimension member name.

2 Preview the query. 

When prompted to enter a value for "location", enter the fully qualified member name 
InventoryLocation/InventoryLocation/CHN. When prompted to enter a value for 
"time", enter the fully qualified member name Manufacturing/MY 2004/August. Note the 
number of columns displayed in the preview table.

You can view dimension, namespace, and member names in the Administration>Dimensions 
section of the Navigation Panel. 

3 In Excel, open the workbook containing the report worksheet created earlier; or, in the 
Administration>Worksheets section of the Navigation Panel, create a new report worksheet. 

● If the number of columns required in the report has changed, remove or add columns as 
needed to match the number of columns in the preview table. For example, if the Weeks 
column is no longer needed, remove it along with an adjacent empty column, if one exists. 

● Add a menu to the report worksheet and use a text box to label it. For example, create a 
Location: label.

4 Scroll the worksheet to display empty columns to the right of the defined data range. In this region of the 
worksheet, manually enter two lists of filter values and define three ranges as shown below.

                              1                                1

CHN January

LAS February

MEX March

SAN April

May

June
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● In two adjacent empty columns, manually enter a list of InventoryLocation dimension 
members in the InventoryLocation namespace, and a list of Manufacturing dimension 
members in the MY 2004 namespace. 

● The columns should be located to the right of your defined query data range, so the lists do 
not occupy rows that may be needed to display query results.

● Leave at least the top three rows of each column empty.

● The dimension members in each list should occupy the same hierarchy level. Otherwise, 
the number of columns needed to display query results may change depending on the filter 
value selected from a menu.

● The member names must be entered exactly, including letter case and word spacing.

● Since the members in each list above belong to the same namespace, you do not need to 
prefix the dimension and namespace names. You will represent the prefixes by a formula 
later.

● Select and name two cell ranges as outlined in the figure above. Each range should include 
one of the member lists, plus the empty cell above the list. For example, name the ranges 
location_list and month_list.

● In the cell above each range, enter the value 1. The value in this cell is an index variable 
used to identify a row in each range.

5 Optional. Select the cell above each index variable and assign it a range name. 

For example, name the two cells location_value and month_value. Naming these cells is 
not required but is helpful. Later you will add a formula to each cell that represents a filter 
value in one of the lists.

6 Select both cells above the index variables as outlined above and assign them a range name. 

For example, name the combined cells filter_value. This range is used to substitute filter 
values for query parameters.

7 Set control properties for the menus to enable them to display filter values: 

● Right-click the Location menu and select Format Control from the context menu.

● In the Format Control dialog box, specify the following control properties:

❍ Input range—Enter the range name of the list of InventoryLocation members. For 
example, location_list.

July

August

September

October

November

December
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❍ Cell link—Click on the icon at the far right of the Cell link field. Then click on the cell 
containing the index variable above the location_list range. The selected cell location is 
displayed in a small window. Click the X button to close this window. Then click OK to 
close the Format Control dialog box.

When you open the Location menu, you should now see a list of InventoryLocation 
members. The value selected from the menu appears in the text box, and the index 
variable changes in the cell above the location_list range.

● Repeat these steps for the Month menu.

8 Add formulas to the location_value and month_value cells to generate fully qualified member 
names for values selected from the menus. 

The member names in these cells will be substituted for query parameters when you run the 
query.

9 In the location_value cell, enter the following formula:

="InventoryLocation/InventoryLocation/"&INDEX(location_list, 
index_cell_location)

where

● "InventoryLocation/InventoryLocation/" is a string representing a fully qualified 
member name prefix expressed in the form dimension name/namespace name/.

● location_list is the name of the range containing the list of InventoryLocation 
dimension members.

● index_cell_location is the cell location of the index variable above the location_list 
range, expressed as a letter-number combination such as S10.

● INDEX(location_list, index_cell_location) is an Excel function which returns 
the location_list value corresponding to the value of the index variable.

● & is a function that joins the two strings to generate the fully qualified member name.

10 In the month_value cell, enter the following formula:

="Manufacturing/MY 2004/"&INDEX(month_list, index_cell_location

where

● "Manufacturing/MY 2004/" is a string representing a fully qualified member name 
prefix expressed in the form dimension name/namespace name/.

● month_list is the name of the range containing a list of Manufacturing dimension 
members.

● index_cell_location is the cell location of the index variable above the month_list 
range, expressed as a letter-number combination such as T10.

● INDEX(month_list, index_cell_location) is an Excel function which returns the 
month_list value corresponding to the value of the index variable.

● & is a function that joins the two strings to generate the fully qualified member name.

11 Modify the Visual Basic code for the Refresh Data button to specify the filter_value range (defined 
earlier by combining the location_list and month_list ranges) and the new query name 
ModifiedProductShortageExample as follows: 
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Public Sub CommandButton1_Click()

Dim MyQuery As New Oracle Strategic Operational PlanningQuery

    MyQuery.RangeName = "shortage_range"

    MyQuery.FilterRangeName = "filter_value"

    MyQuery.QueryName = "ModifiedProductShortageExample"

    MyQuery.LandData

End Sub

When the query is run, the fully qualified member names in the filter_value range will be 
substituted for parameters defined in the MDX query. Values are substituted in the order in 
which parameters are defined in the query. The first value (in the location_value cell) is 
substituted for the parameter named "location" in the query and the second value (in the 
month_value cell) is substituted for the parameter named "time".

12 Save changes to the report worksheet; then select a value from both menus, for example, CHN and August.

13 Click the Refresh Data button. 

Filtered data is displayed which should match the data in the preview table.

14 Optional. Before closing the workbook and exiting Excel, hide filter and formula information so users don't 
see it when they run the report. 

a. Select all cells containing filter and index variable values to highlight them. Then select 
Format > Columns > Hide.

b. Select Tools > Options. On the View tab, in the Window options section, disable the 
formula checkbox.

c. Save your changes to the worksheet and exit Excel.

Enabling Graphical Controls
As you enable graphical controls, keep in mind the following:

● The number of columns in the preview table and in reports depends on the hierarchy level 
of dimension members specified in the query filter. Dimension members in a filter list in a 
worksheet should belong to the same hierarchy level to generate the same number of 
columns.

● Exit design mode before you test the Refresh Data button in a report worksheet. To toggle 
design mode on and off, on the Control Toolbox toolbar, click the Design Mode/Exit Design 
Mode icon repeatedly.

● Be sure to change the Private statement to Public in the Visual Basic code for the Refresh 
Data button. Also, be sure to use the correct letter case when specifying range, filter, and 
query names. If an error occurs as a query is running, debugging information is displayed 
and you are prompted to correct any syntax problems.

● A Parameter(...) statement is required in an MDX query for each filter menu in a report 
worksheet.
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● Values for parameters in MDX queries are read in the order that parameters are defined. Be 
sure that the order in which filter values are listed in the worksheet matches the order in 
which corresponding query parameters are defined.

● For each range of filter values in a report worksheet, you must have a cell that contains an 
index variable with an initial value of 1.

● Filter values must be fully qualified dimension member names in the form dimension 
name/namespace name/member name. If all members in a list belong to the same 
namespace, you can use a formula to add a prefix to member names which contains the 
dimension and namespace names. 

● To view the exact dimension, namespace, and member names, go to the 
Administration>Dimensions screen in the Oracle Strategic Operational Planning user 
interface.

Step 6: Register the Report Worksheet
The new report worksheet is not displayed in the Oracle Strategic Operational Planning user 
interface until it is registered. When you register the report worksheet, you specify summary 
details which you can edit later if you wish. 

➤ To register a new report worksheet:

1 Click the Administration>Worksheets section of the Navigation Panel in the Oracle Strategic Operational 
Planning user interface.

2 Click the Create Worksheet button, and enter the following summary details for the new report worksheet:

● Name—Enter the name of the report worksheet. The name must exactly match the name 
on the sheet tab in Excel. For example, ExampleShortage.

● File Name—Enter the filename of the Excel workbook that contains the report worksheet. 
For example, example-product-shortage.xls. You do not need to enter the path to 
the file.

● Type—(Report or Planning) Select the Report type from the menu.

● Description—Enter a brief description for the report worksheet.

● Owner—Select a user as the owner of the report worksheet. Only the owner and 
administrators may edit a report worksheet.

● Public—(Yes or No) Select whether the report will be public (visible to all users) or private 
(visible only to the owner).

3 Click Save to register the worksheet. 

The report is now registered. In the list of planning and report worksheets on the 
Administration>Worksheets screen, you should see the new report worksheet listed. 

4 Click on the Excel icon next to the registered name to open the report worksheet in Excel. 

If you encounter any problem, check that the registered name of the worksheet is the same as 
the name on the sheet tab in Excel.
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Once a worksheet is registered, you can unregister it to remove it from the Oracle Strategic 
Operational Planning user interface if you wish. Unregistered worksheets remain on your file 
system and are not deleted.

Step 7: Add the Worksheet to a Planning or Report 
Workbook
To make the new report available to users, you must add the report worksheet to an existing 
planning, data collection, or report workbook, or create a new workbook containing the 
worksheet.

➤ To add the worksheet to an existing planning or report workbook:

1 Click the Administration>Workbooks section of the Navigation Panel in the Oracle Strategic Operational 
Planning user interface.

2 Select a workbook by clicking its name; then, click the Edit Workbook button.

3 In the Available Worksheets list, select the new report worksheet, for example, ExampleShortage; 
then, click the Add button to move the worksheet to the Selected Worksheets list. 

4 Move the worksheet to the front of the workbook (the top of the list) by highlighting it in the Selected 
Worksheets list and clicking Move Up or Move Down.

5 Click Done to save your change. 

Note the display name of the workbook, which may be different from the report worksheet 
name.

To view and update report data, you must run the report in the Administration>Analysis 
Workbench section within a scenario, or in the Administration>Reports section in the 
Navigation Panel.

Step 8: Run the Report

➤ To run the report:

1 Click the Reports section of the Navigation Panel.

2 In the list of reports, click the report name corresponding to the workbook you just edited and select Run 
Report against Base Data from the popup menu. 

When the report opens in Excel, the report worksheet you created in this tutorial is displayed at 
the front of the workbook.
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Managing Worksheets
Managing worksheets involves:

● Viewing Worksheets

● Creating Worksheets

● Editing Worksheets

● Registering Worksheets

● Unregistering Worksheets

Viewing Worksheets
As an administrator, you can view details for planning, report, and data collection worksheets 
that have been registered in the Oracle Strategic Operational Planning user interface. 
Registered worksheets are available for use in planning, report, and data collection workbooks.

Each worksheet belongs to an Excel workbook. The filename of a registered worksheet is given 
by the filename of the Excel workbook that contains it. An Excel workbook can contain other 
worksheets. 

Note: An Excel workbook as described here is a physical file stored on your file system that contains planning and report 
worksheets. An analysis workbook, used during a what-if analysis, is a "virtual" workbook assembled from these 
worksheets. An analysis workbook may be the same as a physical Excel workbook file, but does not have to be.

➤ To view details for registered planning, report, and data collection worksheets:

1 In the Administration section of the Navigation Panel, click Worksheets. 

2 Sort the list by clicking a column header. Click again to reverse the sort direction. Drag the border between 
columns to change column widths.

3 Right-click the empty column header at the far right of the list to select columns to display or hide. 
Columns that can be displayed include:

● Excel icon—An icon next to the worksheet name which opens Microsoft Excel to display 
the workbook containing the worksheet. 

● Name—The worksheet name, specified when the worksheet is registered in the Oracle 
Strategic Operational Planning user interface. Each worksheet is registered separately 
under its own name, which must be the same as the name on its sheet tab.

● Filename—The filename of the Excel workbook containing the worksheet. An Excel 
workbook can contain more than one worksheet. 

● Description—A description of the worksheet.

● Type—The type of worksheet (Planning, Data Collection, or Report). A planning 
worksheet allows users to perform what-if calculations. A report worksheet displays 
tabular reports and charts. A data collection worksheet is a report worksheet designed 
specifically to collect updated forecast data from data providers. 



150  Using the Model Designer Tab 

● Public —A value (Yes or No) that indicates whether the worksheet is public (Yes) or 
private (No). A public worksheet can be viewed and used by others. A private worksheet 
can be viewed and used only by the worksheet owner and administrators.

● Owner—The owner of the worksheet. Only the worksheet owner and administrators can 
view private worksheets.

4 Click the underlined name of a planning, report, or data collection worksheet to view an edit worksheet 
summary details.. 

5 Click Worksheets under the Administration section in the Navigation Panel to return to the list.

6 Click the Excel icon next to a worksheet name to open Excel and display the workbook that contains the 
worksheet. 

You can edit report worksheets in the workbook, using Oracle Strategic Operational Planning 
tools and design tools in Microsoft Excel. To view and update data in planning and report 
worksheets, however, you must open them in the Administration>Analysis Workbench section 
within a scenario, or in the Administration>Reports section in the Navigation Panel.

Creating Worksheets
You use the Oracle Strategic Operational Planning user interface to create new report 
worksheets, edit existing report worksheets, and edit summary details for planning, data 
collection, and report worksheets. To create planning worksheets, you customize XML 
worksheet template files outside the Oracle Strategic Operational Planning user interface.

Report worksheets provide access to Oracle Strategic Operational Planning class modules that 
allow you to call one or more Oracle Strategic Operational Planning queries. Generally, you 
first create a query that retrieves and filters data from the Oracle Strategic Operational 
Planning database. Then you use design tools and the Visual Basic Editor in Microsoft Excel to 
create the report layout and specify a query to use. For a step-by-step tutorial that describes 
how to use these tools in Microsoft Excel, see the “Creating New Report Worksheets” on 
page 133.

Data collection worksheets are report worksheets that are designed specifically to allow data 
providers to update forecast data. These worksheets reference a pre-existing load specification 
that defines how updated forecast data is staged and loaded into the Oracle Strategic 
Operational Planning database. They also include information used to filter and display 
forecast data for individual data providers.

Note: An Excel workbook as described below is a physical file stored on your file system that contains planning and 
report worksheets. An analysis workbook, used during a what-if analysis, is a "virtual" workbook assembled from 
these worksheets. An analysis workbook may be the same as a physical Excel workbook file, but does not have to 
be.

You can create a report worksheet in a new Excel workbook, or you can create a report 
worksheet in an existing Excel workbook. You can create more than one report worksheet at a 
time. 
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➤ To create a new report worksheet:

1 Click Worksheets under the Administration section in the Navigation Panel.

2 Open a workbook to create a report worksheet.

● To open a new workbook, click the Download New Worksheets button. Excel opens to 
display a new workbook containing blank worksheets. Save the new workbook in the 
following location on the Oracle Strategic Operational Planning server with a filename 
such as workbook_name.xls:

interlace_root\custom\workbook\workbook_name.xls

where interlace_root is the Oracle Strategic Operational Planning installation 
directory. 

● To open an existing workbook, click the Excel icon next to the name of a worksheet it 
contains. Excel opens to display the workbook.

3 In the new or existing Excel workbook, delete or insert worksheets as needed. 

● To delete an extra blank worksheet, click its sheet tab. Then select the Edit>Delete Sheet 
menu item. 

● To insert a blank worksheet, select the Insert>Worksheet menu item.

4 Double-click on the sheet tab of a blank worksheet to highlight its name, then enter a new name for the 
report worksheet. 

The worksheet name must be unique. 

5 Save your changes to the workbook. 

You can close Excel and reopen the workbook later to continue setting up the new report 
worksheet if desired.

6 Follow the steps in “Creating New Report Worksheets” on page 133 to define the report layout, specify one 
or more database queries, and add data filters. 

When you have finished creating the new report worksheet, save your changes to the 
workbook. 

7 Register the report worksheet in the Oracle Strategic Operational Planning user interface.

Editing Worksheets

➤ To edit a report worksheet:

1 Click Worksheets under the Administration section in the Navigation Panel.

2 Click the Excel icon next to the name of the desired report worksheet. 

Excel opens to display the workbook that contains the selected report worksheet.

3 Click the sheet tab of the report worksheet to bring it to the front. 

4 Follow the steps in “Creating New Report Worksheets” on page 133 to modify the report layout, specify 
one or more database queries, and modify data filters. 
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5 Save your changes to the workbook. 

If you change the sheet tab name, you must do the following before you can use the edited 
report worksheet:

● Register the report worksheet with the new name. The registered name must exactly match 
the sheet tab name. The name must be unique.

● Edit any planning, data collection, or report workbooks that are associated with the report 
worksheet, to remove the original version and add the renamed version.

● Unregister the original version of the report worksheet.

● If you change the filename of the workbook, you must do the following before you can use 
worksheets it contains:

● Edit summary details for each worksheet in the workbook to update the filename. The 
registered filename must exactly match the actual filename of the workbook. You do not 
need to enter the path to the file. The workbook file must be stored on the Oracle Strategic 
Operational Planning server in one of the following default locations:

interlace_root\interlace\workbook\workbook_name.xls

interlace_root\custom\workbook\workbook_name.xls

where interlace_root is the Oracle Strategic Operational Planning installation 
directory and workbook_name.xls is the filename of the workbook. 

➤ To view and update data after editing a report worksheet, run the report in the Administration 
> Analysis Workbench section within a scenario, or in the Administration > Reports section in 
the Navigation Panel.

You specify summary details when a worksheet is registered in the Oracle Strategic Operational 
Planning user interface. You can edit these details for planning, report, and data collection.

➤ To edit summary details for a planning, report, or data collection:

1 Click Worksheets under the Administration section in the Navigation Panel.

2 Click the underlined name of a planning, report, or data collectionl then click the Edit Worksheet button.

3 Optional. Change the following details for a registered worksheet:

● Filename—The registered filename of the Excel workbook containing the worksheet. The 
registered filename must exactly match the actual filename of the workbook. You do not 
need to enter the path to the file. The workbook file must be stored on the Oracle Strategic 
Operational Planning server in one of the following default locations:

interlace_root\interlace\workbook\workbook_name.xls

interlace_root\custom\workbook\workbook_name.xls

where interlace_root is the Oracle Strategic Operational Planning installation 
directory and workbook_name.xls is the filename of the workbook. 

● Type—The type of worksheet (Planning, Report, or Data Collection).

● Description—The description of the worksheet.
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● Owner—The owner of the worksheet. Only the worksheet owner and administrators can 
view private worksheets.

● Public—The value (Yes or No) that indicates whether the worksheet is public (Yes) or 
private (No). A public worksheet can be viewed and used by others. A private worksheet 
can be viewed and used only by the worksheet owner and administrators.

Note: Private worksheets are not the same as hidden worksheets. Private worksheets are used to restrict the view of data 
to prevent access by other users. Hidden worksheets are invisible to all users and are used to avoid displaying 
data that is not directly useful to users. 

● Dependencies—A value (Yes or No) that indicates whether the worksheet is dependent 
(Yes) or not dependent (No) on another worksheet. For example, a report worksheet may 
depend on data in a hidden worksheet. Or a Refresh Data button in one worksheet may 
also refresh data in another worksheet. 

In Excel, users cannot insert a dependent worksheet into a planning workbook. In the 
Administration>Workbooks section of the Navigation Panel, administrators can add a 
dependent worksheet to a workbook but must also add the worksheet(s) it depends on. 
Otherwise, problems may occur when the workbook is used in scenarios.

4 Click the Done button to save your changes and exit edit mode. 

5 Click Worksheets under the Administration section in the Navigation Panel to return to the list of 
worksheets.

Registering Worksheets
New planning and report worksheets must both be registered in the Oracle Strategic 
Operational Planning user interface. Registering a worksheet allows the Oracle Strategic 
Operational Planning server to access it and makes it available for use in planning, data 
collection, and report workbooks.

Note: An Excel workbook as described here is a physical file stored on your file system that contains planning and report 
worksheets. An analysis workbook, used during a what-if analysis, is a "virtual" workbook assembled from these 
worksheets. An analysis workbook may be the same as a physical Excel workbook file, but does not have to be.

When you register a planning or report worksheet, you specify summary details which you can 
edit later. You can register one worksheet at a time. Each worksheet in an Excel workbook is 
registered separately under its own name, which is the same as the name on its sheet tab. 

➤ To register a planning or report worksheet:

1 Click Worksheets under the Administration section in the Navigation Panel.

2 Click the Create Worksheet button and enter the following summary details for the new planning or report 
worksheet:
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● Name—Enter the name of the planning or report worksheet. The name must be unique 
and must exactly match the name on the sheet tab in Excel. This name is also used as the 
display name. 

● Filename—Enter the filename of the Excel workbook that contains the report worksheet. 
The registered filename must exactly match the actual filename of the workbook. You do 
not need to enter the path to the file. The workbook file must be stored on the Oracle 
Strategic Operational Planning server in one of the following default locations:

interlace_root\interlace\workbook\workbook_name.xls

interlace_root\custom\workbook\workbook_name.xls

where interlace_root is the Oracle Strategic Operational Planning installation 
directory and workbook_name.xls is the filename of the workbook. 

● Description—Enter a brief description for the report worksheet.

● Type—Select the type of the worksheet (Planning or Report) from the menu. Planning 
worksheets allow users to perform what-if calculations. Report worksheets display tabular 
reports and charts.

● Owner—Select a user as the owner of the worksheet. Only the owner and administrators 
can edit a worksheet.

● Public—Select whether the worksheet is public (Yes) or private (No). A public worksheet 
can be viewed and used by others. A private worksheet can be viewed and used only by the 
worksheet owner and administrators.

Note: Private worksheets are not the same as hidden worksheets. Private worksheets are used to restrict the view of data 
to prevent access by other users. Hidden worksheets are invisible to all users and are used to avoid displaying 
data that is not directly useful to users. 

Dependencies—A value (Yes or No) that indicates whether the worksheet is dependent 
(Yes) or not dependent (No) on another worksheet. For example, a report worksheet may 
depend on data in a hidden worksheet. Or a Refresh Data button in one worksheet may 
also refresh data in another worksheet. 

In Excel, users cannot insert a dependent worksheet into a planning workbook. In the 
Administration>Workbooks section of the Navigation Panel, administrators can add a 
dependent worksheet to a workbook but must also add the worksheet(s) it depends on. 
Otherwise, problems may occur when the workbook is used in scenarios.

3 Click Save to register the worksheet.

When the worksheet is registered, it is displayed in the list of planning and report worksheets 
on the Administration>Worksheets screen. When you click on the Excel icon next to the 
registered name, the workbook containing the worksheet opens in Excel. 

Unregistering Worksheets
Unregistering a worksheet removes the worksheet from the Oracle Strategic Operational 
Planning user interface but does not delete the physical workbook file from your file system. 
You cannot unregister worksheets that are currently associated with a planning or report 
workbook. You must edit the planning or report workbook first to remove the association.
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➤ To unregister one or more worksheets:

1 Click Worksheets under the Administration section of the Navigation Panel to view a list that includes all 
registered worksheets.

2 Select individual worksheets or a block of worksheets.

● Select one or more worksheets by enabling their checkboxes. Alternatively, hold down the 
CTRL key as you click individual worksheets in the list.

● Select a block of worksheets by holding down the SHIFT key as you click and drag to select 
a range of worksheets.

● Click the Select All or Deselect All links near the top right of the screen to select or deselect 
the entire list. These links appear if the list contains fewer than 100 items.

3 Click the Delete Worksheets button. 

The worksheets are no longer displayed in the Oracle Strategic Operational Planning user 
interface. The physical workbook files containing them, however, are still stored on the Oracle 
Strategic Operational Planning server in one of the following default locations:

interlace_root\interlace\workbook\workbook_name.xls

interlace_root\custom\workbook\workbook_name.xls

where interlace_root is the Oracle Strategic Operational Planning installation directory 
and workbook_name.xls is the filename of the workbook. 

Managing Workbooks
Managing workbooks involves:

● Viewing Workbooks

● Deleting Workbooks

● Creating Workbooks

● Editing Workbooks

● Adding and Removing Worksheets from the Workbook

Viewing Workbooks
Planning, data collection, and report workbooks, together called analysis workbooks, are 
"virtual" workbooks. They are assembled from worksheets that are stored in physical Excel 
workbook files on the Oracle Strategic Operational Planning server. The worksheets associated 
with an analysis workbook may be the same as those in a single physical Excel workbook file, 
but do not have to be.

➤ To view planning, data collection, or report workbooks:

1 Click Workbooks under the Administration section in the Navigation Panel. 



156  Using the Model Designer Tab 

2 Sort the list by clicking a column header, click again to reverse the sort direction, and drag the border 
between columns to change column widths.

3 Right-click the empty column header at the far right of the list to select columns to display or hide.

Columns that can be displayed include:

● Excel icon—An icon next to the workbook name which opens Microsoft Excel to display 
the workbook.

● Name—The workbook name.

● Type—The type of workbook (Planning, Data Collection, or Report). Planning and data 
collection workbooks can contain both planning and report worksheets. Report 
workbooks contain only report worksheets.

● Display Name—The display name of the workbook. 

● Description—A description of the workbook.

4 Click the underlined name of a planning, data collection, or report workbook to view and edit workbook 
details, including adding or removing worksheets associated with the workbook. 

5 Click Workbooks under the Administration section in the Navigation Panel to return to the list.

6 Click the Excel icon next to a workbook name to open Excel and display the workbook. 

You can edit report worksheets in the workbook, using Oracle Strategic Operational Planning 
tools and design tools in Microsoft Excel.

Deleting Workbooks
You cannot delete planning, data collection, or report workbooks that are currently associated 
with an analysis type. You mus edit the analysis type first to remove the association.

➤ To delete one or more workbooks:

1 Click Workbooks under the Administration section in the Navigation Panel.

2 Select individual workbooks or a block of workbooks.

● Select one or more workbooks by enabling their checkboxes. Alternatively, hold down the 
CTRL key as you click individual workbooks (Don't click the underlined name).

● Select a block of workbooks by holding down the SHIFT key as you click and drag to select 
a range of workbooks (Don't click the underlined name).

● Click the Select All or Deselect All links near the top right of the screen to select or deselect 
the entire list. These links appear if the list contains fewer than 100 items.

3 Click the Delete Workbooks button.

Creating Workbooks
You create or edit a workbook to make new planning and report worksheets available to users. 
A workbook must contain at least one worksheet. 
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You can create three types of workbooks:

● Planning workbook—A planning workbook contains at least one planning worksheet and 
optionally one or more report worksheets. After creating a planning workbook, you 
associate it with an analysis type which is then listed in the Analysis Workbench. An analysis 
owner uses the analysis type to create scenarios, and the analysis owner and participants use 
the scenario's planning workbook to perform a what-if analysis. 

● Data Collection workbook—A data collection workbook contains at least one report 
worksheet that is designed specifically to collect updated forecast data from data providers. 
A data collection workbook can contain other report worksheets, but it should not contain 
planning worksheets. You associate a data collection workbook with an analysis type that is 
then used to create data collection scenarios. 

● Report workbook—Report workbooks contain only report worksheets. You can associate 
one or more report workbooks with an analysis type. The report workbooks are then listed 
in the Reports section of the Navigation Panel and in the Analysis Workbench>View 
Reports section for the given analysis type. Analysis owners, participants, and approvers 
select a report workbook to view tabular reports and charts.

You can hide one or more report worksheets in a workbook. Hidden report worksheets are 
invisible to all users, including administrators. (Administrators can still view details for hidden 
worksheets in the Administration user interface, however.) For example, you may want to hide 
a report worksheet that is used to retrieve data from the Oracle Strategic Operational Planning 
database for use in a chart on a different worksheet.

Note: Hidden worksheets are not the same as private worksheets. Hidden worksheets are used to hide data that is not 
directly useful to users. Private worksheets are visible only to the worksheet owner and administrators. Private 
worksheets are used to restrict the view of data to prevent access by other users.

➤ To create a new workbook:

1 Click Workbooks under the Administration section in the Navigation Panel. 

2 Click the Create Workbook button.

3 Specify summary details for the workbook:

● Name—A unique name for the workbook. 

● Type—The type of workbook (Planning, Data Collection, or Report). Planning and Data 
Collection workbooks can contain planning and report worksheets. Report workbooks 
contain only report worksheets.

● Display Name—A display name for the workbook. A display name is required. Report 
worksheet display names are listed in the Reports section of the Navigation Panel for users 
to select.

● Description—A brief description of the workbook.

● Report Against—For report workbooks, the data used to generate a report. Select whether 
reports can be run using base data and scenario data (Base Data and Scenarios), only base 
data (Base Data Only), or only scenario data (Scenarios Only).
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4 Click Save to save the workbook. 

You are returned to the list of workbooks, which includes the one you just created.

5 Click the underlined name of the new workbook; then, click the Edit Workbook button. 

You can change the workbook display name and description if desired. You cannot change the 
workbook name or type.

6 Associate worksheets with the new workbook. 

The list of worksheets includes planning and report worksheets. View details for worksheets in 
the Administration>Worksheets section of the Navigation Panel.

Editing Workbooks

➤ To edit a workbook:

1 Click Workbooks under the Administration section in the Navigation Panel. 

2 Click the underlined name of a workbookl then click the Edit Workbook button. 

You cannot change the workbook name or type. You can change the following: 

● Display Name—The display name of the workbook. A display name is required. Report 
worksheet display names are listed in the Reports section of the Navigation Panel for users 
to select.

● Description—The description of the workbook.

● Report Against—For report workbooks, the data used to generate a report. Select whether 
reports can be run using only base data (Base Data Only) or using either base data or 
scenario data (Base Data or Scenarios).

3 Associate different worksheets with the workbook. 

The list of worksheets includes planning and report worksheets. View details for worksheets in 
the Administration>Worksheets section of the Navigation Panel.

Adding and Removing Worksheets from the Workbook

➤ To add or remove worksheets from the workbook:

1 In the Available Worksheets list, select one or more worksheets to associate with the workbook, and click 
Add to move the worksheet to the Selected Worksheets list.

2 In the Selected Worksheets list, select one or more worksheets to remove from the workbook and click 
Remove to move the worksheet to the Available Worksheets list.

3 Move a worksheet towards the front or back of the workbook by highlighting it in the Selected Worksheets 
list and clicking Move Up or Move Down. 

The worksheet at the front becomes the active worksheet when you open the workbook in 
Excel.
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4 Optional. Hide report worksheets by enabling their checkboxes. 

Hidden report worksheets in a workbook are invisible to all users. For example, you can hide a 
report worksheet containing data that is intended only for display in a chart on another 
worksheet.

Note: You must use the Oracle Strategic Operational Planning user interface (Administration>Workbooks) to hide or 
unhide worksheets, so that the Oracle Strategic Operational Planning server is aware of visibility requirements. Do 
not use Excel to hide or unhide worksheets in a workbook.

5 Click Done to save your selections; then click Worksheets under the Administration section in the 
Navigation Panel to return to the list of worksheets.

When you click the Excel icon next to a workbook name, Excel opens to display the workbook. 
You can edit report worksheets in a workbook, using Oracle Strategic Operational Planning 
tools and design tools in Microsoft Excel. See “Creating New Report Worksheets” on page 133.

Managing Analysis Types
Managing analysis types involves:

● Viewing Analysis Types

● Deleting Analysis Types

● Creating Analysis Types

● Editing Analysis Types

● Specifying Whether Users Can Edit the List of Approvers

Viewing Analysis Types
An analysis type defines the default properties of newly created scenarios that use it. Default 
properties include the analysis workbooks and key metrics associated with a scenario. Each 
analysis type is represented by a single planning workbook. Planning worksheets in the 
workbook and the specified key metrics determine the subset of data in the Oracle Strategic 
Operational Planning database that is copied into a "sandbox" for use in a scenario.

Analysis types are also displayed under the Planning Workbench section of the Oracle Strategic 
Operational Planning user interface, where they are available to analysis owners for creating 
new scenarios.

➤ To view analysis types:

1 In the Administration Workbench, click the Model Designer tab. Then click the Analysis Types link. 

2 Click the underlined name of an analysis type to view and edit analysis type details. 

● Type—The type of analysis (Analysis, Data Collection, or Forecast). 

● Analysis—This type of analysis is used for what-if analysis.
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● Data Collection—This type of analysis is used in data collection scenarios. The Data 
Collection type allows you to specify default data providers and a default email form, in 
addition to what-if analysis details.

● Forecast—This type of analysis supports integration with the third party application 
ForecastPro. The Forecast type allows users to export data to ForecastPro for forecast 
calculation using statistical methods.

● Name—The unique name of the analysis type.

● Display Name—The display name of the analysis type.

● Description—A description of the analysis type.

● Planning Workbook—The name of the planning workbook associated with the analysis 
type. Scenarios with the given analysis type automatically use this planning workbook for 
what-if analysis. 

● Assigned Report Workbooks—The name of one or more report workbooks associated 
with the analysis type. These reports are listed under the Planning Workbench>View 
Reports section of the Navigation Panel for the given analysis type. 

● Key Metrics—The name of one or more default key metrics associated with the analysis 
type. Default key metrics are automatically calculated and displayed along with other 
scenario impact details.

● Participants—A list of default participants for a scenario with the given analysis type. 
Analysis owners may edit this list when they create a scenario.

● Approvers—A list of default approvers for a scenario with the given analysis type. The 
value of the parameter response.allowEditApprovers determines whether analysis owners 
are allowed to edit this list when they create a scenario.

● Data Collection Settings—(Data collection analysis type only) The following information 
is displayed:

● Data Collection Workbook—The name of a data collection workbook associated with the 
analysis type. Analysis types with a data collection workbook are used to create data 
collection scenarios. The data collection workbook is sent to data providers to update 
forecast data.

● Data Providers—A list of default data providers for a data collection scenario. Data 
providers receive a data collection workbook to update forecast data. Data providers do 
not participate in what-if analysis. Analysis owners may edit this list when they create a 
scenario.

● Data Collection Email—The default email form for this analysis type. The form is used in 
data collection scenarios to email instructions and an attached data collection workbook to 
data providers. Analysis owners may edit this form for individual data providers. 

● Report—The name of a report included as an email shortcut in the message. When the 
email is sent, a link to the report is displayed at the end of the message text.

3 Click Cancel to return to the list of analysis types.
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Deleting Analysis Types
You cannot delete an analysis type that is being used by an existing scenario. The scenario must 
first be deleted (in the In Progress or Complete state) or completed and then deleted (in the 
Submitted or Approved state). 

➤ To delete one or more analysis types:

1 In the Administration Workbench, click the Model Designer tab. Then click the Analysis Types link. 

2 Select one or more analysis types by enabling their checkboxes.

3 Click the Delete button.

Creating Analysis Types
You create an analysis type when you want to set default properties for new scenarios, 
including the planning workbook used in an analysis and the key metrics that are calculated 
and displayed. You can also edit an analysis type, for example, to modify the list of default 
participants and approvers. 

For analysis types that include a data collection workbook, you also specify default data 
providers and define the email template that is used to send them instructions and the 
workbook attachment.

An analysis type must be associated with a planning workbook; otherwise, it is not displayed in 
the Analysis Workbench for analysis owners to use when creating scenarios. 

➤ To create an analysis type:

1 In the Administration Workbench, click the Model Designer tab. Then click the Analysis Types link. 

2 Click the Add button and enter:

● Type—The type of analysis (Analysis, Data Collection, or Forecast). 

● Analysis —This type of analysis is used for what-if analysis.

● Data Collection—This type of analysis is used in data collection scenarios. The Data 
Collection type allows you to specify default data providers and a default email form, in 
addition to what-if analysis details.

● Forecast—This type of analysis supports integration with the third party application 
ForecastPro. The Forecast type allows users to export data to ForecastPro for forecast 
calculation using statistical methods.

● Name—Enter a unique name for the analysis type. 

● Display Name—The name displayed in the Planning Workbench for others to see. Use a 
name that helps identify the purpose of the analysis type. For example, for data collection, 
add "input" or "import" to the name.

● Description—Enter a brief description for the analysis type.

3 Associate one or more planning and report workbooks with the new analysis type. 
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You can view details for analysis workbooks by clicking Cancel and then clicking the 
Workbooks link on the Model Designer tab.

● Planning Workbook—Select a planning workbook from the menu. You must select a 
planning workbook. The planning workbook is used for what-if analysis in scenarios with 
the given analysis type. 

● Report Workbooks—Optionally, select one or more report workbooks from the Available 
Report Workbooks list by highlighting them. Then click the Add button to move the 
selected workbooks to the Assigned Report Workbooks list. Selected report workbooks are 
listed in the Planning Workbench>View Reports section for the new analysis type.

4 Define default key metrics for the new analysis type. 

These are calculated and displayed for scenarios with this analysis type.

First you select the cube that contains the measure you are interested in. Then you specify the 
cube location of a particular value for that measure. Measure values occur at intersections of 
cube dimensions, with coordinates given by one member from each dimension, including the 
measure dimension.

To add a key metric, click the Add button at the top of the Key Metrics panel. In the Key Metric 
dialog box, define a key metric as follows:

● Name—Enter a name for the key metric. A name is required and should be unique. Some 
suggestions:

Complete the key metric definition in the Key Metrics dialog box before choosing a name. 

Use a name that is close to the dimension member name (from the cube's measure 
dimension). For example, Projected Sales.

Indicate in the name whether the key metric value is Absolute (the absolute value, 
calculated using data in the scenario's sandbox) or Relative ( the difference between that 
value and the base value, calculated using the base data in the Oracle Strategic Operational 
Planning database). If the difference is used, a recommended naming convention is to add 
"Delta" to the name, as in Projected Units Delta. 

Indicate in the name the data type of the key metric, for example, whether the value is 
given in dollars (as in Projected Sales $) or number of units (Projected Units).

● Description—Enter a brief description for the key metric. For example, use the key metric 
name as the description. 

● Cube—Select a cube from the Cube menu that contains the measure you are interested in. 
Each measure belongs to one and only one cube. You can view details for cubes on the Data 
Designer tab in the Administration Workbench.

● Delta—Choose how to display the value of the key metric:

● Absolute—The absolute value of the measure calculated using data in the scenario's 
sandbox. For example, this value might correspond to an actual value based on actual data 
values entered into a planning workbook during an analysis. 

● Relative—The difference between the absolute value above and the value calculated using 
the base data in the Oracle Strategic Operational Planning database. For example, this 
value might correspond to the difference between an actual value and a plan value. 
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● Members—After selecting a cube, you must specify one member from each dimension in 
the cube, including the measure dimension, to complete the definition of the key metric. 
Follow these steps:

❍ Click the Add button. An empty text field is displayed.

❍ Enter the fully qualified name of a dimension member in the form dimension 
name/namespace/member name. The measure dimension and its namespace have 
the same name as the cube.

❍ Repeat the above steps until you have selected one member from each dimension in 
the cube, including the measure dimension.

For example, consider a key metric named Projected Sales Delta corresponding to a 
measure named Projected Sales which is contained in the Forecast cube. The Forecast 
cube includes the dimensions ProductLine, Geography, Customer, Fiscal, and 
Forecast. (The Forecast dimension is the measure dimension.) 

To define the key metric Projected Sales Delta as projected sales for all customers in all 
regions for all product lines for Q4 of 2004, the following members must be added:

ProductLine/ProductLine/ProductLine

Geography/Geography/Geography

Customer/Customer/Customer

Fiscal/Fiscal/2004 Q4

Forecast/Forecast/Projected Sales

5 Click OK to save the key metric definition.

The new key metric is now listed for the analysis type. Click on a key metric name in the list to 
reopen the Key Metric dialog box and view or edit the definition.

Note: If you encounter any problem saving a key metric definition, ensure that all members are from the same cube, the 
cube is the same as the one selected in the Cube menu, 0nly one member is selected from each dimension in the 
cube.

To delete a key metric:

● Select one or more key metrics to delete by enabling their checkboxes. To deselect a key 
metric, disable its checkbox.

● Click the Delete button at the top of the Key Metrics panel.

6 Optional. Select default participants for this analysis type. 

Participants can review scenarios with the given analysis type and provide comments, and they 
can create scenario alternatives. Analysis owners can remove default participants and add 
others when they create a scenario.

● Select one or more users in the Available Participants list as default participants by 
highlighting them. Then click the Add button to move the selected participants to the 
Assigned Participants list. 

● To remove a user as a default participant, click a name to highlight it in the Assigned 
Participants list. Then click the Remove button. 
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7 Optional. Select default approvers for this analysis type. 

Approvers can review scenarios with the given analysis type and provide comments, and they 
can approve plan changes. 

By default, analysis owners can remove default approvers and add others when they create a 
scenario, if they wish. If the response.allowEdit.Approvers  parameter is set to false, 
analysis owners cannot add or remove approvers. In this case, it is recommended that analysis 
types include a list of default approvers.

● Select one or more users in the Available Approvers list as default approvers by highlighting 
them. Then click the Add button to move the selected participants to the Assigned 
Approvers list. 

● To remove a user as a default approver, click a name to highlight it in the Assigned 
Approvers list. Then click the Remove button. 

8 (For data collection analysis types) Select a data collection workbook from the menu. 

You must select a data collection workbook for data collection analysis types. The Scenario 
Data Collection panel is then displayed when users create scenarios. The data collection 
workbook is used by data providers to update forecast data.

9 (For data collection analysis types) Select default data providers. 

In data collection scenarios, data providers receive data collection workbooks to update 
forecast data. Data providers do not participate in what-if analysis. Analysis owners can 
remove default data providers and add others when they create a scenario, if they wish.

● Select one or more users in the Available Data Providers list as default data providers by 
highlighting them. Then click the Add button to move the selected data providers to the 
Assigned Data Providers list. 

● To remove a user as a default data provider, click a name to highlight it in the Assigned Data 
Providers list. Then click the Remove button.  

10 (For data collection analysis types) Define a default email form. 

The form is used in data collection scenarios to email instructions and an attached data 
collection workbook to data providers. Analysis owners can edit the default form for individual 
data providers. Enter the following information:

● CC—Enter one or more email addresses separated by commas or semicolons. Recipients 
receive copies of email messages sent to data providers, including copies of data collection 
workbooks. Copies are for information only. Recipients do not participate in data collection 
scenarios unless specifically added as participants or approvers.

● Subject—Enter text for the subject heading of the email message. 

● Body—Enter text for the body of the email message. For example, text can include 
instructions for updating data collection workbooks and a return email address where 
completed workbooks should be sent.

● Report—Select a report from the menu to include as an email shortcut in the message. 
When the email is sent, a link to the report is displayed at the end of the message text. In this 
way, you can include information in a separate report so that the data collection workbook 
attachment is smaller.
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11 Click OK to save the new analysis type, or click Cancel to return to the list of analysis types without saving 
the analysis type.

The new analysis type is now listed under the Planning Workbench.

Editing Analysis Types

➤ To edit an analysis type:

1 In the Administration Workbench, click the Model Designer tab. Then click the Analysis Types link.

2 Click the underlined name of an analysis type.

3 Optional. Change the following summary details:

● Display Name—The name displayed in the Planning Workbench for others to see. Use a 
name that helps identify the purpose of the analysis type. For example, for data collection, 
add "input" or "import" to the name.

● Description—The description of the analysis type.

4 Change the planning and report workbooks that are associated with the analysis type. 

You can view details for analysis workbooks by clicking Cancel and then clicking the 
Workbooks link on the Model Designer tab. 

● Planning Workbook—Select a planning workbook from the menu. You must select a 
planning workbook. The planning workbook is used for what-if analysis in scenarios with 
the given analysis type. 

● Report Workbooks—Optionally, select one or more report workbooks from the Available 
Report Workbooks list by highlighting them. Then click the Add button to move the 
selected workbooks to the Assigned Report Workbooks list. Selected report workbooks are 
listed in the Planning Workbench>View Reports section for the new analysis type.

5 Define default key metrics for the new analysis type. 

These are calculated and displayed for scenarios with this analysis type.

First you select the cube that contains the measure you are interested in. Then you specify the 
cube location of a particular value for that measure. Measure values occur at intersections of 
cube dimensions, with coordinates given by one member from each dimension, including the 
measure dimension.

To add a key metric, click the Add button at the top of the Key Metrics panel. In the Key Metric 
dialog box, define a key metric as follows:

● Name—Enter a name for the key metric. A name is required and should be unique. Some 
suggestions:

❍ Complete the key metric definition in the Key Metrics dialog box before choosing a 
name. 

❍ Use a name that is close to the dimension member name (from the cube's measure 
dimension). For example, Projected Sales.
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❍ Indicate in the name whether the key metric value is Absolute (the absolute value, 
calculated using data in the scenario's sandbox) or Relative ( the difference between 
that value and the base value, calculated using the base data in the Oracle Strategic 
Operational Planning database). If the difference is used, a recommended naming 
convention is to add "Delta" to the name, as in Projected Units Delta. 

❍ Indicate in the name the data type of the key metric, for example, whether the value is 
given in dollars (as in Projected Sales $) or number of units (Projected Units).

● Description—Enter a brief description for the key metric. For example, use the key metric 
name as the description. 

● Cube—Select a cube from the Cube menu that contains the measure you are interested in. 
Each measure belongs to one and only one cube. You can view details for 

● Delta—Choose how to display the value of the key metric:

● Absolute—The absolute value of the measure calculated using data in the scenario's 
sandbox. For example, this value might correspond to an actual value based on actual data 
values entered into a planning workbook during an analysis. 

● Relative—The difference between the absolute value above and the value calculated using 
the base data in the Oracle Strategic Operational Planning database. For example, this 
value might correspond to the difference between an actual value and a plan value. 

● Members—After selecting a cube, you must specify one member from each dimension in 
the cube, including the measure dimension, to complete the definition of the key metric. 
Follow these steps:

6 Click the Add button. 

An empty text field is displayed.

7 Enter the fully qualified name of a dimension member in the form dimension 
name/namespace/member name. 

The measure dimension and its namespace have the same name as the cube.

8 Repeat the above steps until you have selected one member from each dimension in the cube, including 
the measure dimension.

For example, consider a key metric named Projected Sales Delta corresponding to a measure 
named Projected Sales which is contained in the Forecast cube. The Forecast cube includes the 
dimensions ProductLine, Geography, Customer, Fiscal, and Forecast. (The Forecast dimension 
is the measure dimension.) 

To define the key metric Projected Sales Delta as projected sales for all customers in all regions 
for all product lines for Q4 of 2004, the following members must be added:

ProductLine/ProductLine/ProductLine

Geography/Geography/Geography

Customer/Customer/Customer

Fiscal/Fiscal/2004 Q4

Forecast/Forecast/Projected Sales
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Click OK to save the key metric definition. The new key metric is now listed for the analysis 
type. Click on a key metric name in the list to reopen the Key Metric dialog box and view or 
edit the definition.

Note: If you encounter any problem saving a key metric definition, check to make sure all members are from the same 
cube, the cube is the same as the one selected in the Cube menu, and only one member is selected from each 
dimension in the cube.

To delete a key metric:

● Select one or more key metrics to delete by enabling their checkboxes. To deselect a key 
metric, disable its checkbox.

● Click the Delete button at the top of the Key Metrics panel.

9 Modify the list of default participants for this analysis type. 

Participants can review scenarios with the given analysis type and provide comments, and they 
can create scenario alternatives. Analysis owners can remove default participants and add 
others when they create a scenario.

● Select one or more users in the Available Participants list as default participants by 
highlighting them. Then click the Add button to move the selected participants to the 
Assigned Participants list. 

● To remove a user as a default participant, click a name to highlight it in the Assigned 
Participants list. Then click the Remove button.

10 Modify the list of default approvers for this analysis type. 

Approvers can review scenarios with the given analysis type and provide comments, and they 
can approve plan changes. 

By default, analysis owners can remove default approvers and add others when they create a 
scenario, if they wish. If the response.allwEditApprovers parameter is set to false, 
analysis owners cannot add or remove approvers. In this case, it is recommended that analysis 
types include a list of default approvers.

● Select one or more users in the Available Approvers list as default approvers by highlighting 
them. Then click the Add button to move the selected participants to the Assigned 
Approvers list. 

● To remove a user as a default approver, click a name to highlight it in the Assigned 
Approvers list. Then click the Remove button.

11 (For data collection analysis types) Select a data collection workbook from the menu. 

You must select a data collection workbook for data collection analysis types. The Scenario 
Data Collection panel is then displayed when users create scenarios. The data collection 
workbook is used by data providers to update forecast data.

12 (For data collection analysis types) Modify the list of default data providers.

 In data collection scenarios, data providers receive data collection workbooks to update 
forecast data. Data providers do not participate in what-if analysis. Analysis owners can 
remove default data providers and add others when they create a scenario, if they wish.
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● Select one or more users in the Available Data Providers list as default data providers by 
highlighting them. Then click the Add button to move the selected data providers to the 
Assigned Data Providers list. 

● To remove a user as a default data provider, click a name to highlight it in the Assigned 
Data Providers list. Then click the Remove button. 

13 (For data collection analysis types) Modify the default email form. 

The form is used in data collection scenarios to email instructions and an attached data 
collection workbook to data providers. Analysis owners can edit the default form for individual 
data providers. Enter the following information:

● CC—Enter one or more email addresses separated by commas or semicolons. Recipients 
receive copies of email messages sent to data providers, including copies of data collection 
workbooks. Copies are for information only. Recipients do not participate in data 
collection scenarios unless specifically added as participants or approvers.

● Subject—Enter text for the subject heading of the email message. 

● Body—Enter text for the body of the email message. For example, text can include 
instructions for updating data collection workbooks and a return email address where 
completed workbooks should be sent.

● Report—Select a report from the menu to include as an email shortcut in the message. 
When the email is sent, a link to the report is displayed at the end of the message text. In 
this way, you can include information in a separate report so that the data collection 
workbook attachment is smaller..

14 Click OK to save the new analysis type.

Specifying Whether Users Can Edit the List of Approvers
The ability for an analysis owner and participants to add or remove approvers in a scenario is 
set by a parameter, response.allowEditApprovers. If explicitly set, the parameter is located in 
the ISServer.properties file on the server machine in the following directory:

c:\interlace_root\ISServer.properties

where interlace_root is the Oracle Strategic Operational Planning installation directory. 

If this parameter is set to true, the analysis owner, participants, and administrators can add or 
remove approvers while the scenario is in the In Progress state. If this parameter is set to false, 
only administrators can add or remove approvers. The default value is true. To change this 
value to false, open the ISServer.properties file in a text editor such as Windows Notepad, add 
the following line to the file, and then save the changes to the file:

response.allowEditApprovers=false

If the parameter is set to false, it is recommended that analysis types be given a default list of 
approvers when they are created or edited.
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Managing Queries
Managing queries involves:

● Creating a Query

● Editing a Query

● Previewing a Query

● Deleting a Query

You can use the following types of queries:

● RSQL (Rowsource Structured Query Language)—A query defined using SQL that is 
designed to return rowsource data. Rowsource data is transactional- or component-level 
data, for example, sales order details. Rowsource data is loaded into relational tables in the 
Oracle Strategic Operational Planning database from your execution database. 

● MDX (Multidimensional Expressions)—A query defined using standard MDX and Oracle 
Strategic Operational Planning extensions that is designed to query multidimensional 
cubes. MDX queries return subsets of the base data or scenario data in the Oracle Strategic 
Operational Planning database. 

● Overlay—A query created using Oracle Strategic Operational Planning tools in Excel that 
defines the layout of a planning worksheet. The layout sets the level to which a dimension 
hierarchy or list of measures is expanded or collapsed. The layout also focuses the view to 
display only measures and dimension members of interest.

● Custom—A query defined using custom Java classes. 

Creating a Query

➤ To create a report query:

1 In the Administration Workbench, click the Model Designer tab. Then click the Queries link.

2 Click the Add button and enter the following details:

● Enter a name for the query in the Name field. The query name must be a single word.

● From the Type menu, select the query type (RSQL or MDX), depending on whether you 
are querying rowsource data or cube data. To create an overlay query, use Oracle Strategic 
Operational Planning tools in Excel to create a new worksheet layout. You cannot create 
custom queries.

● In the Description field, enter a brief description.

● In the Definition field, enter the query definition using either RSQL or MDX. You can copy 
and paste the query definition from another source, such as a text file.

3 Preview the query to confirm query results and correct any syntax errors.

4 Click OK to save the query definition, or click Cancel to return to the list of queries without saving the 
query.
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Note the following syntax requirements for query definitions:

● A comma is required after an ON COLUMNS statement if it is followed by an ON ROWS 
statement. Otherwise, a comma is not required.

● You may place a line break between keywords; however, do not place a line break inside a 
dimension member name. 

● A Parameter(...) statement is required in an MDX query for each filter menu you plan to 
create in a report worksheet.

Editing a Query

➤ To edit a report query:

1 In the Administration Workbench, click the Model Designer tab. Then click the Queries link.

2 Click the underlined name of the query. 

The query definition is displayed.

3 Modify query details as follows:

● You cannot change the query name (in the Name field).

● From the Type menu, select the query type (RSQL or MDX), depending on whether you 
are modifying the query to return rowsource data or cube data. To edit an overlay query, 
use Oracle Strategic Operational Planning tools in Excel to modify an existing worksheet 
layout. You cannot edit custom queries.

● In the Description field, modify the description.

● In the Definition field, modify the query definition using either RSQL or MDX, depending 
on the type of query. You can copy and paste any changes from another source, such as a 
text file, if you wish.

4 Preview the query to confirm query results and correct any syntax errors.

5 Click OK to save the modified query definition. 

Note the following syntax requirements for query definitions:

● A comma is required after an ON COLUMNS statement if it is followed by an ON ROWS 
statement. Otherwise, a comma is not required.

● You may place a line break between keywords; however, do not place a line break inside a 
dimension member name. 

● A Parameter(...) statement is required in an MDX query for each filter menu you plan to 
create in a report worksheet.

Previewing a Query
You preview a query to confirm that it returns the results you expect. When you preview a 
query, a syntax check is performed and any errors are reported. Query results are displayed in a 
table in a separate browser window. 
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If you are creating a new report worksheet, the number of columns required in the report is the 
same as the number of columns in the preview table. The number of columns depends on the 
hierarchy level of the dimension member(s) specified in the query definition.

You can preview a query while creating it, and you can preview an existing query. You can 
preview the query using base data in the Oracle Strategic Operational Planning database, or 
scenario data. 

➤ To preview a report query:

1 In the Administration Workbench, click the Model Designer tab. Then click the Queries link.

2 Select a query to preview. 

● Click the name of an existing query, then click the Preview button.

● Click the Add button. Enter your new query, then click the Preview button.

3 From the Preview menu, select whether to preview the query using base data in the Oracle Strategic 
Operational Planning database or scenario data. 

● If you choose to preview the query using scenario data, select the name of a root scenario 
or one of its alternatives from the menu that opens. If no names are displayed, no scenarios 
exist in the In Progress or Submitted state.

● A separate browser window opens to display the query definition and any syntax errors. 
Correct any errors in the query definition displayed on the Edit Query or Create Query 
screen. Remember to select the correct query type (RSQL or MDX) from the Type menu. 
Then click the Preview button again to confirm your corrections. Each time you preview 
the query, a new browser preview window opens.

4 If there are no errors, the query runs and a table of results is displayed in the browser preview window. 

● Depending on the query, it may take time to retrieve results from the Oracle Strategic 
Operational Planning database. Keep the preview browser window open until the query is 
finished running. 

● MDX queries pause during preview each time a Parameter(...) statement is encountered in 
the query definition. A dialog box opens and you are prompted to enter a specific value for 
the parameter. Enter a value and then click OK to continue.

For example, if the parameter represents a dimension member name, enter the fully 
qualified dimension member name in the form dimension name/namespace 
name/member name, as in Manufacturing/MY 2004/August.

● RSQL queries pause during preview each time the variable "?" is encountered in the query 
definition. A dialog box opens and you are prompted to enter a specific value to substitute 
for the ? variable. Enter a value and then click OK to continue.

5 When the query has finished running and you have viewed results, close the browser preview window(s).
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Deleting a Query

➤ To delete one or more report queries:

1 In the Administration Workbench, click the Model Designer tab. Then click the Queries link.

2 Select one or more queries to delete by enabling their checkboxes.

3 Click the Delete button.
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Managing the Job Queue
The job queue lets you execute and monitor the status of certain administrative tasks, 
including data staging and loading operations and dimension restructuring.

In general, data loading jobs are scheduled and executed using predefined batch scripts. For 
example, data loading scripts can be used to update data periodically in the Oracle Strategic 
Operational Planning database. They can restructure dimensions and recalculate cube data if 
the underlying metadata has been modified. They can also delete unnecessary jobs from the 
job queue, for example, when multiple entries for the same job occur.

Using the job queue to execute a job manually is not recommended in most cases. Depending 
on the job, running it manually may consume system resources and significantly slow browser 
response. 

Managing the job queue involves:

● Viewing Jobs

● Executing Jobs

● Deleting Jobs

● Adding Jobs

● Editing Jobs

Viewing Jobs
The job queue displays details for jobs initiated manually in the user interface and also jobs 
executed using batch scripts.

➤ To view jobs in the job queue, job status, and job details:

1 In the Administration Workbench, click the Administration tab. Then click the Job Queue link. 
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2 View open or executed jobs by clicking the menu labeled either Open Jobs or Executed Jobs at the top of 
the Job Queue panel, and then select the type of list to view.

● Open jobs have not yet been executed or are currently running. They are in the Pending or 
Active states. 

● Executed jobs have been completed or attempted. They are in the Completed, Completed 
with Warnings, or Failed states. 

3 Sort the list by clicking a column header. Click again to reverse the sort direction. 

The following columns are displayed:

● Type—The job category, for example, restructuring.

● Creation Date—(For open jobs) The date and time the job was added to the job queue.

● Command—The actual command that is executed by the Oracle Strategic Operational 
Planning server to perform the job. 

● Status—The status of the job:

● Pending—Not yet invoked

● Active—Currently running

● Completed—Completed successfully

● Completed with Warnings—Completed with errors that did not interrupt job execution

● Failed—Failed with errors that interrupted job execution

● Owner—The user on whose behalf the job is executed. The owner of a data collection 
scenario is automatically the owner of data collection jobs such data staging and data 
loading.

● Error Fatal—A value (Yes or No) that indicates whether errors during job execution 
interrupt the job.

● Command—The actual command that is executed by the Oracle Strategic Operational 
Planning server to perform the job. 

● Description—A description of the job.

4 Refresh your browser to view updated status. 

5 Click the job type to view additional job details, including the complete list of commands that are run to 
perform the job. 

Executed jobs include the following additional information:

● Execution Date—The date and time the job was executed, that is, completed or attempted.

● Execution Detail—The name and location of an error log file containing information on 
errors that occurred. If no errors occurred, this field indicates None.

6 Click Cancel to return to the list of jobs.
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Executing Jobs
You can execute jobs manually that are in the Pending state. Jobs are executed sequentially in 
the order they were created. If you execute one job of a certain type, all jobs of that type in the 
job queue are executed.

Jobs run in the background. Depending on the job, your browser response may be slow during 
job execution.

➤ To execute jobs manually in the job queue:

1 In the Administration Workbench, click the Administration tab. Then click the Job Queue link.

2 Select one or more jobs by enabling their checkboxes. 

3 Click the Execute button. 

The button is disabled until you select a job.

4 Switch to the list of executed jobs to view job status. Click the menu labeled either Open Jobs or Executed 
Jobs, and then select Executed Jobs. 

5 Refresh your browser to view updated status. 

You can also monitor job progress in the DOS command prompt window where the Oracle 
Strategic Operational Planning server is running. You can view job history in the console log 
file isserver.log located in the interlace_root\logs directory, where 
interlace_root is the Oracle Strategic Operational Planning installation directory. 

Deleting Jobs
You can delete all jobs except those with status Active.

➤ To delete jobs in the job queue:

1 In the Administration Workbench, click the Administration tab. Then click the Job Queue link.

2 Select jobs to delete from the list of open or executed jobs by enabling their checkboxes.

3 Click the Delete button.

Adding Jobs
If you are familiar with the Oracle Strategic Operational Planning isadmin command-line 
tool, you can add a custom job to the job queue. It is strongly recommended that you do not 
edit isadmin commands for predefined jobs. (See Chapter 10, “Isadmin Commands” for 
detailed information on the isadmin commands.)

➤ To add a job to the job queue:

1 In the Administration Workbench, click the Administration tab. Then click the Job Queue link. 

2 Click the Add button.
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3 Specify job details:

● Type—Enter the type of job. This field is used as the job display name in the job queue.

● Description—Enter a brief description of the job.

● Owner—Select a user from the menu on whose behalf the job will be executed.

● Error Fatal—Indicate whether errors during job execution interrupt the job (Yes) or do 
not interrupt the job (No).

● Command—Enter the actual commands that are executed by the Oracle Strategic 
Operational Planning server to perform the job. 

4 Click OK to add the job to the job queue.

Editing Jobs
You can edit jobs that are in the Pending state.

➤ To edit an existing job in the job queue:

1 In the Administration Workbench, click the Administration tab. Then click the Job Queue link. 

2 Click the job type to display job details. 

3 Edit job details:

● Type—Enter the type of job. This field is used as the job display name in the job queue.

● Description—Enter a brief description of the job.

● Owner—Select a user from the menu on whose behalf the job will be executed.

● Error Fatal—Indicate whether errors during job execution interrupt the job (Yes) or do not 
interrupt the job (No).

● Command—It is strongly recommended that you do not edit the commands in this field. 

4 Click OK to save your changes.

Managing Users
Administrators can manage users to grant and modify access to the Oracle Strategic 
Operational Planning application, including updating email addresses and resetting user 
passwords. Administrators can also assign one or more analysis types to users. 

Assigned analysis types are displayed in the Analysis Workbench and allow users to do the 
following:

● Create new scenarios with the assigned analysis type. 

● Create alternative scenarios as owners or participants in scenarios with the assigned analysis 
type.

If users are not granted access to a given analysis type, they can still participate in scenarios 
with that analysis type as owners, participants, or approvers. However, owners and participants 
can no longer create scenario alternatives. In addition, the analysis type is only temporarily 
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displayed in the Analysis Workbench. It disappears for approvers when they approve the 
scenario, and for owners and participants when the scenario is committed and then deleted 
from the user interface.

Managing users involves:

● Viewing Users

● Adding Users

● Editing Users

● Deactivating Users

Viewing Users
You can view a list of users and see whether they are currently logged in.

➤ To view users:

1 In the Administration Workbench, click the Administration tab. Then click the Users link. 

A list of users is displayed with the following information for each user:

● Login Name—The unique login name (username) of the user.

● Full Name—The full name of the user, also used as the display name.

● Email Address—The email address of the user, where notification messages are sent.

● Logged In?—A value (Yes or No) that indicates whether the user is currently logged into 
the system.

● Active—A value (Yes or No) that indicates whether the user's account is active (the user is 
able to log into the system) or deactivated (the user is no longer able to log into the 
system).

2 Click the underlined name of a use to view and edit user details, including a list of the user's assigned 
analysis types. 

3 Click OK to return to the list of users.

Adding Users
You create a new user to grant that user access to the Oracle Strategic Operational Planning 
application. After creating the user, you then edit the user to grant access to analysis types.

➤ To add a user:

1 In the Administration Workbench, click the Administration tab. Then click the Users link.

2 Click the Add button.

3 Enter the following information for the new user:

● Login Name—A unique login name (username) for the user.
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● Full Name—The full name of the user, for example, first and last name. This name is also 
used as the display name.

● Email Address—The email address of the user, where notification messages are sent. The 
email address must be in the form name@domain.com.

● Account Active—A checkbox that indicates whether the user's account is activated. Enable 
the checkbox to activate the user's account. 

● Password—A login password for the user. Users can update their user profiles later to 
change this password.

4 Retype the user's password to confirm it.

5 Assign analysis types to the user as follows:

● In the Available Analysis Types list, select one or more analysis types to assign to the user. 
Then click Add to move the analysis type(s) to the Assigned Analysis Types list.

● In the Assigned Analysis Types list, select one or more analysis types to remove from the 
user and click Remove to move the analysis type(s) to the Available Analysis Types list.

6 Click OK to save the new user.

Editing Users
You can change the email address and password of a user. For example, you can change the 
default administrator login name and password. You cannot change the login name 
(username), since that is a user's unique ID in the system.

You can also grant a user access to one or more analysis types. The user can then create 
scenarios with the assigned analysis type.

➤ To edit an existing user:

1 In the Administration Workbench, click the Administration tab. Then click the Users link.

2 Click the underlined name of the user you wish to edit.

3 Edit the following user information:

● Full Name—The full name of the user, for example, first and last name. This name is also 
used as the display name.

● Email Address—The email address of the user, where notification messages are sent. The 
email address must be in the form name@domain.com.

● Account Active—A checkbox that indicates whether the user's account is activated. Enable 
the checkbox to activate the user's account. Disable the checkbox to deactivate the user's 
account.

● Password—A new login password for the user. Users can update their user profiles later to 
change this password.

4 Retype the user password to confirm it.
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5 Add or remove the user's assigned analysis types.

● In the Available Analysis Types list, select one or more analysis types to assign to the user. 
Then click Add to move the analysis type(s) to the Assigned Analysis Types list.

● In the Assigned Analysis Types list, select one or more analysis types to remove from the 
user and click Remove to move the analysis type(s) to the Available Analysis Types list.

6 Click OK to save changes to the user.

Deactivating Users
When a user's account is deactivated, the user can no longer log into the system.

➤ To deactivate one or more users:

1 In the Administration Workbench, click the Administration tab. Then click the Users link.

2 Select individual users or a block of users in one of the following ways:

3 Select one or more users by enabling their checkboxes. 

4 Click the Deactivate button.

You can reactivate the user's account by clicking the Activate button.
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About Isadmin Commands
Isadmin is the client-side command line tool to interact with the Oracle Strategic Operational 
Planner application server.           

Command Options

Common Usage
● Execute the statement “export model definitions” and define the username and password  

to connect to the server.

isadmin -u admin -p password -s “export model definitions”

● Execute the statements in commands.isa and define the username and password to 
connect to the server. 

isadmin -u admin -p password -f “c:\osop\custom\bin\load.isa”

The “isa” extension is commonly used as extension for files containing “isadmin” 
commands. You must define the full path for the file.

● Execute multiple commands interactively by creating a “shell” and entering commands one 
at a time. 

C:\dev>isadmin -u admin -p password
Logged in as admin
Admin> create sandbox new_sandbox
executing: [create sandbox new_sandbox]
Admin> alter sandbox set batch mode
executing: [alter sandbox set batch mode]
Admin> alter sandbox calculate
executing: [alter sandbox calculate]
Admin> submit sandbox

Table 10 isadmin Command Options

Option Description

-e Encrypted password

 -f File containing statements to execute

 -h Help

 -l Log file

 -p Password

 -r Server port number (default = 3333)

 -s Statement to execute

 -u Username 

 -v  Server name (default = localhost)
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executing: [submit sandbox]
Admin> logout
executing: [logout]
Syntax error at line 1 column 1
logout
^
Admin> exit
C:\dev>

This creates a session in the server and all commands are executed within that session. In 
the above example:

❍ Users create a shell by entering the command as shown. 

❍ The client responds by displaying the prompt “Admin>”. 

❍ Users enter the commands one at a time. 

Commands are displayed in blue and client responses are displayed in black. 

❍ Each command makes a round trip to the server, and users can monitor the server log. 
Syntax errors are highlighted. 

❍ Users complete the session by entering “exit”. 

Note: In Windows, you can access previous commands by using the up and down arrow keys. 

Isadmin Commands and XML Files
The following topics discuss:

● XML Schema Files

● XML Files and Search Path

XML Schema Files
Metadata objects, scenario objects, and other data objects imported and exported from Oracle 
Stragetic Operataionl Planning conform to the grammar specified in the XML schema files in:

<install-root>/etc/schema

You can use the Administration Workbench to generate objects . If XSD functionality is not 
supported, use XML to generate the objects.

XML Files and Search Path
When referring to XML files in an isadmin command, the system looks through the following 
directories:

<install-root>/custom/<directory-representing-object-type>
<install-root>/interlace/<directory-representing-object-type>
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Using Isadmin Commands in Oracle Strategic Operational 
Planning

➤ To use isadmin commands in Oracle Strategic Operational Planning:

1 Install Oracle Strategic Operational Planning, setup the database, modify the properties, and setup PATH 
and other environment variables. 

See Chapter 2, “Installation and Maintenance” for details

2 Ensure that the server is not running; then, in a DOS window, type isreset. 

Isreset drops all internal tables and model information. It then creates the internal tables 
again. There is no model at this time. 

3 Type startserver to start the server. 

The server starts and listens on the configured port.

4 Open another DOS window and type initializesystem.bat.

This initializes the objects needed to build a model.

5 Use the Administration Workbench to build a model (see “Building a Model” on page 95). 

Figure 3 shows the flow that happens in the system. 

Table 11 Search Path for Objects in the System

Object Type Directory Searched

Cube, Dimension, Constraints <install-root>/custom/model

<install-root>/interlace/model

Data Source <install-root>/custom/datasource, ...

Stagemap and loader files <install-root>/custom/loader, ...

Rowsource <install-root>/custom/rowsource, ...

Script Templates <install-root>/custom/scripts, ...

JACL scripts <install-root>/custom/jacl, ...

Analysis types <install-root>/custom/analysis, ...

Workbook, worksheets, named queries, 
styles, and XLS files used in worksheets

<install-root>/custom/workbook, ...

Dashboards <install-root>/custom/dashboards, ...

Isa files, other OS scripts <install-root>/custom/bin, ...

SQL scripts <install-root>/custom/sql, ...

Powerpoint presentation <install-root>/custom/presentation, ...

Exported information <install-root>/export 
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Figure 3 Flow for Building a Model

The objects created in the Administration Workbench are stored in the Model schema. You can 
verify errors, fix issues, and publish the objects for analysis. Oracle Strategic Operational 
Planning stores the models in the database where they are available between server starts.

6 Optional. Export model information to the file system.

Possible reasons to export model information:

● Moving the implementation from one machine to another (for example, from 
development to a test or production machine)

● Backing up the model in the file system

● Accessing functionalities that are only supported in XML

● Accessing model objects in XML form when writing scripts

To export model information to the file system, use the isadmin command export model 
definitions. The objects are exported to <install-root>/export and various sub-
directories (see “XML Files and Search Path” on page 183). 

Oracle Strategic Operational Planning also exports an isa file that contains import statements 
for modeling objects in the system. The objects and isa file reset the system and use scripts to 
recreate the model. 

7 Copy the sub-directories under <install-root>/export to <install-root>/custom. 

The export directory is only used for storing the exported files. You can make incremental 
changes in the custom directory and write scripts to import the changes back to the system. 
Once the model is imported back to the system, use the Administration Workbench to verify 
the model and make more changes if needed. 

8 Repeat incremental model building by following step 5, step 6, and step 7.

Isadmin Command Details 
Isadmin commands are categorized in the following logical groups:

● Macro Commands

● Import Commands
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● Publish Commands

● Commands for Loading Members into Dimensions and Building Hierarchies

● Export Commands

● Load Commands

● Sandbox Calculation, Submit, and Reconcile Commands

● Script Templates, JACL, and Groovy Scripts

● System Commands

● Migration Commands

● Commands to Export Multi-Dimensional Data

● Custom Java Code Commands

Note: The following sections discuss the semantics of the commands and the different activities they support. For a 
complete list of the commands and their syntax, see “isadmin Command Grammar” on page 203.

Macro Commands
Macro commands are resolved dynamically by the system at runtime. This simplifies script 
maintenance. As the object model changes, the macro commands automatically deal with the 
changes. 

For example:

publish rowsource definitions

publishes “all” rowsource definitions. The semantics “all” is determined at runtime. If you add 
a new rowsource, you do not need to change this script. 

Import Commands
Import commands import shadowed metadata objects such as cubes and dimensions, non-
shadowed objects such as worksheets and named queries, and scenarios and scenario-specific 
information into Oracle Stragetic Operational Planning.

The following example imports datasource, rowsource, dimension, stagemap, cube, and 
constraint objects. 

import datasource definition from file "datasource_IN_TRANSITTIME_DS.xml"
import rowsource definition from file "rowsource_IN_SCRAPPERCENT_RS.xml"
import dimension definition from file "dim_Fiscal.xml"
import stagemap definition from file "stagemap_IN_TRANSITTIME_SM.xml"
import cube definition from file "cube_DriveDemand.xml"
import constraint definition from file "constr_HDAExcess.xml"

The object definitions are in the XML file referred to in the command, and the XML file 
conforms to the grammar specified by the Oracle Strategic Planning XSD.  See “XML Files and 
Search Path” on page 183 for information on how to locate the XML file.
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On a clean system, the first action is to import these objects. If an object is already in the system 
and you run import again, Oracle Strategic Operational Planning compares the imported 
object with the existing object to see if anything has changed. 

Publish Commands
Publish commands check for objects imported into the system and publish the objects so they 
are available to everyone. When publishing, Oracle Strategic Operational Planning checks to 
make sure the object model is valid.

Publish commands refer to the following schemas supported by Oracle Strategic Operational 
Planning:

● Model schema—Schema into which XML objects are imported and maintained.  XML 
objects are created through actions in the Administration Workbench and  by isadmin 
import commands. 

All XML files that do not conform to XSD are rejected. In addition, Oracle Strategic 
Operational Planning does additional syntax and semantic checking not expressible in 
XSD. This results in a consistent and valid object model. 

There are two types of model objects: shadowed (cubes, dimensions) and non-shadowed 
(workbooks and worksheets used for presentations). When publishing, shadowed objects 
go first to the Edit schema first and then to the Base schema. Non-shadowed objects go 
directly to Base schema.

● Base schema—Schema into which XML objects that are converted to proprietary backend 
versions of objects are maintained. This is the published schema that is available to 
everyone. All loading, calculations, and data manipulation occur in this schema.

● Edit schema—Similar to the Base schema for storing backend versions of objects. Oracle 
Strategic Operational Planning creates the backend versions of XML objects in the Edit 
schema, does more error checking not possible in the Model schema, and then gets ready to 
push the changes to the Base schema. 

Publishing involves many commands as shown in the following example:

# Set the model schema to edit mode

alter model schema set current edit

# First set the schema to shadow in backend and clear any previous
# information there. We might have had lingering changes that had
# errors in them.
# Then publish rowsource and dimension definitions to shadow schema

set schema shadow
clear schema shadow

# The following commands are "macro" commands. The system keeps track
# of all the rowsources, datasources, etc. that are imported 
# and publishes them. The list of objects get resolved internally. 
# This is for convenience instead of 
# remembering to publish one object at a time

publish rowsource definitions
publish datasource definitions
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publish dimension definitions
publish stagemap definitions 
 
# The following command actually pushes the object definitions from 
# shadow schema to base schema.

alter system restructure

The following example shows publishing of cube and constraint objects. Note that you should 
publish cubes after you publish and restructure dimensions. 

# Set the model schema to edit mode

alter model schema set current edit

# First set the schema to shadow in backend and clear any previous
# information there. We might have had lingering changes that had
# errors in them.

set schema shadow
clear schema shadow

# The following commands are "macro" commands. The system keeps track
# of all the cubes that are imported 
# and publishes them. The list of objects get resolved internally. 
# This is for convenience instead of 
# remembering to publish one object at a time

publish cube definitions
publish constraint definitions 
 
# The following command actually pushes the object definitions from 
# shadow schema to base schema.

alter system restructure

Commands for Loading Members into Dimensions and 
Building Hierarchies
Loading members into a dimension is a metadata load. This is because during member load, 
the dimensional structures like members, member attributes, hierarchies, and levels get created 
and populated. This is metadata information. As a result, it is important to do a member load 
in the shadow schema and then restructure to publish changes to the base schema. 

The members of a dimension and how they are related to each other are important when 
creating the multi-dimensional space within which the system operates. 

The following example shows loading of members into dimensions and a subsequent 
restructure:

# First set the schema to shadow in backend and clear any previous
# information there. We might have had lingering changes that had
# errors in them.
# Then publish rowsource and dimension definitions to shadow schema
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set schema shadow
clear schema shadow

# do dimension load and restructure so dimensions and members are 
# in base schema. The macro replace command replaces all dimensions.
# The reference to model group name is from the stagemap definitions. 
# We allow users to logically group the stagemaps using this name 
# and the macro command automatically invokes all the stagemaps 
# that are grouped under this name. The user can choose to create 
# different logical groups and put the stagemaps under different 
# groups, and invoke them separately.

stage replace using modelgroup "Bootstrap-Dimension-Stagemaps"
load replace dimensions

# The following command actually pushes the object definitions 
# from shadow schema to base schema.

alter system restructure

Export Commands
Export commands export shadowed metadata objects such as cubes and dimensions, non-
shadowed objects such as worksheets and named queries, and scenarios and scenario-specific 
information out of Oracle Stragetic Operational Planning. 

The most common export commands are:

● Export all metadata to <install-root>/export. The different object types go into their 
respective directories; for example, datasource to <install-
root>/export/datasource. You can choose to export one object type at a time. The 
command syntax is found in the grammar. 

export model definitions

● Export all scenarios to <install-root>/export/scenarios. Each scenario gets 
exported to a new directory.

export all scenarios

● Export the documentation of the object model in the system. The command exports object 
details and their relationship as a HTML file in <install-root>/export/doc. The 
default file name is model.html. 

export documentation [to file <filename>]

Export commands are available for other objects in the system. 

Load Commands
Load commands load external data into the system. Oracle Strategic Operational Planning 
loads data into a new sandbox thereby not affecting the base sandbox. Upon successful load 
and calculation, isadmin commands can submit the changes to the base sandbox.
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Types of Load Commands
Loading data involves:

● Commands for staging data from a datasource into stage tables 

● Commands for loading data from stage tables into a rowsource

Each step can specify the semanitcs of the load in the corresponding command. Oracle 
Strategic Operational Planning supports these semantics:

● Update—For each input row, compose the record using the target’s <key> columns, and 
search for that record in the target. If the key exists, replace all non-key values in the target 
row with values from the input row. If the key does not exist, add the input row.

● Replace—Delete all target rows and add all input rows.

● Append—Insert the input row to the end of the target.

● Clear—Clear the stage tables.The combination of clear and update commands are same as 
the replace command.

Oracle Strategic Operational Planning uses update when the input data stream is incremental 
in nature; for example, inventory at the end of the current week. Replace is used when the data 
stream is a complete snapshot of the data in the external system.

Tip: Always do a “stage replace” even for incremental data streams. The load update of rowsource 
incrementally updates the rowsource. 

Tip: Staging is not done inside a sandbox, and the stage tables are common resources. As a result, 
stage commands are normally placed outside the sandbox.

The following commands deal with incremental data streams. The commands do a stage 
replace followed by a load into rowsources and cubes. 

# The model group concept is similar to that of dimensions. The
# stagemaps for rowsources are also grouped using different names. 
# It is important to match this name with that in the stagemap. 
# Otherwise, we will skip those rowsources.
stage replace using modelgroup "Bootstrap-Rowsource-Stagemaps"

# create sandbox,  load all rowsources, calculate and submit sandbox
# The macro definitions allow us simplify the commands and the system
# resolves the names of all rowsources to be loaded.
# When we create sandbox in the following command, we set new sandbox 
# to be the current sandbox in current session and is applicable to all
# subsequent commands. When sandbox is submitted, the current sandbox
# gets reset to base sandbox.

create sandbox "data_bootstrap"
alter sandbox set batch mode
load update  rowsources
alter sandbox calculate
submit sandbox
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The following commands stage and replace a single rowsource:

stage replace using stagemap IN_MEDIA_METADATA_SM"
create sandbox "media_meta_sb"
alter sandbox set batch mode"
load replace rowsource IN_MEDIA_METADATA_RS"
alter sandbox calculate
submit sandbox

The following command clears the stage tables of rowsources. Any subsequent update is like a 
replace:

stage clear rowsources

Troubleshooting Load Commands
If your data does not get loaded into a measure of a cube:

1. Check <install-root>/errors for any errors involving the rowsource that loads data 
into the measure. 

There are two types of errors:

❍ A rowsource value does not match any member name. 

This error implies that there is data for some members that is not in a dimension. You 
can ignore these errors. 

❍ A rowsource has duplicate values.

This error implies that the key for rowsource is not properly defined. Look at the key 
and the mapping between the rowsource and the cube. 

2. If there are no errors, look for the statement in the log that does the staging for the 
rowsource. Statements appear similar to: stage replace using stagemap 
<stagemap-name> or stage update using stagemap <stagemap-name>. 

❍ If there is no stage statement, the staging was never done. This usually happens if the 
script misses the stage command, or if the group name in the stagemap does not match 
the group name in the macro stage command. 

❍ If the stage statement exists, look for how many records were accepted or rejected. If 
there are no rejected records, then there is no problem with staging. 

3. Check if the "load" command is in the log. It has the pattern "load update" or "load replace" 
into the rowsource that is mapped to the measure. 

❍ If there is no load statement, fix the scripts to add the statement. 

❍ If the load statement exists, look for how many records were accepted or rejected. 
Rejected records  appear in the error file described above. 
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Sandbox Calculation, Submit, and Reconcile Commands
Sandbox calculation, submit, and reconcile commands load seed data into the blocks of the 
cube through rowsource loading and the mapping between the rowsource and different cubes. 
These values appear in loaded measures. There are other measures in the cube that need to be 
calculated. This is achieved as follows:

 create sandbox data_calculate
 alter sandbox set batch mode"
 load replace rowsource IN_MEDIA_METADATA_RS"
 alter sandbox calculate
 submit sandbox
 # Once the sandbox is submitted, the base sandbox changes.
 # All the open responses need to be reconciled with respect
 # to the new base and we use the following command for that.
  alter system reconcile active response

Note: Oracle Strategic Operational Planning supports two types of calculations, batch and interactive. The default 
calculation is interactive and should be only used for Excel scenarios.

Script Templates, JACL, and Groovy Scripts
Script templates, JACL, and Groovy scripts provide a convenient way to group commands. The 
commands can be executed from the file.

Script Templates
Script templates are similar to “isa” files in that they are group of commands; however, they are 
also class objects managed inside the system. You can use the Administration Workbench  to 
create and modify script templates, associate the permissions of who can run them, and  
execute them from the user interface. 

The following command imports script template information from the file system. 

Import script template from file "RegenerateAll.xml"

The XML file conforms to the XSD in <install-root>/etc.

The following command executes a script template and all the isadmin commands inside the 
script template.

alter system invoke script template "Initial Publish"

The name used in the command is the name defined inside the script template object (or XML 
file).

JACL and Groovy Scripts
JACL and Groovy scripts intermix isadmin commands with other activities such as polling 
external data source, sending emails, extracting data, calling API’s, and integrating with other 
systems. When the server starts, it prepares the script execution environment and it is ready to 
accept any JACL and Groovy scripts. 
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The following examples use JACL scripts; however, they are applicable to both JACL and 
Groovy scripts.

Use the following isadmin command to invokes the JACL script:

invoke external script "load-mdpothers.jacl"

The script can take an arbitrary number of arguments to be interpreted inside the JACL script. 

The following command invokes JACL script with two arguments:

invoke external script "load-mdpothers.jacl" "daily" 
"c:/osop/install/ftproot"

See “Perl Module Scripts” on page 201 for how to write the JACL script made available by the 
server during execution.

System Commands
System commands include the following maintenance activites:

● Garbage collection

Forces the Java server to run garbage collection at the end of large batch calculations or at 
the end of a script.

alter system gc

● Purge closed scenarios

Reduces the clutter in the user interface and improves performance. The first command 
below purges all closed scenarios, and the second command purges scenarios that are 
closed 30 (configurable number) days before.

alter system purge all closed scenarios
alter system purge closed scenarios older than 30 days

● Enable/disable single user administrative mode 

In administrative mode, all logins to the user interface are not allowed even as an 
administrator. Set the system to single user mode during large data load and calculations, 
and to normal mode at the end of the script. Disabling email at the beginning of a script 
and enable it again at the end. 

The typical pattern for a large script is:

alter system set maintenance mode
alter system disable email reader

... <other commands in the script> ...

alter system enable email reader
alter system unset maintenance mode
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Migration Commands
Migration commands support a complete export and a complete import. Common migration 
commands include:

● Prepare Migration—Exports all metadata and data to the file system. Data exported 
includes  the data in the rowsources and the user-entered data in the cubes. Derived data is 
not exported.

● Migration—Brings in the information from exported files and uses isadmin commands to 
import the model back into the system.The following command imports user-entered 
values in cube cells back into the cubes. 

load update cube "DriveDemand"

This command looks for <cube-name>-XXXX.csv files in directory <export-
dir>/migration/data, where XXXX is a counter and it starts from 0000. Cube data is  
exported to <export-dir>/migration/data  with a maximum of 50000 rows to a file. 

See “Migration Scripts” on page 202 for an example migration script.

Commands to Export Multi-Dimensional Data 
Oracle Strategic Operational Planning supports MDX queries that retrieve a slice of cubular 
data. Using isadmin commands, you can export this same data to relational tables to be used 
elsewhere. You can also use these commands to archive information on a recurring basis before 
a new data refresh.

The following command takes named a query as an argument, creates a relational table, and 
populates the table with data returned by the query. 

snapshot data using query <queryname> (append | replace)?

<queryname> refers to the named query in the system. You must create this query before 
running the command. append adds the data to the end of the table. replace drops all the 
rows and then adds the new rows to the table.

Custom Java Code Commands
Custom  Java Code commands are a set of “standard” java classes that are configurable through 
the properties file. With these standard java classes, there is no need to write any java code -  
you just need to understand what the command does and the different parameters it takes. 
Enter the following to invoke these commands:

alter system solve constraint using rule "MyRule1"

MyRule1 is defined in the properties file as follows:

ConstraintSolver.MyRule1.classname=com.interlacesystems.rules.PreviousVa
lueCopier
ConstraintSolver.MyRule1.description=Copies current week values to 
previous week 
ConstraintSolver.MyRule1.SourceMeasures=MS DEMAND
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ConstraintSolver.MyRule1.TargetMeasures=LAST WEEK MS DEMAND
ConstraintSolver.MyRule1.Cube=DriveDemand
ConstraintSolver.MyRule1.Condition=isNotPast
ConstraintSolver.MyRule1.Levels=DriveMedia-Level1,Week

The custom java classes are referred to as solvers, and they solve violation of  some business rule 
or constraint. All standard solvers take cube, levels, and condition as arguments. 

Solver behavior includes:

● Copy previous value—Copies values from one measure to another using the classname 
com.interlacesystems.rules.PreviousValueCopier. Preserves the values from 
one week (month) to another (month), and is invokedbefore loading values for the next 
time period. The new value is stored in the source measure and after the data refresh, values 
between the two time periods are compared. 

● Clear user input—Clears user-input values and returns to the original calculated or loaded 
value. The following code retrieves baseline loaded values 

ConstraintSolver.MyRule.classname=com.interlacesystems.rules.ClearUse
rInput
ConstraintSolver.MyRule.description=Clear Measures from DriveDemand 
cube
ConstraintSolver.MyRule.Cube=DriveDemand
ConstraintSolver.MyRule.Measures=MS DEMAND,MS DRIVE DEMAND

In this example, the classname is com.interlacesystems.rules.ClearUserInput 
and the parameters are cube and measures.

Conditions supported by Oracle Strategic Operational Planning include:

● isCurrent—Only the current time members of the cube participate in the solver work. As 
the time moves forward, the solver works on different time members.

● isPast—Only the past time members with respect to the current time participate in the 
solver work.

● isFuture—Only the future time members with respect to the current time participate in 
the solver work.

● isNotPast—The current and future time members with respect to the current time 
participate in the solver work.

● isNotCurrent—The past and future time members with respect to the current time 
participate in the solver work.

● isNotFuture—The past and current time members with respect to the current time 
participate in the solver work.

Scripts in <install-root>/bin
The following scripts are found in <install-root>/bin and help manage the system:

● anteros.bat

● anteros_install.bat
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● anteros_uninstall.bat

● backupdatabase.bat

● buildcube.bat

● compilejsp.bat

● createdatabase.bat

● createeararchive.bat

● createwararchive.bat

● dbscript.bat

● debug_runtime.bat

● debugntservice.bat

● decrypt.bat

● deployapplication.bat

● digest.bat

● mpfilebytes.bat

● dumpinfo.bat

● dumpthreads.bat

● encrypt.bat

● exportmodel.bat

● exportmodeldoc.bat

● getproperty.bat

● importsysrowsources.bat

● initializesystem.bat

● installntservice.bat

● isadmin.bat

● isappreset.bat

● isarchivesetup.bat

● isdbarchive.bat

● isdroptables.bat

● isreset.bat

● issetup.bat

● loadscripttemplates.bat

● monitorprocess.bat

● ntservicemonitor.bat

● pingserver.bat

● receiveemail.bat
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● reconcile.bat

● redeployapplication.bat

● restoredatabase.bat

● revertmodelchanges.bat

● runant.bat

● rundbscript.bat

● runjava.bat

● runperl.bat

● runsystemgc.bat

● sendemail.bat

● serveradmin.bat

● setenv.bat

● setmaintenancemode.bat

● showversion.bat

● snapshot.bat

● startapplication.bat

● startntservice.bat

● startserver.bat

● stopapplication.bat

● stopserver.bat

● undeployapplication.bat

● uninstallntservice.bat

● unsetmaintenancemode.bat

● validatexml.bat

Common Activities of isadmin Commands
Common activities of isadmin commands include:

● Archives—Archives data from the current period before moving to the next period. 
Archived data is used for waterfall and other reports. An example is shown in the sample 
model found in <install-root>/samples/sample. See the JACL script, archives.jacl for 
details. Oracle Strategic Operational Planning  uses a snapshot query to output the data and 
store it in an archive table. 

● Clear values—Clears user-input values and returns to the original calculated or loaded 
value. See the weekly script in the sample model found in <install-
root>/samples/sample for details.

● Snapshot—Exports a slice of the cube using  an MDX query. See the archive script in the 
sample model found in <install-root>/samples/sample for details.
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● Waterfall reports—Compares a set of data as  time moves forward. For example, a waterfall 
report could compare the forecast for the current quarter and for future quarters.  See the 
weekly script in the sample model found in <install-root>/samples/sample for 
details.

● ETL—Extract-tranform-load.  Sometimes the data feed is not formatted to go directly into 
the system. In Oracle Strategic Operational Planning, the entry point is the datasource. 
Before pointing the datasource to an XLS file, a CSV file, or a table, Oracle Strategic 
Operational Planning uses JACL scripts to do SQL manipulation. See the JACL script, 
archives.jacl for patterns of SQL activities.

● Send email—See the weekly and daily scripts found in <install-
root>/samples/sample for examples of  sending email notifications. These scripts are 
entry level scripts invoked from the client. Sometimes, Oracle Strategic Operational 
Planning needs to send emails from inside the server (for example, in the middle of the 
execution of script template or JACL scripts). See “JACL Scripts” on page 199 for more 
details on sending emails from inside the server.

● Single thread script execution—Prevents concurrent execution of scripts. For example, if 
you accidentally invoke a daily script twice, you do not want the restructured code to run in 
two separate threads; instead, you can set exclusive execution of scripts and exclusive access 
to the shared resources in JACL scripts. See the weekly and daily scripts in sample model 
found in <install-root>/samples/sample for details.

Process Flow Modeling
The core functionality supported in Oracle Strategic Operational Planning is multi-
dimensional model building, planning, and analysis. It is important to consider:

● The different processes that manipulate the system

● The business stakeholders associated with these processes

● Frequency of these processes

● What permissions to associate with these processes

● What happens to the rest of the system when these processes run

● How long the processes run and how they impact the system

● Input data required to start the process, who is providing it, and how they are providing it

● Automatic scheduling of these processes

Typically we characterize processes as:

● Command line scripts—Reflect the data refresh processes and are created based on the time 
intervals within which they must be executed. Command line scripts are scheduled by 
external systems, and prior agreements are made with respect to availability of data. The 
sample model scripts reflect what typically happens. Oracle Strategic Operational Planning 
is generally in single-user mode,  So it is important to measure the performance of the 
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scripts and understand how they impact the system. The scripts created by Oracle Strategic 
Operational Planning include: daily scripts, weekly scripts, monthly scripts, and migration 
scripts.

● Interactive communication through scenarios—The different analysis types and scenario 
submissions are often used to communicate between different business users. The 
submission process reflects the end of certain activities.

● Interactive communication through script templates—Script templates can be invoked 
from Oracle Strategic Operational Planning  and used to model the work flow. Business 
stakeholers identify the script templates and use the scripts to perform certain activities or 
communicate with one another. 

Evolution of the Commands through Different Releases
● Version 1.x—No Model Schema or Edit Schema. Commands to manipulate base schema 

objects directly and explicit commands for loading data to cubes. No rowsources. 

● Version 2.x—Introduction of rowsources and loading through rowsources to cubes. Must 
explicitly load each rowsource.

● Version 3.x:—Introduction of the Model Schema and the resulting commands for 
importing and publishing. Introduction of macro commands to simplify script 
maintenance. Introduction of script templates as first class objects. Introduction of  JACL 
scripts, Groovy scripts, and the generic java scripting framework inside the server.  (JACL 
scripts provide flexibility in terms of intermingling isadmin commands with access to 
server resources as well as  external access for the Oracle Strategic Operational Planning 
database and other systems. 

● Version 4.x—Introductions of more macro commands, additional scripting language, and 
more powerful isadmin commands.

Scripts
This section details the following typical scripts:

● JACL Scripts

● Perl Module Scripts

● Daily Scripts

● Weekly Scripts

● Migration Scripts

JACL Scripts 
The following tables list the method details of common bean objects initialized by script 
execution. The bean and the method are accessed from JACL script as follows:

$ISStatementAdmin executeStatement "alter sandbox set batch mode"
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where $ISStatementAdmin is the bean exposed by the framework, executeStatement is 
the method on the bean, and the string is the argument to the method.

Note: See the sample model in <install-root>/samples/sample for examples of different JACL scripts. 

Table 12 DBAdmin Method Summary 

Bean Method

Connection getConnection()   

String getFormattedServerDate() 

Date getServerDate()

long getServerTime()  

String getServerTimeAsString() 

String toOracleDate(Date date)  

Date toSqlDate(Date date)  

String toSQLServerDate(Date date) 

Time toSqlTime(Date date)   

Timestamp toSqlTimestamp(Date date)

Table 13 EmailAdmin Method Summary

Bean Method

MailMessage createMessage(String toUser, 

String ccUser, 

String fromUser, 

String subject, 

String content, 

String attachmentPath)

Table 14 ISStatementAdmin Method Summary

Bean Method

Object executeStatement(String statement)  
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Perl Module Scripts
You can write wrapper scripts using the Orac le Strategic Operational Planning Perl modules to 
invoke various isadmin commands. 

See <install-root>/interlace/perl for Perl modules available for configuration and 
runtime support. 

See <install-root>/samples/sample/bin for different examples of Perl scripts (for 
example dailyscript.pl and weeklyscript.pl) to understand how isadmin commands are 
invoked and how error handling is done.

Table 15 ModelAdmin Method Summary

Bean Method

Model getReadOnly()    

Model getReadWrite() 

Table 16 SandboxAdmin Method Summary

Bean Method

ListWrapper getSandboxNamesForResponsesWithChanges(

String responseType)

Table 17  SessionAdmin Method Summary

Bean Method

long getCurrentSandboxID()     

String getCurrentSandboxName()  

boolean isScriptAccessExclusive(String lockName)    

void setExclusiveScriptAccess(String lockName) 

Table 18 TaskAdmin Method Summary

Bean Method

void addTask(String taskCmd, String groupName)  

boolean containsPendingTask(String taskCmd, String groupName) 

void deleteTasks(String groupName)    

void executeTasks(String groupName, boolean waitForCompletion)        
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Daily Scripts
The sample daily script found in <install-root>/samples/sample shows how to write 
Perl scripts, how to write JACL scripts, and how different isadmin commands are put together 
to achieve certain purpose. This sample script provides a good framework to start your own 
implementation. The script highlights the following activties:

● Polling for new data

● Importing model objects 

● Publishing objects and restructuring

● Loading dimensions

● Loading rowsources

● Calculating and submitting the sandbox after loading

● Setting exclusive execution during the script run

● Sending emails

● Error handling

Weekly Scripts
The sample weekly script found in <install-root>/samples/sample  provides a 
framework to start your implementation, and to model the weekly data refresh process flow. 
The script highlights the following:

● All activities that are part of daily script

● Waterfall reporting

● Clearing planning measures from the previous week

● Snapshots

● Archives

● Purging closed and old scenarios

● ETL activity using SQL

Migration Scripts
Before running a migraiton script, complete the following:

● Run the preparemigration command and export all metdata and data from Oracle 
Strategic Operational Planning to the file system. 

● Run the isreset command to wipe out all the information and create a clean slate for 
model building.

The goal of the migrate script is to restore the system back to where it was when 
preparemigration was run. 

The migration script highlights the following:
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● The different directories where the data resides after preparemigration

● Importing the model objects

● Publishing the model objects and restructuring

● Loading the dimension members  using the <migration-
home>/data/rowsource*.csv files that were exported during preparemigration.

● Using the loader scripts exported as <migration-home>/loader/load-dim*.xml

● Restructuring after a dimension load

● Loading the rowsource values using the <migration-home>/data/rowsource*.csv 
files that were exported during preparemigration.

● Using the loader scripts exported as <migration-home>/loader/load-
rowsource*.xml

● Loading the cube values using <migration-home>/data/cube*.csv files that were 
exported during preparemigration. Only user input data from cubes is exported.

● Using the loader scripts exported as <migration-home>/loader/load-cube*.xml

● Creating a sandbox, completing the load, calculating, and submitting

● Restoring the system back to what it was at the time of preparemigration

See the sample migration script found in <install-root>/samples/sample for details.

isadmin Command Grammar

Note: The grammar contains many deprecated commands that are no longer supported. Only the commands that are 
discussed in the previous sections are supported.

header
{
    package com.interlacesystems.compiler;
}

options
{
    mangleLiteralPrefix = "TOK_";
}

{@SuppressWarnings("unchecked")}
class ISParser extends ParserBase;
options
{
    importVocab = ISVocab; // use vocab generated by lexer
    buildAST = true;
    k = 2;
    defaultErrorHandler=false;
}

multistatement
    :   statement (TOK_SEMI! statement)* (TOK_SEMI!)?



204  Isadmin Commands 

    ;

// a statement - the top-level parsed statement
statement
    :   ( create_statement
        | delete_statement
        | import_statement
        | export_statement
        | publish_statement
        | revert_statement
        | alter_statement
        | test_statement
        | advance_statement
        | drop_statement
        | dumpstats_statement
        | shutdown_statement
        | stage_statement
        | load_statement
        | reload_statement
        | submit_statement
        | discard_statement
        | set_statement
        | snapshot_statement
        | run_statement
        | generate_statement
        | print_statement
        | clear_statement
        | anteros_statement
        | grant_statement
        | invoke_statement
        | system_statement
        )
    ;

/**
 * Verbs
 */

protected
invoke_statement
  : TOK_invoke^ invoke_verb
  ;

protected
invoke_verb
  : TOK_external^ invoke_external_statement
  | TOK_class^ invoke_class_statement
  ;

protected
invoke_external_statement
  : TOK_script! (TOK_using! TOK_file!)? name (name)*
  ;

protected
invoke_class_statement
  : TOK_name! name
  ;
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protected
dumpstats_statement
    :   TOK_dump^ TOK_timing TOK_stats
    ;

protected
print_statement
    :   TOK_print^ (TOK_datetime | TOK_schemas | TOK_sandbox)
    ;

protected
alter_statement
    :   TOK_alter^ alter_verb
    ;

protected
run_statement
    :   TOK_run^ TOK_STRING_LITERAL TOK_command! TOK_STRING_LITERAL
    ;

protected
shutdown_statement
    :   TOK_shutdown^ shutdown_system
    ;

protected
advance_statement
    :   TOK_advance^ TOK_calccln TOK_all
    ;

protected
clear_statement
    :   TOK_clear^ clear_clause
    ;

protected
create_statement
    :   TOK_create^ create_verb
    ;

protected
delete_statement
    :   TOK_delete^ delete_verb
    ;

protected
drop_statement
    :   TOK_drop^ drop_verb
    ;

protected
export_statement
    :   TOK_export^ export_verb
    ;

protected
import_statement
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    :   TOK_import^ import_verb
    ;

protected
submit_statement
    :   TOK_submit^ submit_verb
    ;

protected
publish_statement
    :   TOK_publish^ publish_verb
    ;

protected
revert_statement
    :   TOK_revert^ revert_verb
    ;

protected
discard_statement
    :   TOK_discard^ discard_verb
    ;

protected
set_statement
    :   TOK_set^ set_verb
    ;

protected
test_statement
    :   TOK_test^ test_opt
    ;

protected
generate_statement
:TOK_generate^ generate_verb
;

/**
 * Nouns
 */
protected
test_opt
    : TOK_metadata^ test_verb
    | TOK_query^ query_test
    | TOK_export^ test_export
    ;

protected
query_test
    :   TOK_response sandbox TOK_with! TOK_grid! TOK_in! filename 
TOK_export! TOK_to! filename
    ;

protected
test_export
    : TOK_datasource^ (TOK_raw)? TOK_definition! name TOK_to! TOK_file! 
filename
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    | TOK_stagemap^ (TOK_raw)? TOK_definition! name TOK_to! TOK_file! 
filename
    | TOK_dimension^ (TOK_shadow)? name TOK_to! TOK_file! filename
    | TOK_namedquery^ name TOK_to! TOK_file! filename
    ;

protected
alter_verb
    :   TOK_system^ alter_system
    |   TOK_sandbox^ alter_sandbox
    |   TOK_loader^ alter_loader
    |   TOK_schema^ alter_schema
    |   TOK_model^ TOK_schema alter_model_schema
    ;

protected
create_verb
    :   TOK_user^ create_user
    |   TOK_sandbox^ (name)?
    |   TOK_scenario^ TOK_type! name TOK_owner! name TOK_name! name 
(TOK_description name)? (TOK_due datetime)?
    ;

protected
submit_verb
    :   TOK_sandbox^
    |   TOK_scenario^ submit_scenario_clause
    ;
    
protected
submit_scenario_clause    
:   TOK_name name
|   TOK_uuid name
;

protected
clear_clause
    :   TOK_schema^ (TOK_base | TOK_shadow | name)
    ;

protected
discard_verb
    :   TOK_sandbox^
    ;

protected
set_verb
    :   TOK_sandbox^ name
    |   TOK_sandbox^ TOK_using! TOK_id number
    |   TOK_sandbox^ TOK_from! TOK_response number
    |   TOK_schema^ (TOK_base | TOK_shadow | name)
    |   TOK_stage^ TOK_batchsize TOK_ASSIGN! number
    ;

protected
drop_verb
    :   TOK_cube^ name
    ;
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protected
delete_verb
    :   TOK_cube^ TOK_definition! name
    |   TOK_dimension^ TOK_definition! name
    |   TOK_constraint^ TOK_definition! name
    |   TOK_datasource^ TOK_definition! name
    |   TOK_stagemap^ TOK_definition! name
    |   TOK_rowsource^ TOK_definition! name
    |   TOK_dbconnection^ TOK_definition! name
    |   TOK_worksheet^ TOK_definition! name
    |   TOK_workbook^ TOK_definition! name
    |   TOK_keymetric^ TOK_definition! name
    |   TOK_analysistype^ TOK_definition! name
    ;

protected
export_verb
    :   TOK_model^ TOK_definitions!
    |   TOK_dimension^ TOK_definition! name (TOK_to! TOK_file! filename)?
    |   TOK_cube^ TOK_definition! name (TOK_to! TOK_file! filename)?
    |   TOK_constraint^ TOK_definition! name (TOK_to! TOK_file! 
filename)?
    |   TOK_datasource^ TOK_definition! name (TOK_to! TOK_file! 
filename)?
    |   TOK_stagemap^ TOK_definition! name (TOK_to! TOK_file! filename)?
    |   TOK_rowsource^ TOK_definition! name (TOK_to! TOK_file! filename)?
    |   TOK_dbconnection^ TOK_definition! name (TOK_to! TOK_file! 
filename)?
    |   TOK_worksheet^ TOK_definition! name (TOK_to! TOK_file! filename)?
    |   TOK_workbook^ TOK_definition! name (TOK_to! TOK_file! filename)?
    |   TOK_keymetric^ TOK_definition! name (TOK_to! TOK_file! filename)?
    |   TOK_analysistype^ TOK_definition! name (TOK_to! TOK_file! 
filename)?
    |   TOK_style^ TOK_definitions! (TOK_to! TOK_file! filename)?
    |   TOK_rule^ TOK_definitions! (TOK_to! TOK_file! filename)?
    |   TOK_scenario^ name TOK_to! TOK_file! filename
    |   TOK_modelgroup^ name TOK_to! TOK_file! filename
    |   TOK_test^ TOK_scenario! name TOK_to! TOK_file! filename
    |   TOK_all^ TOK_scenarios
    |   TOK_user^ TOK_filters
    |   TOK_data^ TOK_to! TOK_file! filename
    |   TOK_documentation^ (TOK_to! TOK_file! filename)?
    ;

protected
import_verb
    :   TOK_dimension^ TOK_definition! TOK_from! TOK_file! filename
    |   TOK_cube^ TOK_definition! TOK_from! TOK_file! filename
    |   TOK_constraint^ TOK_definition! TOK_from! TOK_file! filename
    |   TOK_datasource^ TOK_definition! TOK_from! TOK_file! filename
    |   TOK_stagemap^ TOK_definition! TOK_from! TOK_file! filename
    |   TOK_modelgroup^ TOK_definition! TOK_from! TOK_file! filename
    |   TOK_rowsource^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
    |   TOK_dbconnection^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
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    |   TOK_worksheet^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
    |   TOK_workbook^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
    |   TOK_analysistype^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
    |   TOK_style^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
    |   TOK_chart^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
    |   TOK_scenario^ TOK_from! TOK_directory! filename (TOK_replace)? 
(TOK_using! TOK_batch)?
    |   TOK_all! (TOK_active | TOK_pending | TOK_complete)? TOK_scenarios^ 
(TOK_replace)? (TOK_using! TOK_batch)?
    |   TOK_all^ TOK_rules (TOK_replace)?    
    |   TOK_dashboard^ TOK_from! TOK_file! filename
    |   TOK_scope^ TOK_definition! TOK_from! TOK_file! filename
    |   TOK_named! TOK_queries^ TOK_from! TOK_file! filename
    |   TOK_acls^ TOK_from! TOK_file! filename
    |   TOK_security! TOK_filters^ TOK_from! TOK_file! filename
    |   TOK_script^ TOK_template! TOK_from! TOK_file! filename
    |   TOK_cubemaps^
    |   TOK_rule^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
    |   TOK_user^ TOK_filters
    |   TOK_presentation^ (TOK_definition! | TOK_definitions!) TOK_from! 
TOK_file! filename
    ;

/**
* Macro command: We need to be careful as when we execute a script 
template, we first expand it
* without executing it. We assume certain structure to that as  publish 
(rowsource| dimension ...) definitions
* Look in ScriptTemplateRepository for getSubTasks
*/
protected
publish_verb
    :   TOK_metadata^ TOK_changes! (TOK_and! TOK_lock TOK_model! 
TOK_schema!)?
    |   TOK_cube^ (TOK_definition! name | TOK_definitions)
    |   TOK_dimension^ (TOK_definition! name | TOK_definitions)
    |   TOK_constraint^ (TOK_definition! name | TOK_definitions)
    |   TOK_datasource^ (TOK_definition! name | TOK_definitions)
    |   TOK_stagemap^ (TOK_definition! name | TOK_definitions)
    |   TOK_rowsource^ (TOK_definition! name | TOK_definitions)
    |   TOK_dbconnection^ TOK_definition! name
    |   TOK_worksheet^ TOK_definition! name
    |   TOK_workbook^ TOK_definition! name
    |   TOK_keymetric^ TOK_definition! name
    |   TOK_analysistype^ TOK_definition! name
    ;

protected
revert_verb
    :   TOK_metadata^ TOK_changes!
    |   TOK_cube^ TOK_definition! name
    |   TOK_dimension^ TOK_definition! name
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    |   TOK_constraint^ TOK_definition! name
    |   TOK_datasource^ TOK_definition! name
    |   TOK_stagemap^ TOK_definition! name
    |   TOK_rowsource^ TOK_definition! name
    |   TOK_dbconnection^ TOK_definition! name
    |   TOK_worksheet^ TOK_definition! name
    |   TOK_workbook^ TOK_definition! name
    |   TOK_keymetric^ TOK_definition! name
    |   TOK_analysistype^ TOK_definition! name
    ;

protected
test_verb
    :   TOK_begin^ update_dimension
    |   TOK_end^ update_dimension
    |   TOK_add^ add_statement
    |   TOK_delete^ del_statement
    |   TOK_move^ move_statement
    |   TOK_update^ update_statement
    |   TOK_rename^ rename_statement
    |   TOK_calculate^ TOK_cube name
    ;

protected
generate_verb
:TOK_forecast^ name TOK_using! TOK_generator! name (TOK_with! TOK_args! 
(name)*)?
;

protected
generate_mandatory
: TOK_query queryname
| TOK_generator name
;

protected
generate_optional
:   TOK_response number
|   TOK_modifier name
;

protected
update_dimension
    :   TOK_update! TOK_of! TOK_dimension dimension
    |   TOK_restructure
    ;

protected
add_statement
    :   TOK_namespace namespace TOK_to! TOK_dimension! dimension
    |   TOK_member member TOK_to! TOK_dimension! dimension TOK_in! 
TOK_namespace! namespace
    |   TOK_hierarchynode hierarchynode TOK_to! TOK_hierarchy! hierarchy 
TOK_in! TOK_dimension! dimension TOK_in! TOK_namespace! namespace TOK_to! 
TOK_parent! parent TOK_in! TOK_namespace! namespace opt_sibling
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    |   TOK_measure measure TOK_in! TOK_dimension! dimension TOK_set! 
TOK_type! type TOK_set! TOK_classproperty! classproperty TOK_set! 
TOK_formula! formula TOK_set! TOK_datasource! datasource TOK_set! 
TOK_datacolumn! datacolumn TOK_set! TOK_dataupdatelevel! updatelevel
    ;

protected
opt_sibling
    :   /* nothing */
    |   TOK_to! TOK_sibling! sibling TOK_in! TOK_namespace! namespace
    ;

protected
del_statement
    :   TOK_member member TOK_from! TOK_dimension! dimension TOK_in! 
TOK_namespace! namespace
    |   TOK_namespace namespace TOK_from! TOK_dimension! dimension
    |   TOK_hierarchynode hierarchynode TOK_from! TOK_hierarchy! 
hierarchy TOK_in! TOK_dimension! dimension TOK_in! TOK_namespace! 
namespace
    |   TOK_dimension name
    |   TOK_datasource name
    ;

protected
move_statement
    :   TOK_hierarchynode hierarchynode TOK_in! TOK_hierarchy! hierarchy 
TOK_in! TOK_dimension! dimension TOK_in! TOK_namespace! namespace TOK_to! 
TOK_parent! parent TOK_in! TOK_namespace! namespace TOK_and! TOK_sibling! 
sibling TOK_in! TOK_namespace! namespace
    ;

protected
rename_statement
    :   TOK_member member TOK_in! TOK_dimension! dimension TOK_in! 
TOK_namespace! namespace TOK_to! TOK_newname! newname
    ;

protected
snapshot_statement
    :   TOK_snapshot^ TOK_data! TOK_using! TOK_query queryname 
(TOK_append | TOK_replace)?
    ;

protected
update_statement
    :   TOK_measure measure TOK_in! TOK_dimension! dimension TOK_set! 
TOK_type! type TOK_set! TOK_classproperty! classproperty TOK_set! 
TOK_formula! formula TOK_set! TOK_sumop! sumop TOK_for! TOK_dimension! 
dimension TOK_set! TOK_datasource! datasource TOK_set! TOK_datacolumn! 
datacolumn TOK_set! TOK_dataupdatelevel! updatelevel TOK_set! 
TOK_datafilter! TOK_value! value TOK_for! TOK_column! column TOK_set! 
TOK_dependency! TOK_on! TOK_measure! measure TOK_in! TOK_cube! cube
    |   TOK_member member TOK_in! TOK_dimension! dimension TOK_in! 
TOK_namespace! namespace TOK_set! TOK_description! description TOK_set! 
TOK_alias! alias
    ;
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/**
 * System mgmt
 */
protected
alter_system
    :   TOK_start^ start_stop
    |   TOK_stop^ start_stop
    |   TOK_javagc
    |   TOK_gc
    |   TOK_allow^ admin_all
    |   TOK_prepare^ alter_system_prepare
    |   TOK_reconcile^ alter_system_reconcile
    |   TOK_set^ alter_system_set
    |   TOK_unset^ alter_system_unset
    |   TOK_freeze^ TOK_datetime (TOK_at!)? (datetime)?
    |   TOK_invoke^ alter_system_invoke
    |   TOK_execute^ alter_system_execute
    |   TOK_add^ alter_system_add
    |   TOK_delete^ alter_system_delete
    |   TOK_reset
    |   TOK_restructure
    |   TOK_solve TOK_constraint TOK_using TOK_rule name
    |   TOK_enable^ alter_system_enable
    |   TOK_disable^ alter_system_disable
    |   TOK_purge^ alter_system_purge
    ;

protected
alter_system_prepare
  : TOK_for! TOK_migration
  ;

protected
alter_system_enable
  : TOK_email TOK_reader
  ;

protected
alter_system_disable
  : TOK_email TOK_reader
  ;

protected
alter_system_invoke
  : TOK_application^ TOK_hook!
  | TOK_script^ TOK_template! name
  ;

protected
alter_system_purge
  : TOK_all TOK_closed TOK_scenarios
  | TOK_closed TOK_scenarios TOK_older TOK_than number TOK_days
  ;
  
protected
alter_system_reconcile
  : TOK_active TOK_response
  | TOK_response number
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  ;

protected
alter_system_execute
: TOK_tasks^ alter_system_execute_tasks
;

protected
alter_system_execute_tasks
:  TOK_in^ TOK_group! group
;

protected
alter_system_set
    :   TOK_datetime^ (TOK_to!)? (datetime)? (TOK_force)?
    |   TOK_maintenance^ TOK_mode!
    ;

protected
alter_system_unset
    :   TOK_datetime
    |   TOK_maintenance^ TOK_mode!
    ;

protected
alter_loader
    :   TOK_set^ alter_loader_set
    ;

protected
alter_loader_set
    : TOK_rowsource^ alter_loader_set_rowsource
    ;

protected
alter_loader_set_rowsource
    : TOK_cle (TOK_log | TOK_nolog)
    ;

protected
alter_system_add
    : TOK_task^ TOK_group! group TOK_command! command TOK_user! name 
TOK_failonerror! booleantoken
    ;

protected
alter_system_delete
    :  TOK_tasks^ TOK_in! TOK_group! TOK_STRING_LITERAL
    ;

protected
shutdown_system
    :   TOK_system (TOK_normal|TOK_force)? (TOK_norestart|TOK_restart)?
    ;

protected
admin_all
    :   TOK_adminonly
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    |   TOK_all
    ;

// alter system start|stop
protected
start_stop
    :   TOK_cube name
    ;

protected
alter_sandbox
: TOK_set^ alter_sandbox_set
| TOK_calculate
| TOK_denseCalc^ alter_sandbox_denseCalc
    | TOK_restructure
    | TOK_transform^ alter_sandbox_transform
;

protected
alter_sandbox_set
    :  TOK_batch^ TOK_mode
    |  TOK_interactive^ TOK_mode
    ;

protected
alter_sandbox_transform
    :  TOK_rowsources! TOK_with! name
    ;

protected
alter_sandbox_denseCalc
    :  TOK_cube! name
    ;

protected
alter_schema
  : TOK_prepare^ TOK_to! TOK_restructure
  ;

protected
alter_model_schema
  : TOK_unlock^
  | TOK_lock^
  | TOK_set^ alter_model_schema_set
  ;

protected
alter_model_schema_set
   : TOK_current^ (TOK_base | TOK_edit)
   ;

protected
create_user
  : name TOK_identified! TOK_by! password TOK_name! name TOK_email! email
  ;

/**
 * Loader
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 */

protected
stage_statement
  : TOK_stage^ stage_clause
  ;

protected
stage_clause
  : TOK_replace^ stage_replace_clause
  | TOK_update^  stage_update_clause
  | TOK_append^  stage_append_clause
  | TOK_clear^   stage_clear_clause
  ;

protected
stage_replace_clause
  : TOK_from! stage_from
  | TOK_using^ stage_using
  ;

protected
stage_update_clause
  : TOK_from! stage_from
  | TOK_using^ stage_using
  ;

protected
stage_append_clause
  : TOK_from! stage_from
  | TOK_using^ stage_using
  ;

protected
stage_from
  : TOK_file^ filename TOK_using! stage_from_file
  | TOK_datasource^ name TOK_using! stage_from_using
  | TOK_database^ TOK_using! TOK_file! filename (TOK_on! TOK_behalf! 
TOK_of! name)?
  ;

protected
stage_from_file
  : TOK_file^ filename (TOK_on! TOK_behalf! TOK_of! name)?
  ;

protected
stage_from_using
  : TOK_stagemap^ name (TOK_with TOK_batchsize TOK_ASSIGN! number)? 
(TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_stagemaps^ namelist (TOK_with TOK_batchsize TOK_ASSIGN! number)? 
(TOK_on! TOK_behalf! TOK_of! name)?
  ;

protected
stage_using
  : stage_from_using
  | TOK_modelgroup^ name
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  ;

protected
stage_clear_clause
  : TOK_rowsource^ name
  | TOK_cube^ name
  | TOK_rowsources
  | TOK_dimension^ name
  | TOK_dimensions
  | TOK_bom^
  ;

protected
load_statement
  : TOK_load^ load_clause
  ;

protected
load_clause
  : TOK_replace^ load_replace_clause
  | TOK_update^  load_update_clause
  | TOK_clear^   load_clear_clause
  | TOK_datasources^ TOK_using! (TOK_dimension | TOK_rowsource) 
TOK_stagemaps! (TOK_identified! TOK_by! TOK_group! name)?
  ;

protected
reload_statement
  : TOK_reload^ reload_clause
  ;

protected
reload_clause
  : TOK_cubes^
  | TOK_cube^ name (TOK_rowsource! name)?
  ;

/**
* Macro command: We need to be careful as when we execute a script 
template, we first expand it
* without executing it. We assume certain structure to that as  load 
(replace | update) (rowsources| dimensions )
* Look in ScriptTemplateRepository for getSubTasks
*/
protected
load_replace_clause
  : TOK_rowsource^ name (TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_dimension^ name (TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_users^          (TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_bom^            (TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_dimensions^
  | TOK_rowsources^
  ;

protected
load_update_clause
  : TOK_rowsource^ name (TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_dimension^ name (TOK_on! TOK_behalf! TOK_of! name)?
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  | TOK_cube^ name      (TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_users^          (TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_bom^            (TOK_on! TOK_behalf! TOK_of! name)?
  | TOK_dimensions^
  | TOK_rowsources^
  ;

protected
load_clear_clause
  : TOK_rowsource^ name (TOK_on! TOK_behalf! TOK_of! name)?
  ;

protected
anteros_statement
  : TOK_anteros^ TOK_eval TOK_url urn
  ;

protected
permission
  : (TOK_create | TOK_read | TOK_update | TOK_delete | TOK_execute)
  ;

protected
permissions
  : permission (TOK_COMMA permission)*
  ;

protected
acl_objects
  : (TOK_chart | TOK_presentation | TOK_response) namelist
  ;

protected
grant_statement
  : TOK_grant^ permissions TOK_on acl_objects TOK_to namelist
  ;

protected
revoke_statement
  : TOK_revoke^ permissions TOK_on acl_objects TOK_from namelist
  ;

protected
system_statement
  : TOK_system^ (name)+ ;
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add Excel shortcut, 63

add jobs, 175

add search filter, 45
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Administration Workbench, 30

administrator, 21
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analysis history, 94

analysis owner, 21
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analysis roles, 21

analysis type, create, 161
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analysis type, edit, 161

analysis type, switch, 83

analysis types, assign, 176

analysis types, delete, 159

analysis types, view, 159

Analysis Workbench, 30

analysis workflows, 21
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approve scenario, 59, 61

Approved state, of scenario, 17, 30, 59

approver, 21

assign analysis types, 176

assign exceptions to users, 50

Assigned state, of exception, 17, 30

assigner, 21

B
base data, 58

bookmark scenario, 63 to 64

C
calculate key metrics, 78

calculate measures, 78

calculated measures, 108
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cell locations, expressing, 36

cell range, select, 133

cells, go to, 80

change password, 44, 176

change workbook filename, 150

change worksheet name, 150

Closed state, of exception, 17, 30

collapse view, 85

commit plan changes, 93

compare scenarios, 83

Complete state, of scenario, 17, 30

Completed state, of task, 30

console log, 71, 173

constraints

creating, 119

context menus, Interlace, 36

copy scenario, 58

create analysis type, 161

create Excel shortcut, 63

create filter pulldown menu, 133

create planning workbook, 52

create query, 133

create Refresh Data button, 133

create scenario, 52

create scenario alternative, 58

create task, 97

create users, 176

create workbook, 156

create worksheet, 150

cubes
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data collection analysis type, 161
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data collection scenario, 19, 67

data collection workbook, 19, 67, 156

data collection workbook, load, 71

data collection workbook, preview, 68

data collection workbooks, send, 68

data collection workbooks, update, 68

Data Designer

understanding the user interface, 112

Data Designer tab, 30

data provider, monitor status, 71

data providers, add, 67
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data providers, overview, 19

data providers, remove, 67
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database, Interlace, 17
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Deferred state, of task, 30

delete analysis types, 159

delete jobs, 173
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delete scenario alternatives, 58

delete scenarios, 51
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diagram, analysis process, 17
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dimensions, zoom, 85
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E
edit analysis type, 161
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edit search filter, 45
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edit workbook, 156
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error log, 71
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Excel shortcut, email, 64

Excel, Interlace tools in, 36

Excel, open scenario, 77

Excel, what-if analysis steps, 73

exception states, 30

Exceptions panel, 29

exceptions, assign, 50

exceptions, defined, 17, 80

exceptions, edit, 50

exceptions, view details, 30, 49

execute jobs, 173

execution database, 17

expand view, 85

export commands, 189

exporting multi-dimensional data, 194
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focus on selected measures, 89
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types of functions in, 110
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functions, in formulas, 108

G
graphical controls, in report worksheet, 133

groovy scripts, 192

H
hidden worksheet, 156

hierarchy levels, 36

hierarchy, dimension, 36

history, analysis, 94

Home page, 29 to 30

I
import commands, 186

In Progress state, of scenario, 17, 30

In Progress state, of task, 30

inline reports, 88

instructions to data providers, 68

Interlace context menus, 36

Interlace database, 17

Interlace menu, 36

Interlace toolbar, 36

introduced exceptions, 17, 80

isadmin command-line tool, 175

commads for loading members into dimensions, 188

command grammar, 203

command options, 182

commands for building hierarchies, 188

common activities, 197

common usage, 182

custom java code commands, 194

export commands, 189

exporting multi-dimensional data, 194

import commands, 186

JACL and groovy scripts, 192

load commands, 189

macro commands, 186

migration commands, 194

process flow modeling, 198

publish commands, 187

sandbox calculation, submit, and reconcile 
commands, 192

script templates, 192

system commands, 193

using, 184

xml files and search path, 183

xml schema files, 183

J
JACL, 192

JACL scripts, 199

java code commands, 194

job queue, 173, 175

jobs, add, 175

jobs, delete, 173

jobs, edit, 175

jobs, execute, 173

jobs, view, 173

K
key metrics, add to watchlist, 78

key metrics, calculate, 78

key metrics, defining, 161

key metrics, edit, 161

key metrics, naming, 161

L
levels, hierarchy, 36

load commands, 189

load data collection workbook, 71

log into the Interlace application, 28

log out of the Interlace application, 28

log, console, 71, 173

log, error, 71

M
macro commands, 186

mapping
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and data flow, 110

maps

allocation, 129

creating, 121

cube-to-cube, 121

datasource-to-dimension, 126

datasource-to-rowsource, 124

rowsource-to-cube, 123

MDX (Multidimensional Expressions), 133

measure formulas, 108

measure summarization, 108

measures

creating, 118

key metrics, 107

summarization, 108

types, 107

measures, add to watchlist, 78

measures, change values, 78

measures, recalculate, 78

measures, search, 86

measures, view, 85

measures, zoom, 85

members, dimension, 36

menu, Interlace, 36

Microsoft Excel, 36, 73

migration commands, 194

migration scripts, 202

Model Designer tab, 30

models

building, 113

monitor data provider status, 71

N
Navigation Panel, 30

Not Started state, of task, 30

O
open, scenario in Excel, 77

owner, analysis, 21

owner, task, 97

P
Parameter statement, in query, 133

parameter, response.allowEditApprovers, 161

participant, 21

password, administrator default, 21

password, change, 44, 176

Perl module scripts, 201

plan changes, 17, 93

plan values, 17

Planning Workbench, 30

planning workbook, defined, 30, 156

planning worksheet, defined, 30

preview data collection workbook, 68

preview query, 133

print scenario, 62

private worksheets, 150, 153

process flow modeling, 198

publish commands, 187

Q
queries, delete, 133

query, create, 133

query, edit, 133

query, preview, 133

R
range, select, 133

recalculate measures, 78

reconcile commands, 192

Refresh Data button, 133

refresh scenario data, 73, 91

register worksheet, 133, 153

remember username and password, 28

remove data providers, 67

remove search filter, 45

report workbook, defined, 156

report worksheet, create, 133

reports, inline, 88

reset worksheet view, 89

response.allowEditApprovers parameter, 161

review scenario, 59, 80

roles, 21

rowsource

creating, 115

rowsource-to-cube maps, 123

RSQL (Rowsource Structured Query Language), 133

run jobs, 173
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scenario alternative, create, 58

scenario alternatives, delete, 58

scenario comments, 80

scenario impact, 80

scenario states, 30

scenario, approve, 59, 61

scenario, bookmark, 63 to 64

scenario, commit to database, 93

scenario, create, 52

scenario, data collection, 19, 67

scenario, edit, 52

scenario, email, 63

scenario, open in Excel, 77

scenario, print, 62

scenario, refresh data, 73, 91

scenario, review, 59, 80

scenario, submit, 59

scenario, switch analysis type, 83

scenario, view details, 30

Scenarios panel, 29

scenarios, compare, 83

scenarios, delete, 51

scenarios, view, 51

script templates, 192

scripts

daily, 202

in install-root/bin, 195

JACL, 199

migration, 202

Perl module, 201

weekly, 202

search dimensions, 86

search filter, add, 45

search filter, remove, 45

search filter, use, 45

search measures, 86

select dimension members to display, 89

select measures to display, 89

send data collection workbooks, 68

sheet tab name, change, 150

state, of exception, 17, 30

state, of scenario, 17, 30

state, of task, 30

status, Home page, 29

status, of data providers, 71

submit commands, 192

submit scenario, 59

Submitted state, of scenario, 17, 30, 59

summarization of measures, 108

switch analysis type, 83

system commands, 193

T
table, Home page panels, 30

table, Interlace context menu items, 36

table, Interlace menu items, 36

table, Interlace toolbar buttons, 36

table, worksheet template elements, 131

task flows, 21

task owner, 97

task states, of action items, 30

task status, data collection, 71

task, create, 97

task, edit, 97

Tasks panel, 29

Tasks section, 30

tasks, as action items, 29 to 30

tasks, delete, 95

tasks, view, 95

templates, customize worksheet, 131

toolbar, Interlace, 36

tour of user interface, 30

type of analysis, 159, 161

U
unregister worksheets, 153

update data collection workbooks, 68

update scenario data, 73, 91

update user profile, 44

URL address for login, 28

use search filter, 45

user interface, 30

user profile, update, 44

users, create, 176

users, deactivate, 176

users, delete, 176

users, edit, 44, 176

users, view, 176
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view analysis history, 94

view analysis types, 159

view as another analysis type, 83

view cell locations, 36

view dimensions, 85

view exception details, 30, 49

view inline reports, 88

view jobs, 173

view measures, 85

view scenario details, 30, 51

view status, 29

view tasks, 95

view users, 176

view workbooks, 30, 155

view worksheet details, 149

W
Waiting On Someone Else state, of task, 30

watchlist, add or remove measures, 78

Weekly Calendar, 29

weekly scripts, 202

Welcome bar, 30

what-if analysis, 73

workbook, change filename, 150

workbook, create, 156

workbook, create scenario, 52

workbook, data collection, 19, 67, 156

workbook, edit, 156

workbook, planning, 67, 156

workbook, report, 156

workbooks, delete, 155

workbooks, email, 68

workbooks, view, 155

workflows, 21

worksheet dependencies, 150, 153

worksheet name, change, 150

worksheet, create, 150

worksheet, edit, 150

worksheet, hidden, 156

worksheet, register, 133, 153

worksheet, reset view, 89

worksheet, view details, 149

worksheets, overview, 30

worksheets, private, 150, 153
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worksheets, unregister, 153

X
XML files and search path, 183

XML schema files, 183

Z
zoom in or out, 85
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